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In Parts, you can create, edit, and delete content for your website. For example, to include your
organization’s mission statement on your site, you can create a part in Parts and write the statement.
You can also include your organization’s logo in the part. Other examples of parts include navigation
buttons, profile forms, event registration forms, and frames. After you save a part, you can display it on
multiple web pages. This section describes how to create parts for your website.

Note: Content does not appear on the website until you add the part to a web page in Pages &
templates. For information, see the Website Design Guide.

Create and Edit Parts
When you include a part on multiple web pages, you can edit and update it once for all pages. To
ensure a new part’s appearance, such as font size and style, is consistent with the rest of your website,
you can copy an existing part. This retains the bulk of information required to create content.

The procedures in this section describe the tabs you use to create and edit parts. For information
about how to design a specific part, see the section about that part type.

Create a part
When you host multiple sites, you can create parts for individual sites. To do this, log in to the site and
create the part. For more information, see the Administration Guide.

1. From Site explorer, click Parts. Parts appears.

2. Click New part. The New Part screen appears.

3. On the Properties tab, enter basic information that defines the part. For example, select the part
type and enter a name for the part. For more information, see Properties Tab on page 12.

4. Select the Targeting & Security tab. In the grid, assign view, edit, delete, and change security
rights for users and roles. For more information, see Targeting & Security Tab on page 15.
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5. Click Next. The Design tab appears. For more information about the Design tab, see Design Tab
on page 14. For information about how to design a specific part, see the section for that part
type.

6. Click Save. You return to Parts.

Edit a part
To search for an existing part to edit in Parts, use the filter tools. For example, select a part type in
the Filter by Type field or enter a full or partial name in the Filter by Name field.

1. From Site explorer, click Parts. Parts appears.

2. When you edit parts, you can perform the following actions:
• To edit a part’s design, click Click here to edit this part. The Edit Part screen appears on the

Design tab. For information about how to design a specific part, see the section for that part
type. For information about the Design tab, see Design Tab on page 14.

• To edit a part’s properties, click Click here to view/edit this part’s properties under Action.
The Edit Part screen appears on the Properties tab. For information about part properties, see
Properties Tab on page 12.
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• To create a part based on an existing part, click Click here to copy this part under Action. The
Copy Part screen appears. In the New Part name field, enter a new name and click Next. The
Edit Part screen appears so you can edit the new part.

Note: If the original part contains tags, the copy inherits the tags. From the Tags tab, you can modify
the copied tags.

• To move a part to another folder, select the checkbox beside the part and click Move. The
Move selected items screen appears for you to select a different folder.

• To delete a part, select the checkbox beside the part and click Delete. A message appears to
confirm you want to delete the data. When you do this, the part is available for you to restore
from the Deleted Parts folder.

Warning: To prevent you from inadvertently removing active content from your website, you can no
longer delete parts when they are associated with web pages. When you attempt to delete a part that
is associated with a single site, or shared across multiple sites, a message appears to inform you that
you cannot remove it because it exists on a page. To identify the pages where the part appears, select
the part's Usage tab. For information about the Usage tab, refer to Usage Tab on page 19.

3. Click Save. You return to Parts.

Properties Tab
On the Properties tab, you enter basic information that defines the part.

Define part properties
1. Select the Properties tab of a part.
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2. In the Part Type field, select a part type, such as “Formatted Text and Images.” This is the type
of content to include on the web page. After you save the part, you cannot change the part
type.

After you save a part, you can view its ID in the Part ID field. You can use this ID to identify the
part in a URL for a traffic measurement service, such as Google Analytics. For more
information, see the Administration Guide.

3. In the Part Name field, enter a name such as “Mission Statement” to allow users to quickly
identify the information in Parts. The name is for internal use and does not appear on the
website.

4. In the Part Description field, enter any additional information to identify the part.

5. In the Target Language field, select a language for content in the part. If the website user’s
primary language for the Internet browser is selected to the same language in the field, the
part appears on the web page. If the browser is selected to a different language, the part does
not appear. If the part applies to all languages, leave the default “<All>” in the field.

The languages that appear in the drop down are those selected in the Language box on the
Settings tab in Sites & settings. For more information, see the Administration Guide.

6. To design, style, and test a part on your website without creating transactions, generating
emails, or communicating in any way with Blackbaud Services or Blackbaud CRM, select Test
Mode. For example, you can complete the fields on a donation form to ensure the
confirmation page is styled and working properly. Although you submit the donation and
receive a confirmation, a transaction does not appear on the Web Transactions page.
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The Test Mode checkbox appears on the Payment, Donation Form, and Event Registration
Form parts. Only users with supervisor rights can view parts in Test mode.

Note: Use Test mode to verify the user’s experience, not to test data processing. Test mode does not
validate credit card numbers and merchant accounts.

7. To make the part available within a certain time frame, select Scheduled Publishing. When
you select this checkbox, the date fields are enabled.

Note: If you do not select Scheduled Publishing, no time limits exists for the part.

a. In the Publish Date field, enter the date and time the part first becomes available on your
site.

b. In the Expiration Date field, enter the date and time the part becomes unavailable on your
site.

If an expired part exists on a live web page on your site, the part does not appear. The other
parts on the page dynamically fill the space where the expired part previously appeared.

Note: When you host multiple sites and edit part properties, the Assign to site field appears so you
can move a part from its current site to another site. If the part is in use on a web page on the source
site, it continues to appear on that site. However, the part is now associated with the target site and
its security. When you move a part, some parts require you to configure options again when you edit
the part's design after the move. For example, the eCards part requires you to select an eCard
template before you save it. During this time, there are no disruptions to the part on your site. It
maintains the original configuration until you edit the part.

8. If you plan to use the part on a site that is a template for multiple sites, you can create a single
instance of the part when you copy the site so you only have to make changes to one instance.
To create a single instance, select Share part across sites. To limit the users who can edit the
shared content, assign security rights from the Targeting & Security tab. For information about
how to copy a site, see the Administration Guide. For information about the Targeting &
Security tab, see Targeting & Security Tab on page 15.

Note: This option appears for the Formatted Text and Images, Slideshow, and Unformatted Text
parts.

When you select Share part across sites, the Allow users who do not have permission to
edit content to create a local copy checkbox appears. If you select this checkbox, users
without permission to edit shared content can copy it.

9. Click Next. The Design tab appears. For more information about the Design tab, see Design
Tab on page 14. For more information about how to design a specific part, see the section for
that part type.

Design Tab
The Design tab appears after you save a part’s properties. On this tab, you set parameters defining the
part’s content, appearance, and processing. For example, on some parts you define required fields,
allowable payment options, and how users navigate away from the part. For more information about
the Design tab for a particular part, see the section for that part type.
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Targeting & Security Tab
On the Targeting & security tab, you assign website security rights for users and roles. You can assign
view, edit, delete, and change security rights.

By setting view rights, you target website content to only certain users. For example, on a Formatted
Text and Images part, you can assign view rights to the Board Members role so only users in that role
view the part on a web page.

Users with rights to edit and delete content can help manage the website. For example, on an Event
Registration Form part, users with edit rights can update last year’s golf tournament information with
this year’s information.

Users with change security rights have view, edit, and delete rights to the content. They can also
change security on this tab. Only users with supervisor rights should have rights to change security.

Select website security permissions
Follow this procedure for information about the Targeting & security tab on pages, templates,
images, and other areas in the program.

1. On a part, select the Targeting & security tab. A grid appears that lists the Everyone role in the
first row.

Note: You cannot edit a checkbox that you select for the Everyone role. All users inherit permissions
from the Everyone role.

2. To apply the same security permissions another part uses, click Copy permissions. The Select a
Part screen appears to select the part.

When you copy permissions, you overwrite the current security settings on the Targeting &
Security tab.
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Tip: You cannot copy permissions from a different task. For example, when you select to copy
permissions from a part, you must select permissions from another part. You cannot select
permissions from a page or template. In addition, images do not support copying permissions.

3. Select the part and click Select to return to the Targeting & security tab. The users and roles
appear in the grid. You can adjust the permissions as necessary.

4. To adjust the permissions for users and roles for this part, select Add users and roles. The
Create new security permissions screen appears.

Tip: When you create or edit a User Login part, you select the roles to assign to a user who signs up
on that part for your website. This is commonly the way users become a part of the roles you assign
permissons for on this screen. For more information about role assignments on the User Login part,
see User Login on page 248.

a. In the Filter field, enter the first letter of the user or role to include.

Note: The Available box displays 30 users and roles in alphabetical order. Use the Filter field to find
additional users and roles that do not appear in the box.

b. Locate the user or role, and click Add. The user appears in the Selected box.

To select multiple users or roles, press SHIFT while you select the multiple users, and then
click Add all. The users appear in the Selected box.
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c. Under Assign permissions, grant the users and roles view, edit, delete, and change security
permissions.

d. Click OK. You return to the Targeting & security tab. The users and roles appear in the grid.

5. To apply the permissions to the part, click Save. You return to Parts.

For more information about security, see the Users & Security Guide.

Parts That Require User Login Information
Users must log in to view some parts on your website. The following parts require user name and
password information before website users can access them.

• Change User ID/ Password

• Chapter Links

• Email Forwarding Form

• My Friends

• Profile Display

• Profile Form

• Targeted Content

• Transaction Manager

• User Interests Form

• User Link Module

• User Networking Manager

• User Photos Form

Other parts, such as the Personal Page Manager part, allow any user to access some of the part but
require user name and password information to view the rest. Parts, such as the Menu and Weblog
parts, do not require any login information.

Language Tab
Use the Language tab to rename labels, headings, and other text on your web pages. For example, if
you do not want the anonymous gift checkbox to display I prefer to make this donation
anonymously on the donation page, you can change the text to Anonymous gift. For the Tag Display
part, you can enter the header that appears before the list of tags. You can also choose the punctuation
mark, or delimiter, that separates entries in displays that include only tags on the selected page.

You can also enter localized text in another language for the items that appear on the Language tab.
For example, you can create a Donation Form part for English and enter localized text for Spanish. On
the Language tab, you enter the localized text for each language. You use this tab in combination with
other features to create international pages for your website.
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Rename and localize text
1. Select the Language tab of a part.

Tip: The Language tab appears on the Donation Form, eCards, Language Selector, Payment, Tag
Display, Transaction Manager, User Email Preferences Form, and User Login parts.

2. In the Category field, select the area of the part to rename text for.

3. In the Language field, select the language to localize.

You select the languages that appear in the Language box on the Settings tab in Sites &
settings.

4. Refer to the Item name column to enter text in the Text column. This text replaces the
default text.

• Enter the text to replace the default label or heading. For example, for the Anonymous gift
checkbox item, you do not want the checkbox to display I prefer to make this donation
anonymously on the web page. In the Text column, enter “Anonymous gift” to change the
name of the checkbox.

• Enter localized text for selected languages. For example, to create a Spanish web page, you
can change the text to “Donación anónimo." In the Language field, select the next language
to localize. When you toggle the Language field between multiple languages, the localized
text appears in the Text column for each language.

For more information about multiple languages on your website, see Add Localized Text For
Web Pages on page 19.

• For the Tag Display part, you can enter a new delimiter to separate tag entries.

Note: The delimiter separates entries in tag displays that show only tags for the parts on a page. For
tag displays that include all tags in use, entries appear on separate lines by default and the delimiter
does not appear. To add a delimiter to a tag display for all tags, you must modify the
BBTagDelimiterAll element under Tag Display for the appropriate style sheet. For information about
how to manage style elements, see the Website Design Guide.
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Add Localized Text For Web Pages
You use the Language tab in combination with other features to create international pages for your
website. You can create localized text for pages on your website in two ways. You can enter the
localized text to appear on the Language tab and create the Language Selector part. The Language
Selector part allows the website user to render the localized text on the web page. You can also create
a part specifically for a language. If a website user’s primary language for the Internet browser is the
same as the part, the part appears on the web page.

Implement multiple languages on your website
1. On the Settings tab in Sites & settings, select the languages to associate with your website. For

example, if your website audience includes Spanish and French users, select Español (Mexico)
and français (Canada) in the Language box. For more information, see the Administration
Guide.

2. Create a part specifically for a language. You can create localized pages in two ways.
• On the part’s Properties tab, in the Target language field, select the language for the part. If

the website user’s primary language for the Internet browser is selected to the same language
in the Target language field, the part appears on the web page. If the browser is selected to a
different language, the part does not appear. If the part applies to all languages, leave the
default “<All>” in the field. For more information, see Properties Tab on page 12.

OR
• On a part’s Language tab, in the Language field, select the language to localize. In the Text

column, enter the localized text for the web page. Create the Language Selector part. This part
displays a Language drop down field on your website. A website user selects a language
preference from the field on the web page. After the user selects the language, the page
renders the localized text. For more information, see Language Tab on page 17 and Language
Selector on page 122.

3. Add all applicable parts to a template or page in Pages & templates.

Usage Tab
After you save a part, the Usage tab appears. This tab displays the layouts, templates, and web pages
that use the part. The information is for informational purposes only. If the part is not used, a “This part
is not being used” message appears.

PARTS 19



Helplets Tab
On the Helplets tab, you can add custom text to help users understand the features of certain parts on
your website. For example, on the Personal Page Manager part, you can provide instructions for the
various Dashboard buttons.

Tip: The Helplets tab appears on the Event Registration Form, Payment, and Personal Page Manager
parts.

Add helplets
1. Select the Helplets tab.

2. In the Screen field, select the screen to add help text for.
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Note: Some screens contain default helplet text. You can use the text provided or enter different text.
If you overwrite the default text, you can click Restore Default to restore the original text.

3. In the box, enter the text to appear on the part. To format the content’s appearance and
layout, use the HTML editor. For information about the HTML editor, see the Program Basics
Guide.

4. To create help text for another screen, select it in the Screen field. The program automatically
saves your changes, and an asterisk appears beside the screens in the field that have help
content.

Content ApprovalTab
When you design a Formatted Text and Images part or Formatted Text and Images (Secured) part, the
Content Approval tab appears. On this tab, you select the approval status of the part and view its status
within the selected workflow and its approval history. If you have rights to manage workflows, you can
also assign the part to a different workflow.

When you revise a published part, the program automatically archives its earlier version. From the
Content Approval tab, you can view its previously published versions. If you have rights to approve
content, you can also restore the part to an earlier version.

Select the workflow and approval status of a part from its Content Approval tab
1. On the Edit Part screen, select the Content Approval tab.
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2. In the Approval Status field, select the part’s status in the workflow.
• When you first create or edit a part, the approval status is “Draft” until you complete its design

and submit it for approval. Until the part is ready for approval, select this account status. In the
Activity grid, parts with this status display “Draft” in the Status column. Parts with this status
appear in Approvals and on the Approvals tab of the selected workflow.

• When you complete the part’s design and content, select “Ready for Approval” to submit it for
approval. Users in the approval role for the workflow can review parts with this status and
select whether to approve the content to appear on the website. In the Activity grid, parts
with this status display “Pending” in the Status column. In Approvals and on the Approvals tab
of the selected workflow, parts with this status display an approval status of “Pending.”

• To approve the part and its content, users in the approval role for the workflow select
“Publish.” Parts with this status appear on your website. In the Activity grid, parts with this
status display “Published” in the Status column.

• To reject the part and its content, such as if the content contains error or is inappropriate for
your website, users in the approval role for the workflow select “Reject.”

3. If you have rights to manage workflows, the Workflow field appears. Select the workflow to
apply to the part. The workflow determines the users who review the part for approval.

Note: When you create a workflow in Workflows, you can select whether it is the default workflow for
the selected part type. When you design a part and select its workflow in the Workflow field, an
asterisk (*) appears next to the default workflow. For information about how to create a workflow, see
the Administration Guide.

4. In the Activity grid, view the recent approval activity for the part, including its approval status
and the date and owner of the more recent approval status update.

To view the part and its content, such as for review and approval, click Click here to view this
version in the Action column. The part and its content appears. To return to the Content
Approval tab, click Close.

To compose and send an email message to the most recent person to update the status of a
draft or pending part, click Click here to send email in the Action column.

5. To continue to design the part and its content, select the Design tab. For information about
how to design the Formatted Text and Images or Formatted Text and Images (Secured) part,
see Formatted Text and Images on page 117.
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To return to Parts, click Save.

Restore a published part to an archived version
When you revise a published part, the program archives its earlier version. On the Content
Approval tab, the Status column displays “Archived” for earlier published versions of the part.
From the Content Approval tab, users in the content approval role can restore the part to an earlier
archived version.

1. On the Edit Part screen, select the Content Approval tab.

2. In the grid, determine the version of the part to restore. To view the part and its content for an
earlier version, click Click here to view this version under Action. The part and its content for
that version appears. To return to the Content Approval tab, click Close.

3. Next to the version to restore, click Click here to restore this version under Action. A
message appears to confirm the restoration of the version.

4. Click OK. You return to Parts.

Tags Tab
On the Tags tab, you enter keywords or phrases to identify a part’s content. You can also associate user
interests with the part. When the part is on a web page with a Tag Display part, its tags and user
interests appear as hyperlinks. Users can click the links to access similar content from a list of the web
pages that contain parts associated with the tags and user interests. For information about how to
display tags as hyperlinks, see Tag Display on page 225.

Add tags
1. Select the Tags tab.
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2. To view the tags and user interests, click Existing tags and interests. Links appear for existing
tags and user interests.

Note: A number beside a tag or user interest indicates how many parts use it. This information also
appears in autocomplete text in the Add Tag field.

3. To associate existing tags and user interests with the part, click the links. The items appear
under Tags currently attached to this part.

4. To create a tag, enter a word or phrase in the Add tag field and click Add. The tag appears
under Tags currently attached to this part.

Note: To save data entry time, the program uses autocomplete to suggest existing tags from the Site
Tags code table. When you add tags, the program adds them to the code table. For information
about how to manage the Site Tags code table, see the Administration Guide.
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5. To remove a tag or user interest, click the “x” beside it under Tags currently attached to this
part.

6. To allow Suggested Content parts to link to the part, select Include on Suggested Content
parts. The Suggested Content part searches for parts with matching tags and user interests to
recommend content to website users. For information about the Suggested Content part, see
Suggested Content on page 213.

7. In the Title field, enter a header to display on a Suggested Content part when it recommends
the part. The header links users to the part’s web page.

8. In the Summary field, enter a short description to appear on a Suggested Content part.

9. Click Save. You return to Parts.

Acquisition Form
The Acquisition Form part enables your organization to collect constituent information — personal
data, constituent attribute information, and communication consent preferences — without requiring
constituents to register or log in to your site. You can then download the data to your constituent
database in Blackbaud CRM via the Constituent Update Batch process. When you commit the batch,
data captured on the Acquisition Form is written to the constituent's record — the record is created for
new constituents and updated for existing constituents.

Note: Consider using the Acquisition Form part — instead of the Email Signup Form — to capture
email signups going forward. The Email Signup Form will be deprecated in a future release.

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

Design Acquisition Form Part
1. Under General Properties, enter a Form Title that displays to web site users. You can also add

a Form Description to display below the form title to provide more information.

2. Under Fields, specify the Title for the fields section that displays on the form. Then, select the
fields to include on the form and whether or not they are required. The minimum required
fields — Last Name and Email Address — are selected by default and cannot be modified.
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To change the order in which the fields display on the form, select a field's row and drag up or
down in the list.

3. Under Attributes, enter a Title for the constituent attributes section that displays on the form.
Then select which constituent attributes from Blackbaud CRM to Include on the form and
whether they are Required fields. Only those constituent attributes you enabled in Sites &
settings that have a type of Yes/No, Table, and Text are available to display on the form.

4. To enable users to specify their consent preferences for how they want to receive
communication from your organization:

a. Under Consent part, select an existing Consent part to include on the form.
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b. Select how you want the communication preference options to display — choose Inline to
embed the options directly in the form itself or choose Overlay to display a pop-up window
with the consent options when the form is submitted.

5. To ensure users are not automated programs to generate spam or phish for information,
select Enable reCAPTCHA login to display reCAPTCHA on the Acquisition Form.

6. Specify a Constituent Code from Blackbaud CRM to apply to users who sign up using the
form.

7. Under Navigation, select the web page to display to users when the form is completed.
Select the binoculars to display the list of pages on your site to choose from. This field is
required.

8. Select Acknowledgment Email to design the email acknowledgment that's sent when a
website user submits the form. The Name of email, Subject, From address, and From name
fields are required. For more information about designing an acknowledgment email, see the
Email Guide.

9. Click Save.
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Advanced Donation Form
Tip: For best practice information about donation forms, refer to Best Practices for Donation Forms.

The Advanced Donation Form part is an alternative to the standard Donation Form part. The Advanced
Donation Form allows for customizations by your organization so you can enter your own HTML and
JavaScript to create features for the part the standard part does not include. For example, you can
create a customization that supports donations to various schools and designations or shopping cart
functionality.

Note: The Advanced Donation Form part offers additional flexibility, but comes with additional
complexity. If you host your own website, we strongly recommend only developers knowledgeable
in all areas of customizations design this page. This includes using endpoints, objects, and the API, as
well as writing HTML and JavaScript code. Users without this expertise should not design this part. For
information about the API, including REST API information, see the Developer Guide.

You download and manage transactions from the Advanced Donation part in Blackbaud CRM the same
way you download and manage transactions from the standard Donation Form. For information about
how to process donation transactions in Blackbaud CRM, see the Web Transactions Guide.

Design Advanced Donation Form
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

Note: If you are using multicurrency and browser/regional settings, prices are displayed on the
donation form in both the base currency for the database and the regional currency based on the
browser settings.

1. From the Design tab, to view donation options, select 1. Donation options under Build your
part.
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a. In the Minimum gift amount field, enter the minimum donation a donor can contribute.
Enter “0” or leave the field blank to allow donors to contribute any gift amount.

b. Under Payment setup, select the payment options for website users.
• To allow website users to pay for multiple transactions at one time, select Use payment part.

In the Payment page field, select the web page to use to process donations. The Payment 2.0
part on the selected page determines the payment methods and merchant account used to
process donations. For information about the Payment 2.0 part, see Payment 2.0 on page 158.

• To require website users to pay for donations one at a time, select Proceed directly to
payment. Under Payment methods, select the payment methods to offer to website users.
You can allow users to pay by credit card or make a pledge to pay later. Under Additional
payment fields, select whether to include reCAPTCHA on the form. When you select this
option, a reCAPTCHA checkbox displays below credit card payment fields on your Blackbaud
Secure Payments form. Users must select the reCAPTCHA checkbox before they can submit the
form

When you select Proceed directly to payment and the user clicks Donate on the part's web
page, the program uses the secure payment page to process the biographical billing
information and payment information. For more information about this page, refer to Secure
Payment Page on page 165. For more information about customizing this design, refer to the
Developer Guide.

2. To enable users to specify their consent preferences for how they want to receive
communication from your organization:

a. Under Consent part, select a saved Communication Consent part to include on the form.

b. Select how you want the communication preference options to display — choose Inline to
embed the options directly in the form itself or choose Overlay to display a pop-up window
with the consent options when the form is submitted.

After users submit the form, their consent information is downloaded along with their
transaction. After the appropriate batch is committed, their constituent record is updated on
the Communications > Preferences tab in Blackbaud CRM with their communication
consent preferences.

3. To view email options, select 2. Acknowledgement under Build your part.
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a. Under Acknowledgement, enter information for the email such as the subject and from
email address.

To receive responses from recipients at a different email address than the one you use to
send the message, click More Options and enter the address in the Reply Address field.

b. Under Notifications are to be sent to the following addresses, select Failures to receive
failure messages when email messages are not delivered. In the field beside the checkbox,
enter an email address to receive failure messages.

Failures are email addresses that do not receive the acknowledgement email. Failures can
also be called non-delivery receipts, bouncebacks, UnDeliverables, or Delivery Status
Notifications (DSN). For information about how the program handles failures, see the Email
Guide.

c. The bottom pane displays the acknowledgement email content. To format the message’s
appearance and layout, use the HTML editor. For information about the HTML editor, see the
Program Basics Guide.

Note: When you select Use payment part on the 1. Donation options step to integrate this part
with a Payment 2.0 part, the email fields on this step do not appear but you can use the HTML editor
to design content. The program uses the Payment 2.0 part's acknowledgement information for the
email. On the Payment 2.0 part, use the Combined Acknowledgements merge field to consolidate
this acknowledgement content with the Payment 2.0 part's content. If you do not include the merge
field on the Payment 2.0 part, website users do not receive the content from this part.

Blackbaud recommends that you use inline styles, such as <div style=”background-
color:Blue;”>Welcome color</div>, when you create and design the email content. Do not
define classes or use external references because email vendors, such as Gmail or Outlook,
are not guaranteed to render the styles correctly when the recipient reads the email.
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d. To personalize the message with information about the constituent, add merge fields. To
display the list of available merge fields, click Merge fields on the Insert tab in the toolbar.
Next, double-click or drag and drop the field in the content area.

e. In the body of the email, put fields where you want them to appear. For example, enter
“Hello First Name.” In the email, the recipient reads “Hello [the recipient’s first name].” To
move a field, click and drag it to the new location.

4. To design the donation summary that appears after a user submits a donation, select 3.
Confirmation Screen under Build your part.

Tip: When you select Use payment part on the 1. Donation options step, this step disables and the
program uses the Payment 2.0 part's confirmation screen design to display the donation summary
after a user submits a donation.

a. To use the program’s default confirmation screen, select Use default confirmation screen.

b. To customize a confirmation screen, select Use custom confirmation screen. The HTML
editor appears. The program’s default confirmation screen appears in the HTML editor for
you to customize according to your needs.

In the box, edit the content to appear for the donation summary. To format the content’s
appearance and layout, use the HTML editor toolbar. To include personalized information,
use merge fields. For more information, see the Program Basics Guide.

Tip: Customizations for the confirmation screen remain even if you select Use default confirmation
screen. To remove your customizations for the screen, select Use custom confirmation screen and
click Load Confirmation Template. The program’s default confirmation screen appears in the HTML
editor for you to customize again.

5. To customize the part for your donation page, select 4. Design under Build your part. In the
box that appears, sample code defaults for you to use as a starting point and reference. Enter
your own code, such as JavaScript, to customize features for your donation page. For
information about the API, including REST API information, refer to the Developer Guide.
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There are several important items to remember about the Advanced Donation Form part as
you design your donation page.

• You can enter your own HTML and JavaScript to create features for the part. For example, you
can create a customization that supports donations to various schools and designations or
shopping cart functionality.

• The endpoints you use in this box honor security. For example, users who do not have rights
to view this part also do not have rights to view its endpoints.

• If you use third-party software, such as Drupal, to customize the part, we recommend you
create a subdomain for the page to communicate with Blackbaud Internet Solutions.

• Whether you host your site or Blackbaud hosts your site, the secure payment page on the
hosted Blackbaud server processes all credit card payments for the Advanced Donation Form
part. For more information about Blackbaud secure payment, see Secure Payment Page on
page 165.

6. Click Save. You return to Parts.

Feature Comparison
Review the following table for differences between the Advanced Donation Form part you can
customize and the standard Donation Form on page 60.

Feature Advanced Donation Form Donation
Form

Appeals Yes Yes

32 CHAPTER 1



Feature Advanced Donation Form Donation
Form

Anonymous gift Yes Yes

Corporate gift Yes Yes

Finder number (when you integrate with
Blackbaud Direct Marketing)

Yes Yes

Gift comments Yes Yes

Recurring gifts Yes Yes

Revenue attributes Yes Yes

One-time gifts Yes Yes

Payment 2.0 support Yes Yes

Pledge (Bill me later) Yes Yes

Pledge installments Yes No

QAS Yes Yes

Tribute Yes Yes

Designation search Yes, but you must use JavaScript in the part Yes

Direct debit Yes, but you must integrate the part with a
Payment 2.0 part

Yes

Donor challenge No Yes

eCards No Yes

eReceipts No Yes

Email notifications No Yes

Impact statement No Yes

Matching gift No Yes

Name format field entry No Yes

Spouse information and joint gifts No Yes

reCAPTCHA No Yes

Marketing source code Yes No
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FAQs
In Blackbaud Internet Solutions, you can use the Donation Form part and the Advanced Donation Form
(ADF) part to accept online donations. The Advanced Donation Form part was developed in response
to customer feedback to provide a more flexible donation form. Refer to these FAQs for answers to
the most common questions.

FAQ #1: What is the difference between an ADF and a standard Donation
Form?
Both the Donation Form and Advanced Donation Forms share many common donation form features.
Both forms allow one-time or recurring donations, allow users to select from giving levels, and push
online donations down into a Blackbaud CRM Enhanced Revenue Batch.

We received feedback from customers that the original Donation Form part was too strict in its design.
Customers wanted to design their own donation experience. In order to reorder fields, change
captions, or change the design of the form, you had to use JavaScript or jQuery to alter the behavior of
the form. Based on discovery feedback, the Advanced Donation Form was created and released.

The Advanced Donation Form was created to be a form for developers. It uses an API, with set
endpoints (fields), to capture donation, donor, and payment information and send that to Blackbaud
CRM. The standard Donation Form has a lot of point-and-click configuration, so it is easy for non-
technical staff to set up a donation form. The ADF has very little point and click configuration. Most of
the configuration lies in HTML, CSS, and JavaScript code that is written directly into the part. An ADF is
not typically easy or quick to set up, unlike the standard Donation Form. While there are some
functional differences between the ADF and the standard Donation Form, the largest difference lies in
flexibility in the overall look and feel of the form and how the form is created.

FAQ #2: What features are not available in the ADF?
ADF is meant to offer the most commonly-used features. For more information, refer to Feature
Comparison on page 32.

FAQ #3: Do I have to be a developer to use the ADF?
While anyone can create an Advanced Donation Form part, we recommend that you leave this to a
developer. A solid knowledge of HTML, CSS, and JavaScript is required to build out the donation form
of your dreams. If you want a customized form design, but do not have developers on staff, Blackbaud
Services can design and build a form for you on a time and materials basis.

FAQ #4: What is the best way for my organization to determine if I need an ADF
or can use the standard Donation Form?
The first step in determining which form works better for you is establishing your overall online
donation strategy. How do you guide people to your donation forms? How many donation forms do

34 CHAPTER 1



you have? What are the differences between them?

After you have a good strategy, determine what your requirements are for each form. Are you only
allowing recurring gifts to be entered on a specific form? Do you have one form that handles all giving
needs? Compare these requirements to the Feature Comparison chart (linked to above) to determine
the form that works best for you.

If you want to build a unique donation experience with the Advanced Donation Form, but it does not
handle all of your feature requirements, assess the impact of not having the feature. For example, if
one of your requirements is to capture spouse name information, how many of your donors input this
information on your current form? If joint gifts and spouse information is put into the Comments field,
how much extra work does that cause your gift administrators? Can you separate out those donors
through your site user experience and use a standard Donation Form for only those instances?

Blackbaud has a long term goal to bring feature parity to the ADF. Until then, features and functions
must be weighted carefully with design aesthetics to determine if using an ADF is right for you.

FAQ #5: How do I go about designing the user interface for my donation form
part?
Once you have determined that your requirements fit the Advanced Donation Form, it is time for the
fun part—designing the user interface. The only visual requirement of an ADF is that it must use the
Blackbaud secure payment web page to capture billing information as the last step of your form. The
best way to design your form is first to look at your competitors and other organizations like you, and
then build out a wireframe that lays out the functions of the form. By getting internal signoff on the
wireframe first, you lessen the amount of coding changes that need to be made once you build the
form.

FAQ #6: Is the ADF responsive?
Because the design and markup of the form is completely up to you, it is up to your developers to
code the ADF to be responsive. Blackbaud Internet Solutions layouts and templates can be made
responsive. By adding a responsive ADF form, your donation form would then be considered
responsive.

FAQ #7: How do I get my designations into my ADF? What if I want to show a
designation hierarchy?
You add designations within the code by referencing their GUID. You can also pull a collection or
group of GUIDs by creating a query resulting in the designations you want and adding the query GUID
into the ADF to pull your designations. The GUID can be obtained via SQL (if you have access to SQL)
or by creating a query with your designations as the query result and including the Systems Record ID
field in your query output.

To include multiple designations, create a query with your designation filter criteria. (Tip: Many
customers use tags or attributes to mark their designations for online use, and then query off of that
criteria.) Use the query GUID instead of the designation GUID to pull in the designations from your
query results.
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Designation hierarchies (also known as cascading fund drop downs) must be created with custom code
and JavaScript.

FAQ #8: How do I get support for the ADF I am building? Can I just call the
regular Support line?
Because of the custom code each customer can build into the Advanced Donation Form, the Advanced
Donation Form is considered a customization that requires a level of developer expertise to be
enhanced or modified. While our Support analysts can answer high-level questions about built in
functionality of the Advanced Donation Form, they cannot help you code it or troubleshoot your
custom code. We recommend that you review our Developer Guide and code samples for the
Advanced Donation Form. Alternatively, our Professional Services team can offer consulting and build
support for an additional cost. You can also use the discussion forums on the Blackbaud Developer
Network to ask your peers.

FAQ #9: If I send an email from Blackbaud Internet Solutions or Blackbaud CRM
Marketing Efforts, is my finder number and other email information still
captured?
Just like the standard Donation Form, donations made through ADF pass finder number and other
email identifiers to Blackbaud CRM revenue records when they initiate their ADF donation through an
email sent from Blackbaud CRM (finder number + referring email information) and Blackbaud Internet
Solutions (referring email information).

FAQ #10: Why is there not any sample code to help make this work?
In order to be able to update sample code more proactively than product releases allow, sample code
for the Advanced Donation Form lives on the BBIS Developer Network. We encourage customer
developers to also share their own code with their peers through the Github repository on the site.

Anonymous Newsletter Subscription
With the Anonymous Newsletter Subscription part, you can offer a newsletter for website users to
subscribe to without registering on your website. Because the subscriber does not create a user
account, no sign-up transaction or constituent record is created in Blackbaud CRM. Typically, you may
want to enable anonymous subscriptions for a particular newsletter, such as an introductory newsletter,
that leads subscribers to become more involved with your organization and become active users and
constituents.

Tip: To keep information for anonymous newsletter subscribers private, subscriber data is stored in
the online database. You cannot view it on the administrative side of the website.

On the web page, the Anonymous Newsletter Subscription part appears as a box where users can enter
their names and email addresses and click a button to subscribe.
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Design Anonymous Newsletter Subscription
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Newsletter field, select the newsletter that users can anonymously
subscribe to.

2. In the Form title field, enter the text to appear at the top of the Anonymous Newsletter
Subscription part on your website, such as “Get the Newsletter!”

3. In the After subscribing navigate to field, select the web page, such as a Welcome or Thank
You page, to appear after the site user clicks Subscribe.

Note: If you do not select a web page in the After subscribing navigate to field, the website user
returns to the Anonymous Newsletter Subscription part after he clicks Subscribe.

4. Click Save. You return to Parts.

Change User ID/Password
With the Change User ID/Password part, website users can change their usernames and passwords in
the online database without affecting the usernames and passwords for other integrated Blackbaud
programs. On the website, the user can update the username and password.

Design Change User ID/Password
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the After update navigate to field, select the web page to appear
after the website user changes the username and password.
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Note: If you do not select a web page in the After update navigate to field, the Home Page
selected on the Settings tab in Sites & settings automatically appears after the website user changes
the username or password.

2. In the Fields grid, select the fields to display on your Change User ID/Password form. You can
include the User Name, Password, Confirm Password, and Time Zone fields. For details
about the grid, see Change User ID/Password Fields Grid on page 38.

Note: If the site only collects email addresses for user logins, Email Address appears instead of User
Name as the login field option.

3. Click Save. You return to Parts.

Change User ID/Password Fields Grid
The table provides information about the options in the Fields grid on the Change User ID/Password
part.

Option Program Administrator
or Website User?

Notes

Include Program Select the checkbox next to the fields to include on your
Change User ID/Password form.

Field N/A Displays the default field name for your Change User
ID/Password form.

Editable Program and website To enable other users to edit the field, select this checkbox.
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Option Program Administrator
or Website User?

Notes

Required Website To make a field required on the Change User ID/Password
form, select this checkbox.

Communication Consent Part
The Communication Consent part enables you to capture explicit communication consent from your
constituents — and to assist with General Data Protection Regulation (GDPR) compliance — on your
Blackbaud Internet Solutions forms. Website users can make consent option preference selections on a
web form. This includes specifically opting in or opting out of specific consent options.

As an organization, you can create one Communication Consent part — or multiple versions of the part
— to support the forms in Blackbaud Internet Solutions that collect constituent information and write
the data to constituent records in Blackbaud CRM.

You can include a Communication Consent part on any of the following forms in Blackbaud Internet
Solutions by configuring the Consent section on the form's Design tab:

l Donation Form

l Event Registration Form (Classic)

l Events Registration Form

l User Login Form

l Payment 2.0 Form

Note: This form supports consent for all transactions types — donations, event registrations,
memberships, and sponsorships.

l Advanced Donation Form

After users submit the form, their consent information is downloaded along with their transaction.
After the appropriate batch is committed, their constituent record is updated on the Communications
> Preferences tab in Blackbaud CRM with their communication consent preferences.

Note: You can expect a lag time of approximately 5 minutes between the time you commit a
donation or membership transaction batch and the time the consent preferences are written to the
constituent's record in Blackbaud CRM.

After a user has already provided consent preferences, if they fill out a subsequent form that includes
the Communication Consent part and they are logged into Blackbaud Internet Solutions, their consent
preferences are automatically pre-populated. Users can modify their consent preferences, and the
changes are then written to their constituent record when they submit the form.

If a transaction is canceled for any reason, the user's consent preference selections for that transaction
are not written to their constituent record.

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.
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Design Communication Consent Part
1. Under General, enter a title to display on the web page for the communication consent

preferences or use the default title. This field is required.

2. Under Consent Statement, enter customized instructions or use the default statement.

3. Under Consent Options, add the consent options you want to display on the web page.

a. Select Add Option to search for solicit codes or consent solicit codes that are configured in
Blackbaud CRM, then choose the ones to include on the form. For each consent option, you
can modify the caption that displays on the form, specify whether the option is required, or
remove the option.

b. To add a divider to separate sections on the form — for example, to keep all email consent
options together — select Add Separator and include a caption for the separator.

You can click and drag the consent options to reorder them and to move the corresponding
separators.
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4. Under Privacy Policy, select an option for including access to your organization's privacy
policy on the web page. Select Create link to Blackbaud Internet Solutions page, then click
the binoculars to choose an existing page on your website that includes your privacy policy.
Select URL to include an external link to the privacy policy, then enter the URL. If you don't
want to include a link, select None.

5. Select Save.

Content Comparison
With the Content Comparison part, you can compare the effectiveness of different appeals to your
website users. For example, you can create multiple Formatted Text and Images parts to promote an
event or to solicit donations. On the Content Comparison part, you add up to six of these parts and
select a target page, such as a page with an event registration form or donation form. After you place
the Content Comparison part on a page, it randomly displays the Formatted Text and Images parts to
website users and tracks the click-through rate to the target page. After a user views the comparison,
the program associates the user with a particular Formatted Text and Images part so that each user
only sees one part in the comparison. To track users, the Content Comparison part uses the login
information or cookies that identify the user’s computer.

The Formatted Text and Images parts in the comparison must include links to the target page because
the comparison measures their effectiveness by the click-through rate to the target page. The
comparison also measures the conversion rate if the target page includes a donation form, event
registration form, payment part, survey part, or user login. For example, if the target page includes an
event registration form, the comparison tracks how many users register for the event. If the target page
includes a donation form, the comparison also tracks the amount donated.

The Content Comparison part tracks the performance of Formatted Text and Images parts until it
achieves statistical significance. The number of Formatted Text and Images parts in the comparison
determines the default threshold to reach statistical significance, but you can also select your own
threshold. Comparison statistics are not calculated in real time but are updated nightly. After the
comparison reaches statistical significance, the Content Comparison part ends the comparison and
displays only the most effective Text and Formatted Images part. If you decide to use a different Text
and Formatted Images part, you can override this selection.

Design Content Comparison
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, browse to the target page for the comparison. To track the click-through
rate, the Formatted Text and Images parts in the comparison must include a link to the target
page.
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The comparison measures the effectiveness of the Formatted Text and Images parts by the
click-through rate. It also measures the conversion rate if the target page includes a donation
form, event registration form, payment part, survey part, or user login. If the target page
includes a donation form, the comparison also tracks the amount donated.

2. To override the default threshold for the comparison, enter the number of users who must
click through to the target page in the Threshold field. The default threshold to achieve
statistical significance is based on the number of Formatted Text and Images parts in the
comparison.

3. Under Add parts, add parts to the comparison. You can only include up to six different
Formatted Text and Images parts. You cannot edit the parts during the comparison.

• To add an existing part, click Add Part for Comparison. The Select a Part screen appears with
all available Formatted Text and Images parts.

• To create a part, click Create Part for Comparison. The New Part screen appears with
“Formatted Text and Images” in the Part Type field. For information about how to create a
Formatted Text and Images part, see Formatted Text and Images on page 117.

Note: After you add Formatted Text and Images parts to the comparison, you can edit and delete the
parts from the Content Comparison part. After you start the comparison, you can no longer edit or
delete the parts. In addition, while a Formatted Text and Images part is placed on the Content
Comparison part, you cannot delete it elsewhere in the program.
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4. To start the comparison, click Enable Comparison. The status appears. The comparison tracks
the performance of the Formatted Text and Images parts until it achieves statistical
significance.

5. After you enable the comparison, click View Report to view details.

6. Click Save. You return to Parts.

Custom Parts
In Administration, Custom parts, you can create a new custom content part type or link to an existing
framework part type. After you create or link to the part type, it is available for selection in Parts.

Note: Custom parts offer additional flexibility, but come with additional complexity. If you host your
own website, we strongly recommend only developers knowledgeable in all areas of customizations
design them. This includes writing HTML and JavaScript code. Users without this expertise should not
design these parts. If Blackbaud hosts your website, customizations can only be completed by
Blackbaud or one of our designated partners. For more information, please contact your Blackbaud
Account Executive.

To create a custom content part type, click New content part. A custom content part uses JavaScript
and HTML to create the part editor and define how to display the part on a web page. You can use
custom content parts to create customizations such as slideshows, tabbed content, RSS Feed readers,
accordion content, pop-up boxes, and callout boxes.

To link to an existing framework part type, click New framework part. To build custom framework
parts for your website, you should understand Blackbaud Internet Solutions from a site designer’s
perspective and have a working technical knowledge of ASP.NET. The content for custom framework
parts can come from a variety of sources and can be as simple as text or HTML stored in the Blackbaud
Internet Solutions database, or it can be data from the back office such as constituent giving history.
For example, you can use a custom framework part to create a custom individual search form or a
custom pledge form for Blackbaud Internet Solutions.

To learn more about custom content parts, review Anatomy of a Custom Framework Part and Custom
Content Parts. You can also contact Professional Services. For information about how to create custom
framework parts, visit the Blackbaud Developer Network or refer to the Developer Guide.
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Designation Details
Use the Designation Details part to provide a detailed description of a designation. For example, the
Designation Search part displays a short description of each designation. To provide a more detailed
description, you can link from the search results to a page that contains a Designation Details part.

Design Designation Details
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Designation summaries, design the search results display. Use
merge fields to include information about designations included in the results. The text box
includes the Public Name, Purpose Description, and Designation Tags List merge fields by
default. If you need other merge fields, click Advanced merge fields to select additional field
groups. After you select field groups, the Merge fields button on the Insert tab in the toolbar
appears so you can add the additional merge fields to the display.

To format the content’s appearance and layout, use the HTML editor. For more information
about the HTML editor, see the Program Basics Guide.

Tip: To include an Add to cart link, insert the Designation.BeginAddtoCart and
Designation.EndAddtoCart merge fields. Users can click this link to add designations in the search
results to their shopping carts.

2. Click Save. You return to Parts.
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Designation Search
With the Designation Search part, website users can enter key words or select search filters to search
for designations. You can choose the type of filters available for the search and you can design the
content for the search results display.

Warning: To avoid data conflicts, you can add only one Designation Search part on a web page. You
also cannot add a Record Search part to a page that contains a Designation Search part.

You can use the Designation Search part with other parts to create a powerful designation search
feature on your website. For example, this is one possible workflow:

• The search results include a short description of each designation that meet the search terms. To
provide a more detailed description, you can add a link from your Designation Search part to a
page that contains a Designation Details part or to another web page that contains more
information about the designation. For more information, see Designation Details on page 44.

• To guide users to designations based on their interests, add a Suggested Content part. The
Suggested Content part recommends designations that match the user’s interests and the tags
assigned to parts they have recently accessed. For example, if the user has “Whales” assigned as a
user interest on his constituent record and he viewed parts with a “Whales” tag, the Suggested
Content part recommends designations dedicated to whales. For more information, see Suggested
Content on page 213.

• When you add a Payment Summary 2.0 part to your template, users can view all the transactions
currently in their shopping carts, including any payments for designations. For more information,
see Payment Summary 2.0 on page 167.

• To include a list of designations that a user donated to in the past, you can include a Query Results
Display part. For more information, see Query Results Display on page 176.

Design Designation Search
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under General options, select a query in the Designation query field.
The output fields from the selected query are used as search filters on the designation search
form.
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2. In the Results per page field, select the number of results to display on the page. If the search
returns more results than the number entered, the results display on additional pages.

3. Select Search when page loads to automatically search and display all results when the page
loads.

4. Under Designation filters, move fields from the Available box to the boxes on the right.

• Shared search field for multiple filters — This option creates a single keyword search field
for multiple filters. For example, you include the public name and description as filter fields.
Users can enter keywords in a search field and the program will return any public names or
descriptions that match the keywords. For fields where users select from finite lists such as
code table entries, it may be better to use the Unique search fields for each filter option.

• Unique search fields for each filter — This option creates multiple search fields to provide
precise search results for each filter. This is most useful for fields where users select from finite
lists such as code table entries. For example, if you include the designation’s purpose category
and tags, users can select from the available categories and tags.

5. Under Designation summaries, design the search results display. Use merge fields to include
information about designations included in the results. The text box includes the Public
Name, Purpose Description, and Designation Tags List merge fields by default. If you need
other merge fields, click Advanced merge fields to select additional field groups. After you
select field groups, the Merge fields button on the Insert tab in the toolbar appears so you
can add the additional merge fields to the display.
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To format the content’s appearance and layout, use the HTML editor. For more information
about the HTML editor, see the Program Basics Guide.

Tip: If you assigned details page URLs to the Web tab of designation records in Blackbaud CRM, you
can add the Designation.BeginDetailsPageLink and Designation.EndDetailsPageLink merge fields
to include a link to the specified URL. If you did not assign URLs to designation records, you can add
the Designation.BeginNoDetailsPageURL and Designation.EndNoDetailsPageURL merge fields
and insert a link to a page that contains a Designation Details part.

Tip: If you assigned thumbnail images on the Web tab of designation records in Blackbaud CRM, you
can add the Designation.ImageThumbnail merge field to include the image in the search results.

Tip: To include an Add to cart link, insert the Designation.BeginAddtoCart and
Designation.EndAddtoCart merge fields. Users can click this link to add designations in the search
results to their Payment 2.0 shopping carts.

6. Click Save. You return to Parts.

Directory
With a Directory part, you can allow website users to search for other website users in defined groups
of constituents. Users can then view profile displays to learn more about constituents. To publish
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directories on your website, you use constituent queries to access information about website users. For
example, you can create a constituent query for the Class of 2000 in Blackbaud CRM and use it to
create a directory of users in that class. You can then select fields for website users to search against.
For example, you can allow users to search the directory for data in the First Name, Last name, and
State fields. You can also provide links from the directory to constituent personal pages.

Note: The directory search can return up to 500 results that match the criteria entered by a site user.
Site users can use wildcard characters (brackets, underscores, percents, question marks, and asterisks)
in their search criteria.

You also select the fields to appear on your web page when the user’s search produces results. For
example, you can select to display First Name, Last name, Address Line 1, City, and State fields for
your directory results. The field you list first for results links to the constituent’s published profile
information.

You can also allow website users to send personal messages to others in the directory without sharing
their email addresses.

Design Directory
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Directory title field, enter a name for the directory, such as “Class
of 2000 Directory.”

2. Under Records to Include, specify the records to include in the directory's search results.

a. The Limit to query field displays the selected query of records included in the directory. By
default, “All Constituents” appears.
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Tip: For a query to appear as a selection, you must first create it in Blackbaud CRM. When you create
a query, you may need to refresh the website for it to appear as a selection. To refresh, select View,
Refresh from the menu bar.

To include information from all constituents in your database, leave the default database “All
Constituents.” To select another existing constituent query to use as the directory, click
Change. The Query Search screen appears. For information about how to use the Search
screen, see the Program Basics Guide.

b. In the Include field, select the type of constituent records to include in the directory search
results. You can select “Both Organizations & Individuals,” “Individuals Only,” or
“Organizations Only.”

c. To include deceased constituents in the directory search results, select Include Deceased.

3. When you use the Academic Catalog in Blackbaud CRM, an Education Fields section appears.
In the Include field, select whether to include academic information from affiliated
educational institutions only or both affiliated and unaffiliated institutions for the search and
results filters.

Tip: To improve search performance, narrow the volume of institutions to search by selecting
"Affiliated educational institutions" in the Include field. After you save the part, you cannot change
your selection in this field.

In addition to this section, more educational fields are available to integrate Academic Catalog
data with this part on your website. Under Available Fields, in the Additional Information
nodes for Primary Alumni and Education History, the College/School, Division,
Department, Sub Department, and Degree type fields appear to support the integration.
When you use these fields, website users can search and view the information in the directory
display window for affiliated and unaffiliated institutions, depending on the selection you
make in this section. For example if you select "Affiliated educational institutions" and include
the Department field, users can narrow their search by selecting a department and then view
the information in the search results for affiliated institutions only. Also, you can use the
Program and Degree fields under the Primary Alumni and Education History nodes to
search and display this data for affiliated and unaffiliated institutions.

Note: When you enable or disable the Academic Catalog in Blackbaud CRM and then add or remove
Academic Catalog fields on the part for your web page, the changes do not reflect on your website
for approximately 20 minutes.

4. Under Search Form, in the Split search fields into field, select how many columns of search
fields to appear in the criteria table. You can display up to five columns.

To process a search while the user browses your Directory part, select Load unfiltered results
when this part is loaded. When you select this checkbox, the directory search processes
before the user enters criteria and clicks Search on your website.

5. Under Results, set up how search results appear on your Directory part.

a. In the Show navigation controls field, select whether the navigation buttons should appear
above the results, below the results, or both above and below the results.

b. The directory search can return up to 500 results that match the criteria entered by a site
user. In the Results per page field, select the maximum number of results to appear on a
page when a site user searches the directory. You can display up to 50 results per page.
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c. You can include in the search results the total number of records that met the user’s search
criteria. In the Show number of results field, select whether to display the total number of
results above the results, below the results, or both above and below the results.

d. To display an alphabetical index so that website users can filter search results by the first
letter of last names and organization names, select Enable alphabetical index for individual
and organization name. Then in the Display text field, enter the field label to display
beside the alphabetical index.

e. In the No records found message field, enter the message to appear if no records meet the
search criteria the user enters to search the Directory on your website. By default, the
message “No directory entries match your criteria” appears.

f. Directory results can link to a page that contains a Profile Display part. In the Linked profile
page field, select the page to link to. The field you list first in the Listing Fields box
becomes the link to the page you select in Linked profile page field.

Note: When website users open profile pages from directory search results, a Back to search results
link appears at the top of the page.

g. To allow website users to send personal messages to constituents in the results, in the
Include a send message link for field, select the User Networking Manager part to link to
the directory results.

Note: If constituents opt out of email in Blackbaud CRM, website users can send them personal
messages through the user networking site, but they cannot send them email messages.

h. To allow website users to send personal messages through the User Networking Manager
part to constituents who are not registered website users or who are registered but are not
members of the user networking site, select Allow messages to non-users.

Warning: Constituents who do not have user networking accounts receive personal messages
through email. To allow users to send email messages to these constituents, you must enable a
Directory Message Notification in Email and select the User Networking Manager part for it. Without
this notification, your users will not be able to send messages to constituents who are not registered
website users or to constituents who do not have social networking accounts. For more information
about notifications, see the Email Guide.

6. Under Fields to Include, select the fields the user uses to search the directory, such as First
Name or Last name. Drag the field from the Available Fields box to the Search Form Fields
box, or select the field in the Available Fields box and click the right arrow to move it to the
Search Form Fields box.
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When you integrate with Blackbaud CRM, do not include the Business.County or
PreferredAddress.County field in the Search Form Fields box. Blackbaud CRM does not
support these fields in a directory search.

Note: The system administrator selects the attributes available on the Settings tab in Sites & settings.
For information, see the Administration Guide.

To arrange the placement of a field in the Search Form Fields box, select the field and click
the Up or Down button.

Note: The fields in the Search Form Fields list and the Listing Fields list do not have to match.

7. Next, under Fields to Include, select the fields to appear in the directory display window.
Drag the field from the Available Fields box to the Listing Fields box, or select the field in the
Available Fields box and click the right arrow to move it to the Listing Fields box.

To arrange the placement of a field in the Listing Fields box, select the field and click the Up
or Down button.

While you can link every field, the field you place first in the Listing Fields box automatically
links to the page you select in the Linked Page field. For example, you select to display the
alumni’s last name, first name, birth date, and address. In this case, the last name is the link.
When results appear, to indicate the last name is a link, it is underlined and changes color
when you drag your mouse over it. When a website user clicks the alumnus’s last name, the
published profile information for that constituent appears.

PARTS 51



Note: When a website user selects the Make my primary email address private checkbox on your
Profile Update Form web page, it also designates their primary email address as private for this part
on a web page.For more information, refer to Contact Information.

8. To allow website users to send personal messages through the directory, select Allow
messaging between users under Messaging Fields.

Note: Website users must be logged in to Blackbaud Internet Solutions to use directory
messaging. Anonymous users cannot send messages through the directory.

If desired, configure the message's default text:

a. In Default subject, edit the text that displays in the subject line of the email message.

b. In Confirmation message, edit the text to display to the user after the message has been
successfully sent.

c. In From address, enter the sender's email address.

Note: To avoid having the email rejected or considered spam, the From address must be an email
address on a domain that the organiization owns and controls. This is necessary as some email
providers, such as Yahoo and AOL, have strict DMARC policies that reject any emails with a
yahoo.com or aol.com email address that have not originated from those domains.

d. In From name, enter the sender's name.

e. Configure the default email message and the default opt-out message.

Note: When messaging is enabled, an email icon ( ) displays in the directory's Messaging
column for users that have a primary email address and have not opted out of messaging. To send
a message, click beside the recipient's name. The email is sent via the organization to the
recipient, and the recipient's email address is not visible to the sender. A confirmation message
displays when the email is successfully sent. Website users can send a maximum of 10 messages
per hour.

9. Click Save. You return to Parts.

Discussion Group
Select the Discussion Group part type to create an electronic bulletin board so website users can
participate in interactive discussions. For example, you can create a Reunion 2007 Discussion Group for
your alumni to plan events and arrange to meet with old friends. Website users can submit new topics
or add responses to existing topics in this electronic bulletin board. Your organization can create
multiple Discussion Group part types to post on your website.

If you have manager rights, you can approve and delete messages and topics posted to the website.
Additional buttons also appear on messages for discussion group managers. To block the content of a
message without affecting replies to the message, click Block. To delete a message and all replies to
the message, click Prune.

52 CHAPTER 1



Design Discussion Group
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Group Name field, enter the main topic of discussion to generate,
such as “Reunion 2007.”

2. In the Post New Topic Message box, enter the message to appear on your website to provide
users with more information about the discussion topic. For example, enter “Post a new topic
for the Reunion 2007 discussion group. Feel free to start a discussion about a reunion event or
meeting with friends at your favorite old college hang-outs!”

Note: The website user’s message box for postings is limited to 3000 characters.

3. In the Post New Reply Message box, enter the message to appear on your website for users
who post a message. For example, enter “Thank you for participating in the Reunion 2007
discussion! We look forward to seeing you on campus!”

4. If you select Require approval for topics and messages added to this group, topics and
messages posted by users with Can Manage rights appear on your website immediately. A
user with manager rights must approve other topics.

Warning: If you do not select this checkbox, all topics appear immediately on your website.

5. Under Security Rights, assign Manage rights to roles for discussion group users. To assign Can
Manage rights to a role, select its checkbox.
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To include additional users and roles, select Add users and roles.

Note: Managers can approve or delete any messages and topics added to groups. Additional buttons
appear on messages for managers. To block the content of a message without affecting replies to the
message, click Block. To delete a message and all replies to the message, click Prune. For more
information about how to manage a discussion group, see Manage Discussion Group on page 55.

6. To allow users to participate in the discussion group anonymously, select Allow Anonymous
Posting. In the Choose a default display name for an Anonymous poster field, enter the
name to appear when an anonymous user posts on the discussion group, such as
“Anonymous.”

7. Under Spelling Correction, customize the messages on your website for users who participate
in the discussion group.
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a. In the Topic With Errors Message box, enter the message to appear if a website user posts
a new topic with spelling errors.

b. In the Topic With No Errors Message box, enter the message to appear if a website user
posts a new topic without any spelling errors.

c. In the Reply With Errors Message box, enter the message to appear if a website user posts
a response to an existing topic with spelling errors.

d. In the Reply With No Errors Message box, enter the message to appear if a website user
posts a response to an existing topic without spelling errors.

8. Click Save. You return to Parts.

Manage Discussion Group
If you are a user with Manage rights, you have additional options with the Discussion Group part
type. These options are available when you log in to your website with your manager role.

1. Using your manager role with Manage rights, log in to your organization’s website.

2. In the upper right corner of your Discussion Group part, the View field appears. In this field,
select whether to view all postings, only approved postings, or only those postings pending
approval.

Note: If Require Approval for Topics Added to This Group is not selected on the Edit Part screen
for the discussion group, Approve does not appear on your website for users with manager roles.
However, the View field and Delete remain available.

3. Manage the messages and topics of the discussion group.
• To approve a message or topic, click Approve in the same row as the message or topic to

approve. This makes the information available for all website users to view and respond.
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• To delete a message or topic, click Delete in the same row as the message or topic to
remove. This permanently removes the information from the website.

• To block the content of a message without affecting replies to the message, click Block in the
same row as the message to block.

Note: When you click Block, the button changes to Unblock. To recover the message, click Unblock.
• To delete a message and all its replies, click Prune in the same row as the message to prune.

The program deletes only the selected message and its replies. Any messages posted in the
topic prior to the pruned message remain.

4. To return to the administrative side of the program, log out of the website or click Go to
Blackbaud Internet Solutions on the toolbar.

Documents
Using the Documents part, you can easily upload documents of any type to a web page and share the
information. For example, you can upload a Microsoft Word document (*.doc file type) of your board
meeting minutes. You can include a message to appear on the website page that provides details
about the information the document contains. For your board meeting minutes Word document, you
can include “Board Meeting minutes from 05/05/2007. Please call the office if you have questions or
comments.”

The ability to upload documents is based on security rights. For example, users with manager rights
can approve and delete documents.

Note: If you do not want users to upload a document to a web page and want to create a link to a
document for users to access, use the HTML editor. For more information, see the Program Basics
Guide.

Design Documents
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, select a folder in Files to store the documents. You can also create a new
folder on the Select Folder screen. The part displays all files in the folder.
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2. In the Title field, enter a name to identify the documents on the web page. For example, enter
“Board Meeting Minutes.”

3. In the Message field, enter the message to appear on the web page. For example, you can
provide details about the documents or instructions for site users.

4. In the Upload button field, enter a label for the button that website users click to upload
documents to your website.

Tip: There is not a limit to the number of documents on your website. However, hardware space
limitations may constrain the number of documents you are able to store in the online database. The
more documents your website has, the more hardware space used.

5. In the Maximum file size field, enter the maximum size of a document to store on your site.
The size is stored in kilobytes. By default, the maximum file size is typically 4096 KB.

Warning: To prevent possible Denial of Service attacks, there is a limit to the size of the files you can
upload. The default is typically set to 4096 KB, but the system administrator can adjust it up to 10,000
KB. We do not recommend you go over this size. The administrator can specify this limit in the
Web.Config file. For example, to increase the file size, add maxRequestLength="8192" (where 8192 is
the file size) to the <httpRuntime useFullyQualifiedRedirectUrl="true" /> key. For very large files,
increase the website timeout setting. For example, to increase the timeout setting, add
executionTimeout="120" (where 120 is the duration in seconds) to the <httpRuntime
useFullyQualifiedRedirectUrl="true" /> key. Before you maximize the document file sizes or website
timeout settings, visit http://support.microsoft.com/?id=295626 and review the Microsoft
Knowledgebase article.

6. Specify whether uploaded documents require approval before they appear on your website.
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• If you select Require approval, documents posted by users with Manage rights appear on
your website immediately. Other documents must be approved by a user with manager rights.

Note: To enhance security for your website, we recommend you select Require approval.
• If you do not select Require approval, all documents appear immediately on your website.

7. To limit the file types available to upload to your site, select Restrict by file type.

a. Under Common types, select the file type to make available on the site. To move the type
from the Common types box to the Allowed types box, click Add.

b. To move all file types at the same time, click Add all. All file types move to the Allowed
types box.

8. To add file types not available under Common types, click Add additional types. The Add
custom file type screen appears for you to enter the custom MIME type.
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For information about how to enter a custom MIME type, see Add Custom MIME File Types on
page 59

9. Under Security Rights, specify the roles with manage and upload rights for the Documents
part.

a. In the Manage column, select the checkbox to assign manage rights to users and roles. This
grants rights to add, edit, and delete documents. If the part is marked Require Approval,
these users and roles can approve documents.

Note: If the part is marked Require Approval, documents are pending until a user with Manage
rights approves them. A user with Upload rights can view his or her pending documents, but not
those of other users with Upload rights. Only users with Manage rights can view all pending
documents.

b. In the Upload column, select the checkbox to assign upload rights for documents to users
and roles. This does not grant rights to edit or delete documents.

c. To include additional users and roles, select Add users and roles.
10. Click Save. You return to Parts.

Add Custom MIMEFile Types
On the Documents part when you select to restrict by file type, under Common types, 28 common file
types pre-populate for you based on the Internet Assigned Numbers Authority (IANA) MIME Media
Types standards. However, you can choose to add additional custom MIME types your organization
allows for upload. For each custom file type, you enter the MIME type, sub-type, and extension.

Add a custom file type
1. From the Design tab, select Restrict by file type.

2. Under Allowed types, click Add additional types. The Add custom file type screen appears.
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3. Select the MIME content type.

4. Enter the MIME sub-content type. For example, for the application content type, you enter
msword, pdf, and postscript.

5. In the Extension field, enter the file extension for the sub-content type. For example, the file
extension for msword is .doc or .docx, the file extension for pdf is .pdf, and the file extension
for postscript is .ps.

6. Click Add. You return to the Design tab and the new custom file type appears under Allowed
types.

Donation Form
Tip: For best practice information about donation forms, refer to Best Practices for Donation Forms.

For a new Donation Form part, you select the constituency, fund, and giving levels for web donations.
When you select a Donation Form part for your web page, a canned donation form appears using the
constituent code, fund, and giving level information you select.

The Donation Form part also contains an Acknowledgement screen. On this screen, you can create a
standard email to send to donors who donate via your website.

As an alternative to the standard Donation Form, you can create the Advanced Donation Form part to
design a custom donation page for your organization. This part provides a way for you to enter your
own HTML and JavaScript to create features this part does not include. For example, you can create a
customization that supports donations to various schools and designations or shopping cart
functionality. For more information, seeAdvanced Donation Form on page 28.
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When you download gifts from your website, you can create gift records for the donations in
Blackbaud CRM. The gift records can include data such as amount, credit card number, billing address,
an option to give anonymously, and comments.

Note: To design, style, and test a part on your website without creating transactions, generating
emails, or communicating in any way with Blackbaud Services or Blackbaud CRM, select Test Mode
on the Properties tab. For example, you can complete the fields on a donation form to ensure the
confirmation page is styled and working properly. Although you submit the donation and receive a
confirmation, a transaction does not appear on the Web Transactions page in Blackbaud CRM. Use
Test mode to verify the user’s experience, not to test data processing. Test mode does not validate
credit card numbers and merchant accounts. Only users with supervisor rights can view parts in Test
mode.

Warning: To avoid security issues, do not use an iFrame from a third party website to direct users to
this part on a web page. We recommend you design the page to include the same look and feel as
your third party site so that users seamlessly transition to the page.

• Design Donation Form: General and Donor Gift Schedule Options on page 61

• Design Donation Form: Donor Options on page 62

• Design Donation Form: Designations and Giving Levels on page 64

• Design Donation Form: Sources (Appeals), Donor Challenge, and Required Fields on page 64

• Design Donation Form: Additional, Spouse, and Attribute Information on page 66

• Design Donation Form: Payments and Pledges on page 67

• Design Donation Form: eCards on page 69

• Design Donation Form: eReceipts on page 70

Design Donation Form: General and Donor Gift Schedule Options
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

Tip: For best practice information about donation forms, refer to Best Practices for Donation Forms.

1. You can specify a constituency to apply to new and existing constituents who use this part to
contribute and select the minimum amount the donor can enter.

a. In the Constituency field, select a constituency to assign to donors.

For more information about constituencies, see the Constituencies section of the Program
Basics Guide.

b. In the Minimum Gift Amount field, enter the minimum donation a donor can contribute.
Enter “0” or leave this field blank to allow donors to contribute any gift amount.

2. To allow donors to contribute a single gift and pay the total amount at the time of the
donation, select Allow one-time gifts under Donor gift scheduling options. A One-time gift
option appears under Type of gift on the donation form.

3. To allow donors to contribute regular recurring gifts, select Allow recurring gifts. A
Recurring gift option appears under Type of gift on the donation page. When a donor
selects Recurring gift, Frequency options appear.
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Tip: To avoid reconciliation conflicts in Blackbaud CRM, you cannot select direct debit payments for
one-time payment gifts. This impacts multiple areas in Blackbaud Internet Solutions. When you
configure this part and select this checkbox, a message appears to inform you to select credit card as
the payment option. On the donation web page, when a website user selects One-time gift, the
Direct Debit payment option removes so the user cannot select it. If the gift is recurring and the
website user selects today's date as the start date for the first payment, the gift does not immediately
send to Blackbaud CRM. It is processed according to the recurring gift schedule and the EFT workflow
process in Blackbaud CRM. Also, when a website user includes a one-time item in the shopping cart
on a Payment 2.0 part, Direct Debit is not an option from the Payment Type field on the web page.

To allow the donor to determine the frequency of the recurring gift on the donation form,
select General. Donors can select to make a contribution every week, month, quarter, or year.

To define the recurring gift schedules donors can choose, select Specific.

a. Select “Weekly,” “Monthly,” “Quarterly,” or “Annually” as the frequency.

b. In the On field, select a day or date donors can choose to schedule the gift.

Tip: If a constituent donates a recurring gift and selects a start date that is not today’s date, the
transaction downloads to Blackbaud CRM. However, the transaction is not sent to your bank
merchant when the donor submits the recurring gift. The merchant receives the transaction from
the batch output you send to your bank for processing from Blackbaud CRM. For more
information about bank merchants, see the Administration Guide.

c. To add the frequency to the donation page, click Add frequency.

d. Select Allow donor to enter ending date, if donors can specify when the recurring gift
ends.

Note: To add multiple frequency options to the donation form, enter each custom schedule and click
Add frequency to add the new schedule to the list. The selections you make appear in the
Frequency grid on the Donation Form part.

Design Donation Form: Donor Options
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. Under Donor Options, select the options to make available to donors.

a. To allow a company to donate, select Allow corporate gifts. When you select this checkbox,
This donation is on behalf of a company appears on the donation form.

b. To allow donors to give anonymously, select Allow anonymous gifts. When you select this,
I prefer to make this donation anonymously appears on the donation form.

c. To allow donors to enter comments on the donation form, select Allow comments.
Information from the Comments field on the donation form downloads to a note on the
Documentation tab of the revenue record in Blackbaud CRM.

d. To allow donors to provide matching gift company information, select Allow matching
gifts. When you select this checkbox, My company will match my gift appears on the
donation form. Donors can select the checkbox and enter the company name in the
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Company field. If you use MatchFinder Online, Look it up appears next to the checkbox.
Visitors click the link to access MatchFinder Online and search for the company.

Note: Blackbaud hosts the MatchFinder Online search page separately; it is not a page on your
Blackbaud Internet Solutions website. Therefore, the page does not inherit the styles your site uses by
default. Blackbaud can apply styles from your Web Developers to the search page so it integrates
with your website. To contact Support about this, visit Blackbaud's website.

Note: The program does not support matching gifts for pledges and recurring gifts.

2. To create a tribute section on the donation form, select Allow tribute gifts (one-time gifts
only).

Warning: If you allow for recurring gifts in addition to tribute gifts, on your Web page, and your
online donor selects the Recurring gift option, the Tribute section does not display on the form.
This prevents the donor from trying to set up a tribute with a recurring gift, which is not supported in
Blackbaud CRM Constituent Record Management.

a. To allow the donor to enter the tribute information, select General.
Select the checkbox for each tribute type to include in the tribute section. The tribute types
listed are entries from the Tribute Types table in Blackbaud CRM.

b. To apply all gifts to a specific tribute, select Specific.

To select a tribute, click Tributes. A search screen appears so you can search for the tribute.
When you return to the Design tab, the Tribute field displays the tribute text and tribute
type for the selected tribute. If you select a tribute that does not have a tributee associated
with it, you cannot hide the tribute description.

c. To remove the Description field from the Tribute section on the donation form, select Hide
tribute description field.

If you select Hide tribute description, in the Tribute Introductory Text field on the
Language tab, you can enter the text to appear at the beginning of the Tribute section on
your donation form, such as “This gift is made in honor of someone special.”

d. If you select General so users can enter tributes themselves, you can select Display tribute
name fields as two fields (first/last name) to improve data entry. When you select this
checkbox, the Tribute section of the donation page displays First name and Last name
fields so donors can enter information.

Note: If you do not select Display tribute name fields as two fields (first/last name), the Full name
field appears in the Tribute section of the donation form.

e. Select Display acknowledgee name fields as two fields (first/last name) to create separate
name fields for the acknowledgee. When a donor selects Mail a letter on my behalf on the
donation page, the First name and Last name fields appear so the donor can enter an
acknowledgee.

Note: If you do not select Display acknowledgee name fields as two fields (first/last name), the
Full name field appears on the donation form when a donor selects Mail a letter on my behalf.

Note: When you include tribute information on your donor page, Mail a letter on my behalf
automatically appears on the page. When a donor selects this checkbox, name and address fields
appear for the donor to enter information for use in a tribute letter.
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Design Donation Form: Designations and Giving Levels
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

Tip: For best practice information about donation forms, refer to Best Practices for Donation Forms.

1. Under Designations, click Add designation to choose each designation donors can associate
with gifts. A row appears in the grid.

a. In the Designation field, click the binoculars to select a designation to appear on the
website.

b. Select the Default checkbox for the designation that gifts apply to when donors do not
select designations.

To provide multiple designations for users to select from, click Add designation and repeat
these steps to create another entry. When you do this, the Support multiple designations
checkbox appears.

c. To allow users to donate to multiple designations, select Support multiple designations.
When you select this checkbox, Add to Cart appears on the donation page. Similar to
purchasing items from a store, users select the designations to donate to.

2. Under Impact statement, select a note type to merge in the confirmation screen or
acknowledgement email that informs the donor their gift is relevant to the designation. The
available note types integrate from the Documentation tab for a designation in Blackbaud
CRM.

To merge the note in the confirmation screen or acknowledgement email, select merge fields
in the HTML editor from the Impact Statement node. For more information about the HTML
editor, see the Program Basics Guide.

3. Under Giving levels, to select a giving level for your donors, click Add giving level.
When you include giving levels and select Support multiple designations, each donation
made to a fund is considered for the giving level. For example, if a $500 donation is required
for Gold status, and a donor donates $250 to the 2008 Annual Fund and $250 to the Building
Equipment Fund, the donor does not receive Gold status. If the gift is one $500 donation to
the 2008 Annual Fund, the donor receives the Gold giving level status.

a. In the Display name field, enter the name of the giving level as it will appear on the website.

b. In the Amount field, enter the gift amount for the giving level.

c. To include a blank $ Other field on the Donation page, select Allow other amount.

Design Donation Form: Sources (Appeals), Donor Challenge, and Required Fields
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. Under Sources, to select an appeal for the gift, click Add source. With this information, your
organization can manage how donors learn about donating through the website.
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a. To include an appeal, click the binoculars in the Appeal column. The Appeal Search screen
appears so you can select an appeal.

When you select source information, a How did you hear about our site field appears on
the donation page. In this field, users can select from the appeals you select in this step.

b. In the Display name field, enter the name of the appeal as it will appear on the website. By
default, the text entered in the Appeal Name field on the appeal record defaults in the
Display name field.

c. In the Default column, select the checkbox for the appeal to use when the user does not
select an appeal.

d. To hide an appeal from the How did you hear about our site field, clear the checkbox for
the appeal in the Display column.

When you do this, you can add source information to the end of a system generated URL in
an email that navigates the recipient to your donation page. For example, create a link to
your donation page in an email message. At the end of the system generated URL, add
&source=camp. When the recipient clicks the link, the How did you hear about our site
field does not appear on the page. The appeal stores the source information automatically
based on the system generated URL.

Warning: To track source information this way, you must use a system generated URL. You cannot
use unique URLs or friendly URLs created by a user.

The source information must include the appeal ID from Blackbaud CRM. For example, if the
appeal ID in Blackbaud CRM is Annual2008, add &source=Annual2008 to the end of the
system generated URL. If the appeal ID includes a space, replace the space with a %20. For
example, if the appeal ID is CAMP LETTER add &source=CAMP%20LETTER.

If the Display checkbox is selected for the appeal and a user navigates to the donation page
via a URL without source information, the How did you hear about our site field appears on
the page.

e. To require users to select a source, select Source is a required field. If you select this
checkbox, you must select the Display checkbox for at least one appeal.

To add additional appeals, click Add source. Another row appears in the grid for you to
select another appeal.

f. To include a list of appeals sent to the donor, select Include appeal history for donors.
When you do this, options appear for you to select whether to include the entire list of
appeals sent to the donor or limit the list by selecting a query. To include the entire appeal
history, select All. To limit the appeal history, select Specific. Then, select a query of appeals
to filter the list.

Tip: When you select Include appeal history for donors, the How Did You Hear About Our Site
field on the donation page also includes any other appeals the donor received. For example, you
select to include the Annual Appeal and the Scholarship Campaign Appeal under Sources. A donor
received the Building Fund Appeal. When the donor logs in to your site, all three appeals appear in
the How Did You Hear About Our Site field on the donation page.

2. Under Donor challenge, to encourage donors to make a donation in support of a major
donor or corporate sponsor challenge, select Include donor challenge.
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Note: A donor challenge is a fundraising tool to help increase support for a cause. A major donor or
corporate sponsor pledges a large sum to challenge the organization to raise a specific amount from
other donors. For more information about donor challenges, see the Blackbaud Internet Solutions
Fundraising Guide.

a. In the Enter an introduction for eligible donor challenge messages field, enter text to
inform users about the purpose of an eligible challenge match. For example, you can enter
“Your gift may be eligible for the following donor challenges.”

b. In the HTML Editor box, enter text to inform users an eligible challenge match exists. You can
format the content’s appearance and layout. For more information about the HTML editor,
see the Program Basics Guide.

When you include donor challenges on your website, the introduction appears once on the
web page. The HTML editor content appears each time an eligible donor challenge exists.
Multiple eligible donor challenges can exist in one of two ways.

• Multiple donor challenges exist when the designation has more than one donor challenge
associated with it in Blackbaud CRM.

For example, in Blackbaud CRM, the President’s Challenge and the Dean’s Challenge are
associated with the Annual Fund. When a user selects Annual Fund on the web page, the HTML
editor content appears twice. Merge fields populate for each instance to clarify the eligible
donor matches to the user.

• Multiple donor challenges also exist when the Donation Form part allows for multiple
designations and two or more of the designations have a donor challenge associated with
them.

For example, in Blackbaud CRM, the President’s Challenge is associated with the Annual Fund
and the Dean’s Challenge is associated with the Building Fund. When a user selects to make a
donation to the Annual Fund and Building Fund, the HTML editor content appears twice. Merge
fields populate for each instance to clarify the eligible donor matches to the user.

3. Under Required fields, select the checkbox for each donor field to make required on the
donation form. To ensure you download complete constituent information, we recommend
that you make all of these fields required.

Design Donation Form: Additional, Spouse, and Attribute Information
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. Under Additional information, select Include name formats so users can enter multiple
name recognition preferences on the donation page. For example, users can enter a preferred
name for your annual report and they can enter a preferred name for your alumni mailings.

Note: If you know a name format type exists in Blackbaud CRM but do not see it on this part, check
the Settings tab in Sites & settings to make sure the name format type is available.

a. In the Include column, select the checkbox for each name format type to include on the
page.

b. In the Required column, select the checkbox for each name format type you want to require.
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c. In the Alternate caption column, enter the text to display on the page. For example, you can
enter “Annual report recognition.”

When a user submits a name format, it downloads to the Names tab on the constituent record.

2. Under Spouse information, select Include spouse fields so users can add or edit spouse
information on the donation form. Spouse fields appear in a grid for you to select the
information to appear on the page. To make a spouse field required, select the applicable
checkbox in the Required column.

If a user with existing spouse information in the database logs in to your site, the spouse
information automatically appears on the donation page. If a user is not logged in, the spouse
fields are blank. The user selects I would like to provide information about my
Spouse/Partner to add new spouse information.

3. Under Additional fields, select the additional donor fields to include on the form.

a. In the Include column, select the checkbox for each additional field you want to appear on
the form. If you require a field, you must also include it.

b. In the Required column, select the checkbox for each additional field website users must
complete to submit the form.

Tip: We recommend you include Middle name so your organization meets the Canadian Revenue
Agency's requirements for donation receipts.

4. Under Attributes, select gift attributes to associate with the donation page.

Tip: The gift attributes that appear in this frame are created in Blackbaud CRM. After you process a
donation transaction, the attributes you select appear on the Attributes tab of a revenue record.

5. In the Display column, select the checkbox beside the gift attribute to associate with the part.
To make the attributes required, select the checkbox in the Required column. To change the
text of the attribute on the donation page, enter the text to display in the Caption field.

Note: If you know an attribute exists in Blackbaud CRM but do not see it online, check the Settings
tab in Sites & settings to make sure the attribute is available.

Design Donation Form: Payments and Pledges
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. Under Payment setup, select the payment options for website users.

a. To allow website users to pay for multiple transactions at one time, select Use payment
part. The Payment frame appears. In the Payment page field, select the web page to use to
process donations. The Payment part on the selected page determines the payment
methods and merchant account used to process donations. For information about the
Payment part, see Payment on page 154.

In the box, enter the text to appear on the payment page after a donation is added. To
format the content’s appearance and layout, use the HTML editor. For more information
about the HTML editor, see the Program Basics Guide.
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b. To require website users to pay for donations one at a time, select Proceed directly to
payment. Additional frames appear for you to select merchant account, payment type, and
confirmation screen information.

2. In the Merchant account field, select the merchant account to use to process credit card
transactions received through the donation form, such as your organization’s IATS account. The
system administrator sets up merchant accounts in Administration. For more information, see
the Administration Guide.

3. Select the payment types donors can use to contribute to your organization.

Note: Donation forms that allow pledge payments must include credit card or direct debit as a
payment method. For information about how to accept pledge payments, see Transaction Manager
on page 232.

4. Select options for the donation summary that appears after a user submits a donation.

a. To use the program’s default confirmation screen, select Use default confirmation screen.

b. To customize a confirmation screen, select Use custom confirmation screen. The HTML
editor appears with the default confirmation screen. You can edit it as necessary.

In the box, edit the content for the donation summary. To format the appearance and layout,
use the HTML editor toolbar. To include personalized information, use merge fields. For
more information, see the Program Basics Guide.

Tip: Customizations for the confirmation screen remain even if you select Use default confirmation
screen. To remove your customizations for the screen, select Use custom confirmation screen and
click Restore default content. The program’s default confirmation screen appears in the HTML
editor for you to customize again.

5. To enable users to specify their consent preferences for how they want to receive
communication from your organization:

a. Under Consent part, select a saved Communication Consent part to include on the form.

b. Select how you want the communication preference options to display — choose Inline to
embed the options directly in the form itself or choose Overlay to display a pop-up window
with the consent options when the form is submitted.
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After users submit the form, their consent information is downloaded along with their
transaction. After the appropriate batch is committed, their constituent record is updated on
the Communications > Preferences tab in Blackbaud CRM with their communication
consent preferences.

6. Under Pledge payment, select whether to display information about the next installment on
the pledge payment donation form.

When donors access their giving history information with the Transaction Manager part,
certain pledges with an outstanding balance include a link to the selected Donation Form
page. Donors can use this link to enter a pledge payment. For information about how to link a
page that includes a Donation Form part to the Transaction Manager part so donors can pay
outstanding pledges, see Transaction Manager on page 232.

Note: If your organization accepts electronic fund transfer (EFT) payments and the donor selects to
pay a pledge in installments with a credit card or debit card at the time the pledge is created, the link
to the donation form page does not appear. The link also does not appear if the pledge currently has
a payment pending or if the pledge balance is zero.

Note: If a donor enters an amount greater than the installment amount due, the program
automatically applies the overpayment to the next scheduled installment. If the a donor enters an
amount greater than the total remaining pledge amount due, the program automatically creates a
new gift with the overpayment.

• Select Show next installment due date for pledges to include information about the next
scheduled installment. When you select this checkbox, a donor who selects to pay an
outstanding pledge from the Transaction Manager can view the Current balance, Amount
due, and Due date fields on the donation form. If you clear this checkbox, these fields do not
appear.

• In the Minimum pledge payment amount field, enter the minimum amount a donor can pay
toward an outstanding pledge. Enter “0” or leave this field blank to allow donors to enter any
amount.

Design Donation Form: eCards
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. Under eCard options, to associate an eCard with the donation web page, select Include
eCards. For more information about eCards, see eCards on page 78.

Note: When you edit a Donation Form part, click eCard Email to access the eCard design screen. You
can use the default text provided or enter different text.

2. Click Next. The Acknowledgement Email screen appears.

3. Create an acknowledgement email for website users who use the donation form to donate to
your organization. You can use the default text provided or enter different text.

Note: To include eReceipt information in an acknowledgement, use the eReceipt Number and
eReceipt Download URL merge fields. If you include the eReceipt Number field, a receipt number
is assigned to the donation. This number downloads to Blackbaud CRM. If you include the eReceipt
Download URL field, the eReceipt contains a URL to a saved copy of the eReceipt PDF. For
information about how to design the eReceipt, see Design Donation Form: eReceipts on page 70.
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Tip: To access the Acknowledgement Email screen, click Acknowledgement Email when you edit a
Donation Form part. For information about how to design an acknowledgement, see the Email Guide.

4. To save the email, click Save. You return to the Edit Part screen.

5. Click Save. You return to Parts.

If receipt stack and number information exists for eReceipts on the Settings tab in Sites &
settings, Next appears. To create and design the eReceipt for the part, click Next.

Design Donation Form: eReceipts
After you create and design the eReceipt, a Click here to view your eReceipt link appears at the
bottom of the donation confirmation screen. To view and print a PDF of the eReceipt, donors click
this link.

1. From the Parts screen, select the Donation Form part for which you want to design an
eReceipt.

2. In the Action column, click Click here to edit this part. The Edit Part screen appears
displaying the Design tab.

3. Click eReceipt. The eReceipt design screen appears.

Note: To create eReceipts, you must establish the receipt stack and number information in Sites &
settings. For more information, see the Administration Guide.

4. In the eReceipt Options frame, select whether to create an eReceipt for a Credit card or
Debit card. You can create the eReceipt for both payment methods.

5. To mark the gift as receipted when you download it to Blackbaud CRM, select the Mark gift
as receipted in Blackbaud CRM checkbox.

When you select this checkbox, the receipt number from Blackbaud Internet Solutions defaults
in the Receipt no. field on the gift record in Blackbaud CRM. Also, the URL for a copy of the
eReceipt PDF defaults as a gift attribute.

Warning: The program does not create a receipt number unless you include the eReceipt Number
or eReceipt Download URL merge fields when you include eReceipt information in the
acknowledgement.

6. In the eReceipt Content frame, enter the text to appear on the eReceipt. If you include the
eReceipt Number field, the eReceipt contains the receipt number for the donation. To format
the appearance and layout, use the HTML editor. For information about the HTML editor, see
the Program Basics Guide.

7. To preview the eReceipt, click Preview PDF.

8. To save the eReceipt, click Save. You return to the Edit Part screen.

9. Click Save. You return to Parts.
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Donation Form - Mini (Beta)
The Donation Form - Mini (Beta) part is our beta release of a new Blackbaud Internet Solutions
donation form that provides a new simplified checkout experience for campaign-based donations. The
form has a modern, responsive HTML design that automatically adjusts to the device size, such as a
smart phone or tablet, on which the page is being viewed.

When you create a Donation Form - Mini (Beta) part, you can customize the message displayed on the
donation form, specify suggested giving levels, select a single designation and appeal to associate
with donations made on the form, and customize the confirmation screen and email.

This new part allows donors to make a quick, basic donation by selecting a predefined giving level or,
if configured, to enter their own gift amount. Because the form uses PCI-compliant Blackbaud
Checkout, customers can be assured that credit card and merchant account information is processed
and stored on a Blackbaud-hosted secure server.

Digital wallet options are available on the Donation Form - Mini (Beta) part for BBMS customers only.

• Visa Checkout and Masterpass are automatically available to donors as secure checkout options.
Both support the same currencies as BBMS: USD, CAD, GBP, and EUR.

Note: The Apple Pay Early Adopter Program (EAP) is now closed and we are no longer onboarding
any clients.

See the Blackbaud Checkout FAQs for more information.

Note: The Donation Form - Mini (Beta) part is considered a proof of concept and will transform into a
full donation form in an upcoming Blackbaud Internet Solutions release.

You download and manage transactions from the Donation Form - Mini (Beta) part in Blackbaud CRM
the same way you download and manage transactions from the standard Donation Form. For
information about how to process donation transactions in Blackbaud CRM, see the Web Transactions
Guide.

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

Tip: For best practice information about donation forms, refer to Best Practices for Donation Forms.

Design Donation Form - Mini (Beta)

Note: If you are using multicurrency and browser/regional settings, prices are displayed on the
donation form in both the base currency for the database and the regional currency based on the
browser settings.

1. Under Donation form message, enter a custom message to display on the donation form.
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The HTML editor shows the default message that displays on the donation form. You can use
the default message or customize the content according to your needs.

2. In the Designation section, select the designation that you want associated with donations
made using this form. This field is required.

Click the binoculars, search for the funds from Blackbaud CRM, then select the one you want to
use.

To add a giving level, click Add giving level, then enter the gift Amount (required) for the
giving level. You can also specify a Display name (optional) to show on the form for any of
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the giving levels. To have a specific giving level preselected on the donation form, select the
corresponding Default option.

To remove a giving level, click Remove next to the one you want to remove.

To include a blank $ Other field on the donation form, select Allow other amount to allow
donors to contribute any gift amount. On the form, donors can enter the gift amount in the
Other field. In Minimum gift amount, enter the minimum amount that donors must give. To
specify no minimum amount, either leave the field blank or enter 0.

3. Under Appeals, select an appeal that you want to associate with all donations made using this
form. This field is optional.

Click Add Appeal, then click the binoculars. You can search for appeals from Blackbaud CRM,
then select the one you want to use.

To remove the appeal, click Remove.

Note: The designation and appeal can be overridden by the URL used to access the donation
form. You format this URL as https://www.yourdomain.org/donate-now?aid=Appeal system record
ID&did=Designation system record ID.

Note: You can find the appeal and designation system record IDs to include in the URL by creating
an ad-hoc query in Blackbaud CRM. In Analysis > Information Library, click Add an ad-hoc query
on the Queries tab. In the Select a Source View window, select Appeal in Record type and in
Source view, then click OK. In Select filter and output fields, select Appeal record and any other
query criteria, and add to Results fields to display. Click the Preview results tab. For the desired
appeal, copy the corresponding system record ID. This is what you'll use in the URL for the Appeal
system record ID. To locate the Designation system record ID, create another ad-hoc query and
follow the steps above, substituting Designation for Appeal.

You can customize the text that displays on the donation form for this option using the
Language tab.

4. Under Payment Setup, select the merchant account, such as your organization’s Blackbaud
Merchant Services (BBMS) account, to use to process credit card transactions received through
the donation form.

Note: All merchant accounts support the Donation Form Mini - (Beta) part except for iATS and IP
Payments. iATS and IP Payments will display as disabled in the Merchant account list.

Note: To take advantage of digital wallets like Apple Pay, Visa Checkout, and Masterpass, you must
use BBMS. If your merchant account isn't BBMS, the system administrator can set it up in
Administration. For more information, see the Administration Guide.
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5. Under Confirmation Screen, you can customize the message that displays to donors after
their donation payment is made.

The HTML editor shows default content you can use for the confirmation screen message. If
desired, you can customize it according to your needs. To format the content’s appearance
and layout, use the HTML editor toolbar. To include personalized information, use merge
fields. Note that Amount, Designation, and Appeal are the only merge fields that can be
displayed on the confirmation screen.

To remove your customizations for the screen, click Restore default content. The program’s
default confirmation screen appears in the HTML editor.

6. Optionally, under Additional payment fields, select Include to have a reCAPTCHA checkbox
display on your Blackbaud Secure Payments form below the credit card payment fields. Users
must select the reCAPTCHA checkbox before they can submit the form.
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7. Click Next. You can design the email acknowledgment that's sent when a donor completes
the payment transaction. You can select the fields to appear and format content appearance
and layout.

For information about how to design an email to acknowledge a payment, see the Email
Guide.

8. Click Save.

Blackbaud Checkout FAQs

Visa Checkout

What is Visa Checkout?
Visa Checkout is a secure checkout option for donors accessing your website on any device. This
secure payment option allows donors to skip filling out lengthy forms usually associated with online
credit card transactions. For more information about Visa Checkout, visit https://usa.visa.com/pay-with-
visa/visa-checkout.html.

What do I need to do to enable Visa Checkout?
Nothing! Visa Checkout is automatically an available option for all BBMS customers. And, there’s no
onboarding process required. Once you enable Blackbaud Checkout in Blackbaud Internet Solutions,
any donor making donations through that donation experience will have the Visa Checkout option
available to them.

If you do not see the digital wallet options, you may not be using valid Blackbaud Payment Service
(BBPS) credentials in the BBMS Web Portal.

To confirm:

l Log in to the Web Portal at https://bbms.blackbaud.com.
l Navigate to the Virtual Terminal using the top menu.
l Select one of the two options, either Card Present or Card Not Present.

If you receive an error message, you need to update your credentials before the digital wallets will
appear on the checkout screen.

What does it cost our organization to offer Visa Checkout?
There is no extra charge to use Visa Checkout. All transactions are processed via Blackbaud Merchant
Services (BBMS) and are subject to the BBMS OneRATE.

Will all donors see the Visa Checkout option?
Any donor accessing the donation form you create that uses Blackbaud Checkout will see the Visa
Checkout payment option.
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Do my donors need Visa to use Visa Checkout?
Visa Checkout works with Visa, MasterCard, American Express, or Discover credit or debit cards. Donors
can simply tap or click the Visa Checkout logo to enroll or make the purchase or donation.

Does Visa Checkout work on any device?
Visa Checkout works on just about any device that can access the web, so your donor will see it on a
smartphone, tablet, or computer.

Masterpass

What is Masterpass by Mastercard?
Masterpass is a secure checkout option for donors accessing your website on any device. This secure
payment option allows donors to skip filling out lengthy forms usually associated with online credit
card transactions. For more information about Masterpass, visit https://masterpass.com/en-us/.

What do I need to do to enable Masterpass?
Nothing! Masterpass is automatically an available option for all BBMS customers. And, there’s no
onboarding process required. Once you enable Blackbaud Checkout in Blackbaud Internet Solutions,
any donor making donations through that donation experience will have the Masterpass option
available to them.

If you do not see the digital wallet options, you may not be using valid Blackbaud Payment Service
(BBPS) credentials in the BBMS Web Portal.

To confirm:

l Log in to the Web Portal at https://bbms.blackbaud.com.
l Navigate to the Virtual Terminal using the top menu.
l Select one of the two options, either Card Present or Card Not Present.

If you receive an error message, you need to update your credentials before the digital wallets will
appear on the checkout screen.

What does it cost our organization to offer Masterpass?
There is no extra charge to use Masterpass. All transactions are processed via Blackbaud Merchant
Services (BBMS) and are subject to the BBMS OneRATE.

Will all donors see the Masterpass option?
Any donor accessing the donation form you create that uses Blackbaud Checkout will see the
Masterpass payment option.
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Do my donors need Mastercard to use Masterpass?
Any major credit or debit card can be added to the Masterpass account.

Does Masterpass work on any device?
Masterpass works on just about any device that can access the web, so your donor will see it on a
smartphone, tablet, or computer.

Apple Pay

What is Apple Pay?
Apple Pay is a secure checkout option for donors who access your website on a device that supports
Apple Pay.

Donors can use Touch ID or double-click an Apple Watch to provide their payment, shipping, and
contact information to securely check out with just one touch.

Offering this option provides your donors the simplicity of Apple Pay, while enabling your mission to
leverage increased user adoption and conversion rates.

How do I set up Apple Pay as a payment option?
The Apple Pay Early Adopter Program (EAP) is now closed and we are no longer onboarding any
clients.

What are Apple's Terms and Conditions for our donation pages?
To offer Apple Pay as a checkout option, you must adhere to at least the minimum required Terms and
Conditions by Apple.

If you implement the recommended method, you cover the minimum requirement as well.

Minimum requirement implementation
On a one-time donation form, display the Apple Pay payment mark next to other payment options.

The Apple Pay payment mark should be a link that directs the donor to the page that supports the
Apple Pay donation experience.
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Recommended implementation
On the homepage, include the detection code recommended by Apple to determine if the donor is
on a device that supports Apple Pay. If the donor is on an Apple device and has set up Apple Pay, when
they click the Donate button on the form, they'll be redirected to the page that supports the Apple Pay
donation experience.

Contact Blackbaud for assistance, if needed.

What does it cost our organization to offer Apple Pay?
There is no extra charge to use Apple Pay. All transactions are processed via Blackbaud Merchant
Services (BBMS) and are subject to the BBMS OneRATE.

Will all donors see the Apple Pay option?
No, only donors using an Apple Pay-enabled environment will see the option.

Donors who access your page from another environment can make a payment using a credit or debit
card.

eCards
With the eCards part, your organization can enable website users to browse, personalize, and send
eCards to others from your website. An eCard is an electronic greeting card that contains content from
a selected template. Your users can send an eCard as an email message or as a printed copy in the mail.
eCards can promote your organization and drive new visitors to your website to help build your online
community. You can offer eCards as a free service for your website users or as an incentive to donate
to your organization.

On your website, the eCards part includes multiple screens to step the user through the process to
select, personalize, and send an eCard.

• Choose – On this screen, the website user selects the template to use to create an eCard. When you
design the eCards part, you select the available eCard templates and how they appear on your
website. Before you can add a template to the eCards part, the template must be available in eCard
Templates. For information about eCard Templates, see the Email Guide.

• Confirm – After the website user selects an eCard template, this screen displays a preview of the
selected template to verify it is the one to use to create an eCard. The website user can select to
continue to create the eCard or return to the previous screen to select another template.

Note: When you design the eCard template, you can use merge fields to create additional content to
appear when the preview of the template appears. For example, you can display a watermark you
create over the preview of the eCard to prevent users who attempt to copy and send the free preview
of the eCard to avoid a donation.
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• Personalize – On this screen, the website user enters the recipients and email addresses to receive
the eCard. The user can also enter a personal message for the recipients, select whether to send or
print the eCard, and request to receive copies of the eCard email messages the program sends to
each recipient.

• Preview – On this screen, the website user can view a preview of the personalized eCard before
the program sends it. The website user can continue to send the eCard or return to the previous
screen to adjust its personalization. From this screen, the user can print or generate a portable
document format (*.pdf) file of the eCard preview. If the user logged in to your website and you
do not require a donation to send an eCard, the website user also sends the eCard from this screen.

• Send – If the user is anonymous or did not log in to your website, this screen appears. To help
prevent automated abuse of your website, the Send screen provides a completely automated
public turing test to tell computers and humans apart (CAPTCHA).

Note: The eCards part requires a completely automated public turing test to tell computers and
humans apart (CAPTCHA). Visit http://recaptcha.net/ to obtain free CAPTCHA functionality with
reCAPTCHA. When you sign up for reCAPTCHA, you receive public and private keys, which your system
administrator must enter on the Settings tab in Sites & settings. Without CAPTCHA functionality, you
leave your website vulnerable to automated abuse. For more information, see the Administration
Guide.

• Donation – If you require a donation to send an eCard, this screen appears. On this screen, the
website user enters information about the donation. After the website user completes the
donation, the confirmation screen you select when you design the eCards part appears.

• Finish – If you do not require a donation to send an eCard, this screen appears to thank the user
and confirm the program sent the eCard. From this screen, the user can select to print or generate
a *.pdf file of the sent eCard. The user can also select to create another eCard.

Tip: To create reports about the eCards your users send through your website, design a Report
(Email) part. For information about the Report (Email) part, see Email Reports on page 84.

Design eCards
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

Note: eCards do not apply to the BlockScheduledEmails setting in both web.config files for
Blackbaud Internet Solutions and Blackbaud CRM. Therefore, if you have this setting set to True to
prevent email from sending from a test environment, recipients will continue to receive them.

1. From the Design tab, under Available eCards, browse the eCard template categories in eCard
Templates and select the templates to make available to website users. The templates you
select here appear on the Choose screen of the eCards part on your website.
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Note: eCard Templates provides the eCard templates that appear under Available eCards. To add a
template to an eCards part, the template must be in eCards Templates. For information about how to
create an eCard template in eCard Templates, see the Email Guide.

2. Under Display options, enter how the selected templates appear on the Choose screen of the
eCards part on your website.
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a. Select how the selected eCard templates appear on the part’s Choose screen on your
website.

To display all the eCard templates together, select Display the templates in a single listing.

To display the eCard templates by category, select Display the templates in separate
listings by category. When you select this option, your website users can browse for a
template by its category.

b. Select whether the personal message field on the part’s Personalize screen on your website
generates plain text or rich text.

Note: All email clients can easily read the plain text format, but it does not allow users to adjust the
text’s color, font, or format. With rich text, users can adjust the text’s format and embed pictures and
links, but not all email clients can easily read the rich text format. Email clients that do not support the
rich text format convert the text to the plain text format.
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c. In the Maximum height and Maximum width fields, enter the maximum size, in pixels, of
the thumbnail preview image of each template.

3. Under Sender and recipient options, you determine the maximum number of eCard
recipients and whether to provide first and last name fields for senders and recipients.

a. In the Maximum recipients field, enter the maximum number of recipients for an eCard. You
can allow website users to send eCards to a maximum of 100 recipients.

b. To provide one name field for the sender and one name field for recipients, select Display
all as single fields. To provide First name and Last name fields for both the sender and
recipient, select Display all as separate first and last name fields.

c. To require website users to enter first names for eCard recipients so merge fields are not
blank, select Require eCard recipient's name.

4. To require website users to make a donation to send an eCard, select Require a donation.
The options for the Donation Form part appear. For information about these options, see
Donation Form on page 60.

5. Under Donation options, select Require a donation to associate gift attributes with eCards
for the part, under eCard Attributes, select attributes in the Send date, Recipient first name,
and Recipient last name fields. Each field creates its own attribute in Blackbaud CRM. Website
users do not view these attributes on the donation page.

Warning: If your eCard allows for multiple recipients and you select an attribute for the Recipient
first name and Recipient last name fields, only the first recipient name information in the recipient
list downloads to Blackbaud CRM. If the user enters one word for a recipient name, it downloads as
the recipient first name attribute.

6. When website users send an eCard, the recipient receives an email message with the
personalized content from the selected template or a link to a web page that contains the
content. To create the email message for the eCards this part generates, click eCard Email. The
eCard Email screen appears.

For information about how to create an eCard email message, see the Email Guide.

7. To customize the messages and labels that appear for the eCards part on your website, select
the Language tab. For information about the Language tab, see Language Tab on page 17.

8. Click Save. You return to Parts.

Email Forwarding Form
With the Email Forwarding Form part, website users can establish an email address that never changes.
With this part, users can sign up and create a lifelong email address that is forwarded to an address
they select. If their address changes, they can change the forwarding address and other users never
know and do not need to keep up with changes. To configure your organization’s email forwarding
email domain, review the Technical Requirements document provided by Blackbaud Professional
Services.
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Design Email Forwarding Form
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Title field, enter a name to identify the Email Forwarding form.

2. In the Help message field, enter the tooltip message to display when users move their mouse
cursors over the enable email forwarding option.

3. In the Enable caption field, enter the text to appear on the website for the checkbox users can
select to enable email forwarding. By default, “Yes, I want email forwarding.” appears.

4. To allow users to create their own forwardable email addresses, select Allow users to edit
address. When a user edits an email forwarding address, the program creates a Profile Update
transaction for the user.
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5. In the After update navigate to field, browse to the page you want to appear for website
users after they update their email forwarding. If you do not select a page, the home page
from the Settings tab in Sites & settings appears by default.

6. Click Save. You return to Parts.

Email Reports
Using the Report (Email) part, you can create reports about email sent through the website.

Email Revenue Summary — The Email Revenue Summary displays the amount of donations collected
through a link in the email to a donation page. Website users can filter the report results by date range,
message type, and revenue type.

Email Activity Report — The Email Activity Report displays details for each email sent including the
email title, type, sender’s name, and date sent. Other details include the number of opened and
bounced emails, and the number of page visits generated by each email. The report also contains a bar
graph that shows the total number of opened, bounced emails, and page visits for all emails included
in the report. Website users can filter the report results by email type, date range, and action.

Note: After you add the part to a page and send emails through the website, the report automatically
generates results when you access the page.

This table explains the items included in the Email Activity Report.

Type Type of message sent — Email, Acknowledgement, Newsletter, Chapter,
Personal Page, Campaign Appeals, and Scheduled

Sent Number of emails sent

Opened Number of emails sent that were tracked as opened

Bounced Number of emails sent that were not delivered successfully

Page Visits Number of web page visits generated by a link in the email

Design Email Reports
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Report Type field, select the type of report to create. Select Email
Revenue Summary or Email Activity Report.
To view a pop-up preview of the report, click on the report type.

2. In the Report Title field, select the title to use for the report.
• To use the report’s name for the title, select Default.
• To enter a custom report title, select Other and enter the title in the field.

3. To display the report title above the report, select Show Report Title.

4. To save the report, click Save and Close. You return to the Report (Email) design screen.
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5. Click Save. You return to Parts.

Event Calendar
You can use the Event Calendar part to add a calendar to your website. Event Calendar parts can:

• Act as standalone calendars. For example, the academic departments at your school manage their
own calendars on your website. Each department can create and maintain a separate Event Calendar
part for its calendar.

• Work as sub-calendars that feed events to a larger organizational calendar. For example, your
website has a main calendar that lists events for all areas of the school. With the Event Calendar
Group part, each departmental calendar can feed events from their Event Calendar parts into the
main calendar for the school. For more information about Event Calendar Groups, see Event
Calendar Group on page 90.

When you include events from Blackbaud CRM on your website event calendar, you can also publish
registration links to the website calendar directly from the corresponding Event Registration Form
parts. For more information about how to publish event registration links, refer to Design Event
Registration Form on page 98.

You can use Event Calendar part properties to manage who views and manages each calendar. For
example, a school may have a sub-calendar of faculty events that only users assigned to Administrator
or Faculty roles can view or edit. You can also use Event Categories to manage the types of events
added to the calendar and who manages them. For example, a soccer calendar may have categories
such as Registration, Practice, and Games, and only users in the Coaches role have rights to add, edit, or
delete events in these categories.

Calendar managers can create recurring events. When you edit recurring events, the manager can select
whether to change all occurrences in the series, only the selected occurrence, or all future occurrences
in the series including the selected occurrence. When you change an occurrence of an event, you
cannot later make that occurrence part of a recurring series.

Calendar managers can select a time zone for the event. If an event does not have a time zone, the
logged-in user’s time zone setting determines the date and time displayed for the event. For
anonymous users or any user who does not have a time zone specified, the event displays the time and
date based on the system’s setting. If your website users are all in the same time zone, we recommend
managers leave the time zone field blank. If your website users are in multiple time zones, we
recommend you set the time zone to the user’s setting.

When you enter an address for the event, you can select to include a Google or Yahoo! map link to the
location. On the Events screen, you can click Preview map under Event Information to verify that the
location you entered is correct. Calendar managers can also use the HTML editor to add pictures and
hyperlinks to the event listing and to format text.

To cancel an event, a manager can select Mark Canceled. In the List View and Calendar Highlights, the
event title is appended with “- Canceled.” In the Calendar View, the event name is struck through. For
the calendar weblog, “Update” or “Removed” is added to the title, and readers who subscribe to the
calendar weblog receive an updated calendar event posting through their RSS feed.

Website users have four views of the calendar: the Calendar View, the List View, Published Events, and
Event Details View.
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• The Calendar View displays a large monthly calendar. Dates with scheduled events are colored and
list the events that occur that day. Users can click Filter Events to customize the categories of
events that appear. Event names are hyperlinked so users can click them to read more information
about the event. In this view, icons indicate whether an event is recurring, occurs in a time zone, or
lasts longer than one day.

• The List View displays a list of all the events scheduled for the selected period of time. Event
names are hyperlinked so users can click them to read more information about the event. Users can
filter events by date or click Filter Events to select the types of events to view.

• If you enable the RSS (Really Simple Syndication) Event Publishing capabilities, calendar managers
can post “stories” in a weblog form with details about upcoming events. Site users click Published
Events to view the calendar weblog. Posted events also appear in site search results. Website users
can subscribe to the RSS feed so they receive updates in their RSS reader about upcoming events.

• The Event Details View is the page that appears when a website user clicks on an event in the
Calendar View or List View. It displays the details for the selected event.

In the Calendar View, List View, and the Event Details View, users can click Print View to open a
window displaying the printer-friendly version of the calendar or event.

Also in the Calendar View, List View, and the Event Details View, users can click Export as iCalendar to
export events in the iCalendar format (*.ics) so they can be opened in other calendar programs, such as
Microsoft Outlook or Apple iCal. The export file includes only the events appearing currently in the
calendar; if the calendar is filtered, filtered out events are not exported. If an event is time zone
specific but not recurring, the event time is converted to UTC time in the export file. If an event is time
zone specific and recurring, the export file includes the event time zone as well as the daylight savings
rules for that time zone. The export file includes any *.html event descriptions but does not include
event graphics. In the Event Details View, additional buttons appear so users can add the single event
to their Windows Live, Google, or Yahoo! calendars.

Note: When using a version of Microsoft Outlook older than version 7, users should save the exported
*.ics file to their local machine and use the Import an iCalendar file function in Outlook. If users with
an older version attempt to import by double-clicking the saved *.ics file, it imports only the first
event and discards any others. Users with Outlook 7 can double-click the saved *.ics file to import all
events with no issues.

In the Calendar View and List View, users can click Import Events to add multiple events to the
calendar at one time. On the Select import file screen, in the File field, users browse to a *.csv file that
contains header columns and the values to import. Only the Start Date, End Date, and Title fields are
required, but the import file can include values for all fields that appear on the Add Event screen,
except Recurrence.
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After selecting the import file, the user must map the import fields to those in the program. However,
if the *.csv file’s column headers use the same names as the corresponding fields in Blackbaud Internet
Solutions, the program automatically maps the import file fields to the event fields.

Note: You can import data for all event calendar fields, except Recurrence. After you import the *.csv
file, you can manually set an event’s recurrence.

Use the table below to set up *.csv files with values the program can automatically map to the
corresponding event fields in Blackbaud Internet Solutions.

Field Name Field Values

Event Category Enter a category for the event. Your entry must match a category you
previously created on the Code Tables page in Administration.

All Day Event Enter “Yes” or “No,” “True” or “False” to indicate whether the event
will last the entire day.

Time Zone Enter the geographical location associated with the time zone where
the event occurs, such as “Chicago” or “Los Angeles,” so the start and
end times accurately reflect the scheduled time of the event for a
viewer in a different time zone.
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Field Name Field Values

Start Date Enter the start date in any standard date format. For example, you
can enter January 1, 2011 as “01/01/11” or “1/1/2011.” This field is
always required.

Start Time Hour Enter a whole number for the hour. If you entered “No” or “False” in
the All Day Event column, this field is required.

Start Time Minute Enter “0,” “15,” “30,” or “45.” When you manually create an event in
Blackbaud Internet Solutions, you must enter this time in fifteen-
minute increments. If you entered “No” or “False” in the All Day
Event column, this field is required.

Start Time AM/PM Enter “AM” or “PM.” If you entered “No” or “False” in the All Day
Event column, this field is required.

End Date Enter the end date in any standard date format. This field is always
required.

End Time Hour Enter a whole number for the hour. If you entered “No” or “False” in
the All Day Event column, this field is required.

End Time Minute Enter “0,” “15,” “30,” or “45.” When you manually create an event in
Blackbaud Internet Solutions, you must enter this time in fifteen-
minute increments. If you entered “No” or “False” in the All Day
Event column, this field is required.

End Time AM/PM Enter “AM” or “PM.” If you entered “No” or “False” in the All Day
Event column, this field is required.

Title Enter the name of the event. This field is always required.

Subtitle If the event has a subtitle, enter this information.

Location Enter the address for the event. If you plan to include a Google or
Yahoo!map link, enter the street address, state, and zip code so the
program includes accurate directions to the event’s location.

Map Link If you entered a location for the event, you can enter “Google” or
“Yahoo” as the web mapping service. After you import the event, a
Map link appears next to the location in the event’s details.

Details Enter information about the event.

Fees Enter the fees associated with the event as a number ($10.00) or as
text (ten dollars).

Contact Info Enter a contact name or email address.

More Info URL Enter the URL that includes additional information about the event.
This entry appears as a More info link when you open the event from
the calendar.
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Design Event Calendar
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, refer
to Create and Edit Parts on page 10.

1. From the Design tab, under General options, enter a name for the calendar in the Calendar
title field.

2. Under Default display, select the default view of the calendar. You can select Calendar view
or List view. Website users can always select a different view when they open the calendar.

3. Under Uncategorized events management rights, select the roles with rights to manage any
events not associated with a category.

4. Under Event Categories, select the event categories to associate with the calendar. After you
add a category, click Assign rights to the category. The Event Category Security screen
appears so you can assign rights to users and roles for the event category. For example, a
Soccer calendar may have the Registration, Practice, and Games categories, and only users in
the Coaches role can add, edit, or delete events in these categories. Also, when the coach adds
a new event, they can assign its category from those you select for the calendar. For example,
the coach specifies whether the new event is Registration, Practice, or Games. You can use
these categories to filter the types of events that appear in calendar groups and calendar
highlights. For example, you can set a calendar highlights part to display only events included
in the Game category. For information about how to add event categories, refer to the
Administration Guide.

5. To include a weblog for the Event Calendar part, select Enable RSS. Additional fields for the
weblog appear.

a. In the Date format field under Appearance, select a date format for the weblog.

b. Under RSS publishing properties, in the Title field, enter a title for the weblog.

c. In the Link URL field, enter a website address news readers can use to link to the calendar
weblog. Also, if your website has a News Reader part, add this link to your news reader so it
displays new events when they are posted. For more information about the News Reader
part, refer to News Reader on page 137.

d. In the Description field, enter a description for news readers about the types of events
posted on the calendar. For example, if your organization supports the environment, enter
“Upcoming Local and National Events Supporting the Environment.”

e. In the Copyright field, enter a copyright notice for the weblog, if you have one.

f. In the Editor’s email field, enter the email address for the person responsible for the content
of calendar postings.

g. To approve weblog posts before they appear on your site, select Moderated.

6. To add a picture to the calendar weblog, click Select Image under Image properties. The
Select Image from Image Library screen appears. For information about how to insert an
image, refer to the Program Basics Guide.

7. In the Link URL field, enter the web address to open when a user clicks the image. The link can
access another page on your site or an outside website.

8. Under Security rights, define the roles with post and manage rights for the published events.
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a. In the Post column, select the checkbox to assign post rights for users and roles allowed to
post to the weblog. This does not include rights to edit or delete postings.

Note: If the list is marked Moderated, posts are pending until a user with Manage rights approves
them. A user with Post rights views his or her pending posts, but not those of other Post users. Only
users with Manage rights view all pending posts.

b. In the Manage column, select the checkbox to assign manage rights for users and roles
allowed to add, edit, and delete weblog postings. If the list is marked Moderated, this
grants rights to approve postings.

c. To include additional users and roles, select Add users and roles.
9. Click Save. You return to Parts.

Event Calendar Group
You can use the Event Calendar Group part to create a top-level calendar that receives events from
smaller sub-calendars. For example, the academic departments, athletic department, and alumni
association at your school each maintain a calendar on your website. Your website also has a main
calendar that includes events for all areas of the school. In this scenario, the departments and alumni
association create their own calendars with the Event Calendar part. You can then create an Event
Calendar group for the main school calendar and assign the department and alumni calendars as sub-
calendars of that group. For more information about the Event Calendar part, see Event Calendar on
page 85.

Design Event Calendar Group
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in Calendar group title field, enter a name for the calendar group.

2. Under Pick source calendars, select the calendars to include in this group. You can choose
from any calendars created with the Event Calendar part.

a. In the Display column, select each calendar to include in the calendar group.

b. In the Color column, select a color for events included in the selected calendar. When a user
views the calendar group in the List View or the Calendar View, hyperlinks to events included
in the selected calendar appear in the selected color. For example, if you select red for the
soccer calendar, all hyperlinks to soccer events are red.

c. In the Icon column, select an icon for events included in the selected calendar. The program
resizes the selected image to 16x16 pixels automatically. Icons appear next to the hyperlinks
to events included in the selected calendar. For example, if you select a soccer ball for the
soccer calendar, a soccer ball icon appears next to all hyperlinks to soccer events in the
calendar group.

3. Under Pick category filters, select the categories of events to use in the calendar group. For
example, if this is a school’s main athletics calendar, you could include only the Game
category. This would filter out any events included in other categories from the selected
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calendars, such as practices or scrimmages. You create Event Calendar categories on the Code
Tables page in Administration.

4. Click Save. You return to Parts.

Event Calendar Highlights
You can use the Event Calendar Highlights part to display short descriptions of upcoming or prior
events on any web page. The part displays event names, dates, and times, and it may also include links
to the event calendars where users can view more details about the events. You can select the
calendars that feed into the highlights and when to include the events.

Design Event Calendar Highlights
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Pick source calendars, select the calendars to include in the
calendar highlights. You can choose from any calendars created with Event Calendar parts.

a. In the Display column, select each calendar to include in the calendar highlights.

b. In the Color column, select a color for events included in the selected calendar. When a
website user views the highlights, the titles of events from the selected calendar appear in
the selected color. For example, if you select red for the soccer calendar, the titles of all
soccer events are red.

c. In the Icon column, select an icon for events included in the selected calendar. The program
resizes the selected image to 16x16 pixels automatically. Icons appear next to the event
titles. For example, if you select a soccer ball for the soccer calendar, a soccer ball icon
appears next the titles of soccer events in the calendar highlights.

2. Under Pick category filters, select the categories of events to use in the calendar highlights.
For example, if this is the school’s main athletics calendar, you could include only the Game
category. This would filter out any events included in other categories from the selected
calendars, such as practices or scrimmages. You create Event Calendar categories on the Code
Tables page in Administration.

3. To include a section that displays highlights of upcoming events, under Additional options,
select Show upcoming events.

a. In the Upcoming events title field, enter a title for the upcoming events section.

b. In the Show next field, select the period of time to include events in the display, such as
events that occur within the next 5 days or next month.

4. To include a section that displays highlights of previous events, select Show recent events.
a. In the Recent events title field, enter a title for the recent events section.

b. In the Show last field, select the period of time to include events in the display, such as
events that occurred within the previous 5 days or previous month.
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5. To include the Print View button on the highlights display, select Show print view button.
When website users click Print View, a window appears displaying a printer-friendly version
of the event highlights.

6. In the URL for more information field, enter a URL to another page on the website or to a
separate site that contains more information about events. If you add a URL, More
Information appears on your website.

7. Click Save. You return to Parts.

Event Registration Form
Use the Event Registration Form part to allow website users to register for events online. When you
create an Event Registration Form part, you can select to include one or more event records from
Blackbaud CRM on the part. After users submit event transactions online, you can download
registration information directly to the event record.

Note: This Event Registration Form part includes improvements such as support for complex, multi-
day events, a streamlined workflow, and responsive design. Consider using Event Registration Form
(Classic) when your event requires a shopping cart (Payment 2.0 part integration).

To support the redesigned Event Registration Form part, batch processing now better accommodates
multiple event registration results. When you review the downloaded event registration batch details
in Blackbaud CRM, the information for registrants and events is organized more efficiently.

All registered attendees — host, guests, and unnamed guests — display on the Registrants tab. The
Registrations tab shows details for all events that have been registered for. The Payment tab shows
all payment information that was entered on the payment page during registration. The donation
amount and designation are shown on the Additional donation tab if an additional donation was
made during the checkout process.

When you select an attendee on the Registrants tab and then select View details, all corresponding
event information is displayed. The Events tab lists all the events that the attendee was registered for,
the Options tab shows the preferences selected for each event for the attendee, and the Biographical
and Address tabs show the registrant's personal information.

Warning: To avoid security issues, do not use an iFrame from a third party website to direct users to
this part on a web page. We recommend you design the page to include the same look and feel as
your third party site so that users seamlessly transition to the page.

Event Registration Steps on Your Website
When you place the Event Registration Form part on a web page, registration options appear on five
separate pages. Users can return to the previous or next page by clicking the button in the status bar.
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Attendees — The first page of the event registration process enables website users to enter details for
all registrants — including themselves, multiple guests, and unnamed guests — who will be attending
any of the events. Fields that are included on this page, and whether or not they are required, are
configured when the part is designed.

Select events — On the second page, a list of all events that are available to register for is displayed,
including event details from Blackbaud CRM, such as the descriptions, start dates, and times for events.
When selecting an event to attend, website users can select attendees from a drop-down list
populated with all attendees that were added on the Attendees page. As attendees are registered for
events, the page is automatically updated with event attendee information and subtotal amounts.
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Select options — On the third page of the event registration process, website users can choose
options (where applicable) — such as preferences and restrictions — for each registrant for each event.
Note that event options cannot be selected for unnamed guests. This page doesn't display on the form
if no options are available for the selected events.
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Review — The fourth page of the event registration process displays detailed information for the
selected events, such as who is registered for each event and what their preferences are. Modifications
can be made to any event registration by selecting the event's link. When designing the form, you can
configure whether this page displays to the website user.
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Checkout — On the last page of the event registration process, the Billing Information page displays.
Website users can make additional donations (if configured), and specify who is paying for the events
and the payment method.
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If the Bill me later option is selected, users enter their contact information and select Submit to
complete the registration process. For other payment options, users select Continue after entering
their contact information to make a payment using Blackbaud Checkout. The program renders the
secure payment page on the Blackbaud server to process transactions for event registration payments.
When website users select multiple events with multiple charges, the total cost automatically defaults
on the secure payment page. For information about the secure payment page, refer to Secure Payment
Page on page 165.

Design Event Registration Form
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, refer
to Create and Edit Parts on page 10.

Show Me: Watch how to create an event registration form for complex events.

Note: If you are using multicurrency and browser/regional settings, prices are displayed on the
form in both the base currency for the database and the regional currency based on the browser
settings.

1. To select an event to use for the part, click Add an event under Add events. The Event Search
screen appears for you to select an event. After you select one, the Edit configuration screen
appears.
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a. In the Name and Description fields, enter the event name and event description to appear
on the web page. This information defaults from Blackbaud CRM event record, but you can
change it for the web page.

b. To use the capacity from Blackbaud CRM as the maximum number of registrations the form
can accept, select Use event capacity. Under Sold out message, enter the text to appear
after all the registrations are reserved. If you do not configure a message, the program uses a
default.

Note: The sold out message appears when the number of processed and unprocessed
registrations in Blackbaud CRM and the number of in-progress registrations online are greater than
the event capacity on the Blackbaud CRM event record.

The program reserves in-progress registrations after users complete the Select Events page
of the form. For each additional step, the program indicates the length of time users have to
submit their information before it releases the reservations to other users. The program also
releases registrations when users return to the Select Events page.

c. Under Event price options, the event's types, names, and prices default from Blackbaud CRM
event record. In the Include column, select the types to make available on the web page. In
the Name column, enter the type name to appear on the page. In the No. registrants
column, enter the number of registrants for the type. For example, enter "2" for a Couple
type.

To limit the availability of an event type, click the arrow beside the type and select Limit
date availability. Specify the dates and times for it to appear on the web page. For example,
create an event type with a discount price for individuals who register early and indicate the
date to remove it from the web page. To inform website users of the dates the event type is
available, enter them in the event's Description field under Event display options.
For information about the event record, refer to the Blackbaud CRM Events Guide.

d. Under Registrant options, the price types for the event appear. For each event type you
include, select the arrow beside it to include fields, event preferences, and participant
attributes for the type.

Note: Types in these grids appear as the original default regardless of your selections in the Event
price options grid. For example, when you remove a type or reorder the list in the Event price
options grid, it does not affect the types in this grid. If you do not include a type in the Event
price options grid, disregard it in this grid.
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e. To allow users who pay to register additional registrants as anonymous, select Allow
anonymous. When you select this, a Register as an unnamed guest checkbox appears on
the Attendees page for each additional registrant. When users do not know who is attending
the event, they select the checkbox and the biographical fields are removed so the
registration page does not require the information.

f. To save your event options and return to the Design tab, click Save.

You can use this part to add all the events you want to include on the Event Registration Form.
All events shown under Add events will display on the Select events page in chronological
order. You can Edit or Remove any listed event. To add another event to the form, click Add
an event and repeat these steps.

2. To display a description on the web page for the main multi-level event, enter your text in
Title.

3. To configure attendee and organization fields to display on the form, click Field entry
options.
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a. Under Attendee options, Field options, select the biographical fields to appear on the web
page for the host and guests in the Include column. To change the text to appear on the
web page, enter it in the Caption field and to make it required for the host and/or guests,
select its checkbox in the Required column. To reorder a field in the list, click and drag the
dotted button on the far left.

By default, Last Name is included on the form and required for both the host and guests,
Email is included and required for the host, and First Name is included for the host.

b. Under Organization options, select Allow individual to register on behalf of organization
so users can register as an organization. In the grid below, select the fields to appear on the
web page in the Include column. To change the text to appear on the web page, enter it in
the Caption field and to make it required, select its checkbox in the Require column.

When you allow organization registration, the person who pays the registration fee links to
the organization in Blackbaud CRM.

Note: In the corresponding batch in Blackbaud CRM, two columns are included for the
organization: Organization name and Linked organization auto-match. In Web Transactions >
Configure Integration, on the Auto-match tab, you can specify matching criteria for the batch to
auto-match and update the Linked organization auto-match column. After you commit the
batch, the Registrations tab on the Event record displays the organization record.

4. To select additional information for the part, click Options.
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a. Select Include review step to display the Review page to users on the event registration
form.

b. Under Total registrants, enter the maximum number of registrants to allow a user to enter
on your website during a single transaction. You cannot enter a number greater than 50.

c. Under Select constituency, select a constituency to apply to registrants. For more
information about constituencies, refer to the Constituents Guide.

d. Under Appeal tracking, click the binoculars to select an appeal for event registration
payments. Any appeals that are already associated with the event record in Blackbaud CRM
display on the search screen. You can also click Search to view and select from all active
appeals.

102 CHAPTER 1



Note: Event registration payments are automatically associated with campaigns that have been
added to the event record in Blackbaud CRM. Within a BBIS Event Registration Transaction Batch in
Blackbaud CRM, you can modify the appeals and campaigns that are associated with event
registration payments.

e. To enable users to make an additional donation during checkout, select Allow additional
donations under Additional donations. In the grid that appears, click the binoculars in the
Designation column to select a designation. In the Display name column enter the text to
display. To include a Designation field so participants can select from a list of funds, click
Add designation and select a designation for each option. In the Default column, select the
checkbox for the designation to use when the user does not select one. The gift links to the
participant’s constituent record, but not to the event record.

Note: You can allow users to select from a list of up to twenty-five designations.

Under Giving levels, set up the suggested giving levels to display on the donation form. By
default, three best practices giving levels of $25, $100, and $500 are specified. You can
change these amounts, and add or remove giving levels as desired. There must be a
minimum of one giving level on the form. To remove a giving level, click Remove next to
the one you want to remove. To include a blank $ Other field on the donation form, select
Allow other amount to allow donors to contribute any gift amount. On the form, donors
can enter the gift amount in the Other field.

f. Under Free events, select whether to display the Price column and enter text to appear in
place of the price.

To enter your own custom text, select Display text. In the field below, enter the text to
appear in the column for free events. For example, you can enter “$0” or “Free.”

5. To enable users to specify their consent preferences for how they want to receive
communication from your organization:
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a. Under Consent part, select a saved Communication Consent part to include on the form.

b. Select how you want the communication preference options to display — choose Inline to
embed the options directly in the form itself or choose Overlay to display a pop-up window
with the consent options when the form is submitted.

After users submit the form, their consent information is downloaded along with their
transaction. After the appropriate batch is committed, their constituent record is updated on
the Communications > Preferences tab in Blackbaud CRM with their communication
consent preferences.

6. Under Payment options, select the payment options for website users.

a. In the Merchant account field, select the merchant account to use to process credit card
transactions received through the event registration form, such as your organization’s
Blackbaud Merchant Services account.

The system administrator sets up merchant accounts in Administration. For more information,
see the Administration Guide.

b. For the payment method, select Credit Card, Pledge (Bill me later), or both payment
options.

When you select to include pledges, a Bill me later checkbox appears on the Billing
Information page. When a user selects it, they enter biographical information for billing
purposes, then Submit the form.
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Note: When website users select to process payments by credit card, they must submit
information within 15 minutes on the Checkout page.

Note: When a website user selects Bill me later on the Billing Information page, the Checkout page
does not render the program's secure payment page because a credit card payment is not included in
the transaction.

7. Select whether the default confirmation screen or a custom confirmation screen displays the
summary after a user registers for an event.

If you select Use custom confirmation screen, the HTML editor appears and displays the
default confirmation screen. Customize the default confirmation screen according to your
needs. To format the content’s appearance and layout, use the HTML editor toolbar. To
include personalized information, use merge fields.

The date and time merge fields do not display schedule information for events with a
category of Class in Blackbaud CRM. As you design your confirmation screen for classes, we
recommend you enter schedules in the content.

To display the information from the registrations form's Review page on the
acknowledgment page, include the merge field Full Event Details.

Tip: If you customize the default confirmation screen, the customizations remain even if you later
select Use default confirmation screen. To remove your customizations for the screen, select Use
custom confirmation screen and click Restore default content. The program’s default confirmation
screen appears in the HTML editor.

8. Click Next. The Acknowledgement Email screen appears.
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9. Create the email to acknowledge the registration. You can use the default text provided or
enter different text.

For information about event registration loop merge fields, refer to Event Registration Loop
Merge Fields on page 115.

You can design your email to include a link to the event that populates the registration page
with the recipient's biographical details such as name, address, phone number. To do this,
select Use email links to autofill forms in Sites & settings and make sure the message's query-
based email list uses Constituents as the data source. When a recipient navigates to the event
from the email, the recipient's name appears as a link on the registration page. The recipient
clicks the link to autofill the biographical details. For more information about how to use an
email to autofill a form, refer to the Administration Guide.

Tip: When you edit an Event Registration Form, you can click Acknowledgement Email to access the
Acknowledgement Email screen.

10. Under Additional payment fields, select whether to include reCAPTCHA on the form. When
you select this option, a reCAPTCHA checkbox displays below credit card payment fields on
your Blackbaud Secure Payments form. Users must select the reCAPTCHA checkbox before
they can submit the form.
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11. Click Save. You return to Parts.

Event Registration Form (Classic)
Note: The original Event Registration Form is now called Event Registration Form (Classic). This part
still exists for you to use on your website, but we encourage you to use the Event Registration Form
on page 92. There are a few features the Event Registration Form (Classic) includes that the new Event
Registration Form part does not, such as Payment 2.0 part integration and the ability to link to
another page from the event. You may want to consider this when you create the new part.

To allow website users to register for events online, you can create event registration forms. You can
link your online and offline events and download online registration information directly to event
records.

You can set up the event registration form so that when members register for events online, their
relationships from Blackbaud CRM appear as available participants, making online registration easy for
members and adding personal details to their registration forms.

When the Event Registration Form part is added to a web page, the registration options appear on
separate pages. You can include a status bar for the user to view their progress while they complete
the event registration process.

• Step 1: Start — This is the Event Selection page. Information about each event appears, including
the description, date, and time of the event. By default, the website user selects their events on this
page and enters the registration quantity and pricing information on another page. If your Event
Registration form includes only a few events, you can exclude the first step of registration to
minimize steps for your registrants. When you exclude the first step, the progress indicator
displays the event registration as four steps: Prices, Attendees, Register, and Finish. In a four step
registration, the user selects the events and enters the quantities of event units as part of the Prices
step.

• Step 2: Prices — This is the Quantity and Pricing page. The pricing options and units for the
selected events appears. On this page, the website user enters the quantities of event units to
register. If you exclude the first step of registration, the user selects their events on this step too.

• Step 3: Attendees — This is the Attendees page. On this page, the website user enters who will
attend the selected events and selects any participant attributes you add to the Event Registration
form.

• Step 4: Register — This is the Payment page. A summary of the event registration appears. On this
page, the website user verifies the registration options selected are correct and enters any billing
and payment information.

• Step 5: Finish — This is the Confirmation page. A summary of the billing and payment information
appears.

Note: To design, style, and test a part on your website without creating transactions, generating
emails, or communicating in any way with Blackbaud Services or Blackbaud CRM, select Test mode on
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the Properties tab. For example, you can complete the fields on an Event Registration Form to ensure
the confirmation page is styled and working properly. Although you submit the registration and
receive a confirmation, a transaction does not appear on the Web Transactions page in Blackbaud
CRM. Use Test mode to verify the user’s experience, not to test data processing. Test mode does not
validate credit card numbers and merchant accounts. Only users with supervisor rights can view parts
in Test mode.

Warning: To avoid security issues, do not use an iFrame from a third party website to direct users to
this part on a web page. We recommend you design the page to include the same look and feel as
your third party site so that users seamlessly transition to the page.

Design Event Registration Form

Tip: For optimal performance, include only one Event Registration Form part for each web page.

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

Note: If you are using multicurrency and browser/regional settings, prices are displayed on the
form in both the base currency for the database and the regional currency based on the browser
settings.

1. From the Design tab, under General Options, select a constituency to apply to registrants. For
more information about constituencies, see the Program Basics Guide.

Note: If a registrant already exists in the database, the constituent record updates to include gift and
event data from the downloaded event.

2. Under Registration Options, select Display progress indicator to display a progress status
bar for the user to view during the event registration.
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3. To allow the website user to select both events and registration options on one page, select
Exclude first step of registration. If you do not select this option, a five step progress
indicator appears at the top of the event registration form and the website user selects the
events to register for on one page and enters the registration quantity and pricing information
on another page.

Tip: If you select Exclude first step of registration, Step 1: Start does not appear on the progress
indicator. The progress indicator displays the event registration as four steps: Prices, Attendees,
Register, and Finish. In a four step registration, the user selects the events and enters the quantities of
event units as part of the Prices step.

Note: If your Event Registration form includes one or few events, we recommend you select Exclude
first step of registration to minimize steps for your registrants. If your Event Registration form
includes multiple events, a second event information and selection page may be helpful to your
website users.

4. To display a notification message to users when they attempt to register for events with
overlapping start and end times, select Display event conflict notification. Users can still
register for the conflicting events, but a notification will be displayed.

5. Under Required fields, select the checkbox for each donor field to make required on the
event registration form. To ensure you download complete constituent information, we
recommend that you make all these fields required.

6. Under Captions, for each button or label listed, enter the text to appear on the Event
Registration form.

7. Under Events from Blackbaud CRM, select the event to use.

To add an event to the field list, click Add Event. The Event Search screen appears so you can
select an event.

You can use this event registration form for more than one event. To add another event to the
form, click Add Event and select an additional event. After you select an event, additional
options appear for you to set up how its registration appears on the form.

Tip: By default, event registration fees apply to the designation associated with the event in
Blackbaud CRM.
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a. Under Event options, in the Display Name field, enter the name of the event as it will
appear on the website.

b. In the Display Description field, enter the description of the event as it will appear on the
website.

By default, the text in the Description field appears in the Display Description field.

c. Under Page Link, to add a link to another web page, click the binoculars. The Create Page
Link screen appears. For information about how to create a page link, see the Program Basics
Guide.

d. The help text displays the capacity entered offline for the event. To limit how many
registrants can sign up for the event using the event registration form online, select Restrict
registrations to capacity.

Tip: In Blackbaud CRM, when a registrant's event attendance status changes to "Will not attend" or
"Canceled," the event capacity for the Event Registration Form on your website adjusts accordingly.
For example, if two attendees cancel their attendance for an event, the event capacity increases by
two on your website.

e. To display any relationship records linked to a member’s constituent record in Blackbaud
CRM for selection in registrant fields, select Display relationships.
For example, Mark Adamson has a constituent record. His wife Vicki has a relationship linked
to Mark’s constituent record. If you select Display relationships, when Mark registers for the
Annual Golf Tournament on your website, Vicki’s name appears in the drop-down list when
Mark assigns participants. He can select Vicki or enter another name.
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f. Under Pricing Options, select the prices to appear on the registration page for each event
unit. To display a listed price, select its checkbox in the Include column.

In the Description column, enter the text to appear on the registration page for each event
unit, such as “Individual” or “Couple.”

Note: When you define the number of registrants for each pricing option, we recommend you enter
the number of registrants assigned to the corresponding registration option in Blackbaud CRM.

In the Registrants/Unit column, enter the number of people allowed for the unit.

In the Max units column, select the maximum number of each unit allowed for each
registration. By default, this value is “4.”

To allow participants to register for an event unit anonymously, select its checkbox in the
Allow anonymous column. When you select this checkbox, the Name field is not required
when the website user registers for the event unit.

In the Price (gift amount) and Receipt amount columns, data from the Prices tab of the
event record appears and is disabled. You cannot change this information on the website. To
change the price or receipt amount, edit the event record offline.

g. Under Attributes, select the registrant attributes to appear on the event registration page.
To display a participant attribute, select its checkbox in the Display column.

Tip: Constituent attributes are not available for the Event Registration Form. You can only select one-
per-record registrant attributes with a type of Date, Text, Number, Currency, and Yes/No. Table type
registrant attributes are available without being marked as one per record. Fuzzy Date and
Constituent Name types are not available for the part. If you recently added a new registrant attribute
in Blackbaud CRM and it does not appear in the Attributes grid, click Refresh code tables in Code
tables. This updates code tables from Blackbaud CRM in Blackbaud Internet Solutions. For more

PARTS 111



information about how to update code tables, see the Administration Guide.

To make a selected registrant attribute required, select its checkbox in the Required column.

To change the text of the registrant attribute on the registration page, in the Caption field,
enter the text to appear.

Note: When you download an event registration, the “Online registrant” status defaults on the
registrant record. On the event record, this status also appears in the Online registrant column on the
Registrants tab.

8. Under Additional Donations, to include an additional contribution field on the event
registration page, select Allow additional donations. In the field that appears, select the
designation to credit for additional donations. The gift is linked to the participant’s
constituent record, but not directly to the event record.

9. Under Payment Options, select the payment options for website users.

a. To allow website users to pay for multiple transactions at one time, select Use payment
part. The Payment frame appears.
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In the Payment page field, select the web page to use to process event registrations. The
Payment part on the selected page determines the payment methods and merchant account
used to process event registrations. For information about the Payment part, see Payment on
page 154.

Note: If your payment page uses a Payment 2.0 part, the payment method for it and this part must
match. For example, you cannot select a payment page that only accepts direct debits because this
part only accepts credit cards.

In the box, enter the text to appear on the payment page after an event registration is added.
To format the content’s appearance and layout, use the HTML editor. For more information
about the HTML editor, see the Program Basics Guide.

b. To require website users to pay for event registrations one at a time, select Proceed directly
to payment. Additional options appear.

In the Merchant Account field, select the merchant account to use to process credit card
transactions received through the event registration form, such as your organization’s
Blackbaud Merchant Services account.

The system administrator sets up merchant accounts in Administration. For more information,
see the Administration Guide.

Select whether the default confirmation screen or a custom confirmation screen displays the
summary after a user registers for an event. If you select Use custom confirmation screen,
the HTML editor appears and displays the default confirmation screen. Customize the default
confirmation screen according to your needs. To format the content’s appearance and layout,
use the HTML editor toolbar. To include personalized information, use merge fields.

Tip: If you customize the default confirmation screen, the customizations remain even if you later
select Use default confirmation screen. To remove your customizations for the screen, select Use
custom confirmation screen and click Restore default content. The program’s default confirmation
screen appears in the HTML editor.

10. Click Next. The Acknowledgement Email screen appears.
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11. Create the email to acknowledge the registration. For information about how to design an
email acknowledgement for an event registration, see the Email Guide.

For information about event registration loop merge fields, see Event Registration Loop
Merge Fields on page 115.

Tip: When you edit an Event Registration Form, you can click Acknowledgement Email to access the
Acknowledgement Email screen.

12. To enable users to specify their consent preferences for how they want to receive
communication from your organization:

a. Under Consent part, select a saved Communication Consent part to include on the form.

b. Select how you want the communication preference options to display — choose Inline to
embed the options directly in the form itself or choose Overlay to display a pop-up window
with the consent options when the form is submitted.

114 CHAPTER 1



After users submit the form, their consent information is downloaded along with their
transaction. After the appropriate batch is committed, their constituent record is updated on
the Communications > Preferences tab in Blackbaud CRM with their communication
consent preferences.

13. Click Save. You return to Parts.

Event Registration Loop Merge Fields
Several merge fields output the same registration data, but in different ways. To merge all registration
data into one table without the ability to format and change labels, select the Registrations Block
merge field. To merge registration data in loops for multiple events, registrant types, and attendees,
select the Event Item loop merge fields, Pricing loop merge fields, and Attendee loop merge fields.
These loop fields merge data so you can change labels and use format options to customize the
information.

For example, you create an email acknowledgement for a golf tournament that includes attendees in
the Individual and Family registrant type. When you use the loop merge fields, the program makes the
following loops to merge data.

• Event Item loop merge fields — The program first checks the number of events to include in the
acknowledgement. In this example, there is one loop because your merge includes data for just
the golf tournament event.

• Pricing loop merge fields — Next, the program merges data through loops for registrant types. In
this example, the program makes two loops, one for the Individual type and one for the Family
type.

• Attendee loop merge fields — Lastly, the program loops the actual list of attendees for each
registrant type. This happens multiple times depending on the number of attendees. The program
first loops through the Individual registrant type to merge data for the attendee list. Next, the
program loops through the Family registrant type to merge data for the attendee list.

Event registration loop fields must be nested in the order they appear in the merge field list. The
nesting order is Event Item loop fields, Pricing loop fields, and Attendee loop fields. If you list the
fields out of order, for example you list the Attendee loop fields outside of the Event Item loop
fields, or as standalone fields, the data does not merge correctly.
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Flash Player
With the Flash Player part, you can display dynamic, multimedia content on your website with Flash
technology. Flash files can support audio and video to add interactivity to web pages. You can use the
Flash Player part to add animation or integrate video into your website.

Design Flash Player
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, select a Flash file under Select File.

• To search for a file on your network or computer, click Browse. The Choose file screen
appears.

• To use a URL to point to the file, enter the location of the file in the Provide URL field.

2. In the Height and Width fields, enter the size for the Flash Player part. In the corresponding
fields, select a valid CSS length unit, such as “%” or “px.”

3. In the Display method field, select how to display the Flash Player.
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• To display the Flash Player in a separate window, select “Window.” In Window mode, the Flash
file appears to be on the web page but is actually on a separate window above the browser
window.

• To display the Flash Player in the browser window with an opaque background, select
“Opaque.”

• To display the Flash Player in the browser window with a transparent background, select
“Transparent.”

4. After you select a Flash file, it appears under Preview.

5. Click Save. You return to Parts.

Formatted Text and Images
To include text and images from Image library on your web pages, such as your organization’s mission
statement and logo, use the Formatted Text and Images part. You can also use the Formatted Text and
Images part to create a footer for your website that includes your webmaster’s contact information. On
the Content tab of the Formatted Text and Images part, use the HTML editor to create and format the
text and images to appear.

On the Options tab, you can specify whether website users can copy the content from your website,
such as from a personal page, to use on another web page. For example, the site user can copy the
HTML code necessary for the content on her personal page to appear on a social networking profile
page, family website, or weblog.

Each new and revised Formatted Text and Images part must pass a content approval workflow to
appear on your website. For information about the content approval workflow, see the Administration
Guide. You can add approved Formatted Text and Images parts to each web page in Pages &
templates. For more information about how to add content parts in Pages & templates, see the Website
Design Guide.

Warning: You cannot use HTML to embed your own form via HTML in a Formatted Text and Images
part. We recommend you put the form on a page that is not stored online but can be referenced in
an <iframe> element tag. For more information about how to include customized forms on the
website, contact Blackbaud’s Professional Services at solutions@blackbaud.com.

Warning: You cannot use HTML to embed your own form via HTML in a Formatted Text and Images
part. We recommend you put the form on a page that is not stored online but can be referenced in
an <iframe> element tag. For more information about how to include customized forms on the
website, contact Blackbaud’s Professional Services at solutions@blackbaud.co.uk.

The Formatted Text and Images (Secured) part is the same as the Formatted Text and Images part with
the additional ability to secure the page’s content using encryption such as Secure Sockets Layer (SSL)
or Transport Layer Security (TLS). When the secured part is on a page, the page’s URL starts with
“https”. To design a Formatted Text and Images (Secured) part type, follow the same steps as the
Formatted Text and Images part.
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Design Formatted Text and Images
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, select the Content tab.

2. In the HTML editor content area, enter the content and format its appearance and layout. For
example, you can manually enter or copy and paste your organization’s mission statement. For
more information about the HTML editor, see the Program Basics Guide.

3. To allow site users to copy and paste the content’s HTML code:

a. Select the Options tab.

b. Select Enable HTML code publishing.

c. In the Help text field, enter custom text to appear on the web page to help site users
understand how and why to copy the HTML code. By default, the message “Copy and Paste
the following code where you would normally publish HTML content” appears.

4. Select the content approval workflow to use with the part and its approval status in the
workflow.
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a. On the Edit Part screen, select the Content Approval tab. For information about the items on
this tab, see Content Approval Tab on page 21.

b. If you have rights to manage workflows, the Workflow Name field appears. In this field,
select the workflow to apply to the part.

When you create a workflow in Workflows, you can select whether it is the default workflow
for the selected part type. When you design a part and select its workflow in the Workflow
Name field, an asterisk (*) appears next to the default workflow. For more information, see
the Administration Guide.

c. When you complete the design of the part and its content, in the Approval Status field,
select “Ready for Approval.” Until the part is complete and ready for approval, select the
approval status of “Draft.”

5. Click Save. You return to Parts.

Formatted Text and Images (Secured)
The Formatted Text and Images (Secured) part is the same as the Formatted Text and Images part with
the additional ability to secure the page’s content using encryption such as Secure Sockets Layer (SSL)
or Transport Layer Security (TLS). When the secured part is on a page, the page’s URL starts with
“https”. To design a Formatted Text and Images (Secured) part type, follow the same steps as the
Formatted Text and Images part. For more information, see Formatted Text and Images on page 117.

Frame
With the Frame part, you can store a live web page from another website on your site. This part is
helpful when you migrate from one website to a new one. For example, you can store pages from your
organization’s old website in a frame for your new website.
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Design Frame
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the URL field, enter the web address of the web page to appear in the
Frame part.

2. In the Height and Width fields, enter the specifications of the Frame part. Use a valid CSS
length unit, such as % or px.

3. When you select Include connection information, the program submits form data plus the
REID and DIRECTORYREID to the iFrame. REID is the logged in user’s constituent ID and
DIRECTORYREID is a value taken from the current page’s REID value in the query string.

Use Include connection information only for more complex web applications that are
designed to receive this data.

4. Click Save. You return to Parts.

Giving Search
Note: The Giving Search part is deprecated, and we recommend that you use the more powerful
Designation Search part instead. The Giving Search part still exists for backward compatibility of your
website, but Blackbaud encourages you to use the Designation Search part. The newer part allows
users to enter key words or select search filters to search for designations, and you can use it in
combination with other parts to create a powerful designation search feature for your website. For
more information, see Designation Search on page 45.
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Create a Giving Search part to provide an online designation search for donors. Donors use the search
to find a designation and make a donation. When the search results appear, a donor clicks the
designation to navigate to the donation page. When you create the Giving Search part, you can select a
query of designations so donors do not search all designations in your database.

Design Giving Search
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Search Form, in the Split search fields into field, select how
many columns of search fields to include in the criteria table. You can display up to five
columns.

2. Under Results, set up how search results appear in the giving search.

a. In the Show navigation controls field, select whether the navigation buttons appear above
the results, below the results, or both.
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b. In the Results per page field, select the maximum number of funds per page in the search
results. You can display up to 50 results per page.

The giving search can return up to 200 funds that match the criteria entered by a site user.

c. The search results link to a donation page on your website. In the Linked donation page
field, select the donation page.

3. Under Fields to Include, select the fields to use in the giving search. To move a field from the
Available Fields box to the Search Form Fields box, select the field and click the right arrow.

To move a field in the Search Form Fields box, select the field and click the Up or Down
button. The search fields on the web page appear in the same order as the fields in the box.

Note: The fields in the Search Form Fields box and the Listing Fields box do not have to match.

4. Select the fields to appear in the search results. To move a field from the Available Fields box
to the Listing Fields box, select the field and click the right arrow.

To move a field in the Listing Fields box, select the field and click the Up or Down button. It
is important to remember the following about the fields listed in the box.

• The donation automatically applies to the designation selected in the search results.
• Result fields on the web page appear in the same order as the fields in the box.
• The first field becomes a link to the donation page.
• The first field is disabled in the Designation field on the donation page. The user cannot

change it.
• If included, the donation confirmation screen includes the value from the first field when the

Designation merge field appears on the screen.

Tip: You can use the link in the search results to include a URL to your donation page in an email. To
obtain the URL for the donation page, right click on the link. From the menu that appears, select Copy
Shortcut. Go to your email to paste the URL into your email message. When a recipient clicks the
URL, the donation page appears. The field selected first in the Listing Fields box, which is the link in
the search results, is disabled in the Designation field on the donation page and the website user
cannot change the information in the field. To link to a donation page this way, it is best to include
fields such as Fund ID or Description first in the Listing Fields box. These are logical fields to appear
in the Designation field.

5. Click Save. You return to Parts.

Language Selector
With the Language Selector part, you can allow website users to select language preferences for your
website. Users select their preferences from the languages available on your website. You can make
languages available in the Supported Languages section on the Settings tab in Sites & settings. The
website renders text for selected languages based on the Language tabs of the parts on your website.

Tip: For the Language Support part to be effective, you must localize text on the Language tab
before you use the part.
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After users select languages, the website localizes text on the parts on your website. For example, if a
user selects Spanish as the preferred language and goes to a donation form, the Donation Form part
displays localized Spanish text from the Language tab. For more information about the Language tab
and international pages for your website, see Add Localized Text For Web Pages on page 19.

Language preferences remain in place when users return to your website. For registered users, the
program associates language preference with user logins. For anonymous users, the program
associates language preferences with cookies on their machines.

Note: If you enable Multicurrency in Blackbaud CRM to accept multiple currencies, the Language
Selector part also translates currencies on donation forms. Users enter or select donation amounts in
your default currency, and the form displays approximate values in the currency associated with the
preferred language. To calculate values in preferred currencies, the program uses exchange rates
from Blackbaud CRM. However, exchange rates may change before you process transactions, so the
values on the forms are only estimates. For information about how to configure Multicurrency, see the
Blackbaud CRM Multicurrency Guide.

Design Language Selector
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. On the Design tab, the Language Selector part does not contain design options.

2. Select the Language tab. You can edit default text and localize text for other languages. The
tab appears on parts such as the Donation Form and Giving Search. For more information
about the Language tab, see Language Tab on page 17.

3. The Category field lists the areas on the part that you can edit. For the Language Selector part,
you can only edit the Form fields category.

4. In the Language field, select the language to localize. You can make languages available in the
Supported Languages box on the Settings tab in Sites & settings.
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5. In the Text column, enter text to rename the language field or localize it for other languages.

Note: The default language selection is based on the primary language for the website user’s Internet
browser. If you do not support the browser language in the Supported Languages section on the
Settings tab in Sites & settings, the default selection is based on your default language.

6. Click Save. You return to Parts.

LinkedIn Group Join (Deprecated)
Note: Due to LinkedIn API changes, the LinkedIn Group Join part has been deprecated and no longer
works on your website. If the part exists on any of your websites, we recommend you remove it as
soon as possible.

Membership Form
Warning: To avoid security issues, do not use an iFrame from a third party website to direct users to
this part on a web page. We recommend you design the page to include the same look and feel as
your third party site so that users seamlessly transition to the page.

The Membership Form part includes a membership section on your website to solicit new members
for your organization or for existing members to renew their memberships.

When you design the part, you can include multiple membership programs. You select to include
information such as the membership levels and terms.

Note: Annual dues-based programs purchased on your website must be paid in full . Lifetime dues-
based programs purchased on your website can be paid in full or can use installment plans. Other
types of programs are not available to use on your website.

For the website administrator who sets up the part:

• Step 1, Pick your membership programs: A list of available membership programs is displayed. You
select the ones you want to be available for a user to pick on your website. You can also change
the text for the names and descriptions to alter how they will appear on the website. Then you set
up payment part information.

• Step 2, Configure programs: For each program, you select the levels that will be included, as well
as the terms, if applicable. You also select the payment options members will have to choose from,
such as pay in full, if applicable.

• Step 3, Save the part: After you configure your programs, you save the part and can add it to a
page. For more information about how to set up the part, see Design Membership Form on page
125.

Note: In order to download membership transactions from non-logged in users on your website, you
must use a membership dues batch in CRM that does not have the Bill to field marked as required.

For the prospective member who visits your website:
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• Step 1, Pick your membership: Buttons for each available membership program, level, and term
combination are displayed. The visitor clicks the button for the one he wants to join. The total cost
is displayed.

• Step 2, Add to cart: The visitor clicks Add to cart and is redirected to the payment page to enter
name and address information.

• Step 3, Pay for the membership: The visitor clicks Check out to complete the transaction.

When an existing member logs into the website, the membership closest to the expiration date is
highlighted and the expiration date is displayed. Members can select the program and renew the
membership.

Design Membership Form

Tip: In Pages & templates, we recommend you do not add more than one Membership Form part on
a page.

For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

Note: If you are using multicurrency and browser/regional settings, prices are displayed on the
membership form in both the base currency for the database and the regional currency based on
the browser settings.

1. From the Design tab, under Build your part, select Pick your programs.
2. Select which membership programs to include in the part. The order of the programs in the

list is the order they will appear in on your website. You can click and drag the programs in the
membership part to change their order.

For each program you select to include, a new configuration option appears under Build your
part.

3. Under Payment setup, select the Payment page to use. The Payment part on the selected
page determines the merchant account used to process memberships. Memberships can only
be purchased online using a credit card. For information about the Payment part, see Payment
2.0 on page 158.

You also can design an acknowledgement message. On the Payment 2.0 part, you can use the
Combined Acknowledgements merge field to include this message on the confirmation
screen and acknowledgement email that users receive after they check out.

4. Under Build your part, select each program to configure it. When you configure each
program, you can select which levels and terms, if applicable, of the membership program will
be available on your website. You can modify the display names and descriptions, if needed.

5. You can also select which payment options will be available for the membership program on
your website. At least one payment option must be selected. If there is only one payment
option defined, it is selected by default and cannot be changed.

Note: Annual dues-based programs purchased on your website must be paid in full. Lifetime
dues-based programs purchased on your website can be paid in full or can use installment plans.
Other types of programs are not available to use on your website.

6. Click Save. You return to Parts.
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Note: In order to download membership transactions from non-logged in users on your website, you
must use a membership dues batch in CRM that does not have the Bill to field marked as required.

Menu (Deprecated)
Warning: The Menu (Deprecated) part was replaced with the more powerful Menu part. The Menu
(Deprecated) part type appears in Parts only if you have saved Menu (Deprecated) parts. While the
deprecated part continues to operate for backwards compatibility on your website, you can no
longer create or copy Menu (Deprecated) parts. The Menu part includes all the functionality of the
Menu (Deprecated) part. In addition, the Menu part supports standards for Website Accessibility (WAI)
and includes a number of standard style options without the use of CSS. It also includes an import
tool to help upgrade your Menu (Deprecated) parts. For more information, see Menu on page 126.

Menu
With the Menu part, you can create a menu and a popup menu for your website. For example, when
you visit Blackbaud’s website and hover over the Products menu, a popup menu appears. The popup
menu includes menu items such as Internet Solutions and Fundraising. You can create a similar menu
for your website using Menu.

Note: Some mobile devices do not support popup menus. If you use popup menus on your website,
we recommend that you also create an alternate menu for mobile devices. In Layouts, you can insert a
content placeholder pane for the menu with popups on a layout for desktop browsers. And on a
layout for mobile devices, you can insert a content placeholder pane for the menu without popups.
You can then select the layouts for a template and place only the appropriate Menu part in each pane.
This way, only the correct menu will appear in desktop browsers and mobile devices. For information
about how to create layouts and select them for templatess, see the Website Design Guide.

You create the Menu part in two steps. One step is to add the menu definitions, such as Home and
About Us. For each main menu item, you can define popup menu items. The second step is to create
the style and format for the menus using tables or an unordered list. For table-based menus, you can
select a color and font size to appear for a menu item when a website user hovers over the menu item.
You select standard CSS style options easily on the Edit Part screen in fields such as Border color and
Font color. You can also create custom styles if necessary. For menus based on unordered lists, you
assign the custom class for the menu.

Note: You can add log in and log out links to your menu. On the menu part for the log in link, use the
Create link to special page option to select a page that includes a User Login part. For the log out
link, use the Create link to Blackbaud Internet Solutions page option to select the log out page
that includes the User Login part. Users view these links in the menu based on whether they are
logged in or out.

Upgrade a Menu (Deprecated) part
To upgrade a Menu (Deprecated) part for Website Accessibility and more style options, import the
part in a Menu part. When you upgrade a Menu (Deprecated) part, be aware that some style
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options may not convert to Menu. Also, additional styles may be required for Menu. We
recommend you fully test a converted menu and re-create style options if necessary.

1. From the Design tab, select the Build tab. The Import Menu (Deprecated) Items frame
appears.

2. In the Menu (Deprecated) part field, a list of the existing Menu (Deprecated) parts appear.
Select the Menu (Deprecated) part to upgrade to Menu.

3. To import CSS styles from the Menu (Deprecated) part, select Import/Overwrite compatible
styles. If you do not select this checkbox, only the menu items and structure upgrade to Menu.

4. Click Import. The Menu (Deprecated) part upgrades to Menu.

5. Select the Style tab. The Styling Options frame appears. For more information about these
options, seeDesign a Menu definition on page 127.

6. Click Save. You return to Parts.

Design a Menu definition
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

Show Me: Watch a video about how to add a web page to a menu.

1. From the Design tab, select the Build tab.

2. To add a menu item, click Add item. The menu item appears under the top-level parent menu
item, and the Menu item properties frame appears.
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Tip: To rearrange menu items, select them and click the arrows.

a. In the Label field, enter a menu item name to display in the menu.

b. In the Tooltip field, enter a description to display when the cursor hovers over the menu
item.

c. In the Link field, click the binoculars to link the menu item to a web page. The Create Page
Link screen appears. For information about how to create a page link, see the Program Basics
Guide.

d. If you enter a window in the Open in another window named field on the Create Page Link
screen, the Target window field displays the name of the window. To change the window,
click the binoculars in the Link field.

e. If you select Use unordered list menu on the Style tab, the Styling class field and two links
appear. In the Styling class field, enter the class name from your style sheet for the menu
item. For example, you can enter "red" or "blue" to change the item’s color.

For more information about style sheets, see the Website Design Guide.
• To apply the class to sibling menu items within the same menu node, click Apply to sibling

menu items.
• To apply the class to all menu items in the part on the same level, click Apply to all menu

items at this level.
For example, enter "red" for Level 1 and click Apply to sibling menu items.
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Then enter "blue" for Sublevel A and click Apply to all menu items at this level.

On your web page, the Level items are red in Section 1 only. Level items in Section 2 are not
because you only applied the style to siblings within the same node. All Sublevel items are
blue because you applied the style to all items on the same level regardless of the parent
node.
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3. To add an additional menu item, click Add item, and repeat the steps in this procedure. You
can add as many menu items as necessary.

4. On the Style tab, select whether to style the menu with tables or with an unordered list
formatted by CSS.

5. To style the menu with tables, select Use table-based menu.
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a. In the Category field, select a style category to apply style options. For information about
the style categories, see Style Categories for the Menu on page 134.

b. To create a custom class for CSS style options, select Enable custom CSS.

In the Custom class field, enter a custom class such as “.navMenuItem.” You enter the CSS for
the custom class in Style sheets. For information, see the Website Design Guide.

c. To select standard CSS style options, select Enable standard CSS.
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The available style options depend on the style category. For information about the standard
CSS styles, see Standard CSS Style Options for Menu on page 132.

d. After you select style options for a style category, select another style category. The program
saves your changes.

6. To style the menu with an unordered list formatted by CSS, select Use unordered list menu.

7. In the Top level class name field, enter the custom class name. You enter the CSS for the
custom class in Style sheets.

For information, see the Website Design Guide.

8. Click Save. You return to Parts.

Standard CSS Style Options for Menu
Standard CSS style options vary depending on the category you select. Refer to the following tables
for standard CSS styles for each Menu category. For information about applying standard CSS style
options, seeDesign a Menu definition on page 127.

Style category: General

Orientation Display popup
image on
submenus

Static levels Custom glyph

Static level indent Preview
background
color

Display popup
image on main
menu

Text wrap

Style category: Main Menu or Popup Menu
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Background color Font size

Border color Font underline

Border style Font color

Border width Height

Bold Horizontal
padding

Italic Vertical padding

Font name(s) Width

Style category: Main Menu Item or Popup Menu Item and Main Menu Selected Item or Popup Menu
Selected Item

Background color Font size

Border color Font underline

Border style Font color

Border width Height

Bold Item spacing

Italic Width

Font (names)

Style category: Main Menu Item Hover or Popup Menu Item Hover
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Background color Font name(s)

Border color Font size

Border style Font underline

Border width Font color

Bold Height

Italic Width

Style Categories for the Menu
In the Category field of the Menu part, you select style categories to apply style options. Style
categories include the various menu types. This table describes the available style categories.

Style Category Description

General This applies to your entire menu. For example, Blackbaud’s menu is
horizontal at the top of every web page.

Main Menu This is your main menu. For example, Home, Products, and Services are a part
of the main menu on Blackbaud’s website.

Main Menu Item This is your main menu in its natural state. For example, you browse
Blackbaud’s website, but you are not currently hovering or clicking a menu
item.

Main Menu Item Hover This applies to a main menu item when a user hovers the cursor over it. For
example, when you hover the mouse over Blackbaud’s Products menu item,
the menu button changes to a darker shade of grey.

Main Menu Selected
Item

This affects a main menu item after a user clicks it. For example, when you
click Blackbaud’s Products menu, you land on the Products page and the
Products menu button has a bright yellow background to indicate it is for
the current web page.

Popup Menu This applies to your popup menu. For example, when you hover over
Blackbaud’s, Products menu, a popup menu appears with menu items such
as Fundraising, Forms, and Solutions by Industry.

Popup Menu Item This is your popup menu in its natural state. For example, you hover over
Blackbaud’s Products menu to view the items on the popup menu for it, but
you are not currently clicking or hovering over a popup menu item.
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Style Category Description

Popup Menu Item
Hover

This applies to a popup menu item when a user hovers over the popup menu
item. For example, you hover your mouse over Blackbaud’s Fundraising
popup menu item. When you do this, the popup menu button changes to a
lighter shade of blue.

Popup Menu Selected
Item

This affects a popup menu item when a user navigates to the web page for
that menu item. For example, you click Blackbaud’s Fundraising popup menu
item. You land on the Fundraising page. You can select to style the
Fundraising popup menu button with a bright yellow background to
indicate to a user he or she is on the web page for that popup menu item.

Navigation Buttons
To create a navigation bar, use the Navigation Buttons part. Buttons on a navigation bar honor security.
For example, if you have a Board Members Only page, only a website user logged in as a board
member can view a button on the navigation bar used to access this page.

Design Navigation Buttons
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Orientation field, select the orientation to display the navigation
bar on your web page.

• To display the navigation bar from left to right, select “Horizontal.”
• To display the navigation bar from top to bottom, select “Vertical.”

Tip: Use the up and down arrows to sort your navigation buttons in the order they will appear on
your web page.
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2. In the Preview with Style Sheet field, select the style sheet to use for your navigation bar. For
example, to use the default style sheet, select “System Default.”

For more information about style sheets, see the Website Design Guide.

3. To add a button for your navigation bar, click Add Item. The Navigation Bar Item screen
appears.

4. In the Caption field, enter the information to appear in a yellow box when your website user
moves the mouse over a navigation bar button.

Warning: All images used for navigation bar buttons must be previously created and saved using
graphics software such as Microsoft Photo Editor. You cannot create these images in the program.

To not use images for a navigation bar button, add a linked heading for navigation. In the
Caption field, enter the heading to link. The heading you enter appears on your web page and
is linked automatically. To select the web page to link to, complete the next step in this
procedure.

5. In the Page field, click the binoculars to select the web page where the navigation bar
appears. The Create Page Link screen appears. For information about how to create a page
link, see the Program Basics Guide.

6. In the Default Image field, view the image that automatically appears when your website user
accesses the web page, before the website user moves the mouse over or clicks the button.

To select a default image, click the Image button. The Select Image from Image Library screen
appears.
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7. In the Hover Image field, view the image that appears when your website user moves the
mouse over the button on the navigation bar but does not click the button.

To select a hover image, click the Image button. The Select Image from Image Library screen
appears.

8. In the Selected Image field, view the image that appears when your website user clicks the
button on the navigation bar.

To select a selected image, click the Image button. The Select Image from Image Library
screen appears. For more information about how to insert an image, see Program Basics Guide.

9. To save the images for your navigation bar, click OK. You return to the Edit Part screen. On the
Design tab, the selected images appear.

Note: To cancel the addition of the images for the navigation bar, click Cancel. You return to the Edit
Part screen.

10. Click Save. You return to Parts.

News Reader
The News Reader part type allows the system administrator to display Really Simple Syndication (RSS)
content or Atom content on your website. These are XML-based formats used to distribute web
information. For example, if your organization is health related, you can create a web page for health
tips and include a News Reader part type that includes news headline feeds from other health-related
websites. Using RSS or Atom and the News Reader part, you can include these headlines on your
website automatically.

The website supports RSS versions 0.9, 1.0, and 2.0 and Atom version .3.

Design News Reader
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Source field, enter the website address that contains the XML
content to display on your website. Typically, sites that share content display orange XML
icons that are hyperlinks to their website feeds.
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2. In the Link target field, enter where to open the linked page. For example, to open the link in
a new window, enter “_blank.”

3. In the Number of articles to display field, enter how many articles to display. To display all
recent articles, leave the default “0” in the field.

4. To display articles on multiple pages, select Display [ ] articles per page and enter the
number of articles per page.

5. To display article titles only, select Display headlines but not articles. Users can click links to
access articles.

6. To display any graphics associated with the website feed, select Display graphics associated
with the feed.

7. To display dates for the articles, select Display dates for postings if available.

8. Under Authentication options, enter the authentication information for a website that
requires authentication to access its XML content.

a. In the Type field, select the authentication type that the news feed provider requires.
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Note: Basic authentication does not encrypt the user name and password and sends the credentials
over the network in plaintext. Digest authentication encrypts the user name and password and does
not send them over the network in plaintext.

b. In the User name and Password fields, enter your authentication information. To display
XML content that requires authentication, you must have a user name and password with the
news feed provider.

9. Click Save. You return to Parts.

Page Element Types
To add sections to a web page that are dynamic and customizable for an individual’s use, create page
element parts. The program contains multiple page element part types for the end users of personal
pages. These part types are Chapter Page Elements for chapter managers and Personal Page Elements
for anyone who wants to create a personal page on your site. One example is someone who is ill and
wants to create a care page for family and friends to visit. With web pages that contain page elements,
the pages have customization parts (the page element types) for use on a personal level. For more
information about these parts, see the Chapter Management Guide and Personal Page Management
Guide.

When someone has a personal page on your site, other people who support or know the individual
can visit the personal page to learn more about his relationship with your organization and make
donations. Web pages with page elements also contain static sections that are other parts. Use these
sections to create defaults for your organization to appear on every personal page. For example, use
the static parts to include your mission statement, graphics, or any other information to appear on
every personal page.

When you create a page element part, you select the type of page element to appear on a personal
page. The chart lists every page element type and the page element parts where they are available. For
example, for a Chapter Page or Personal Page Element, you can select a News Reader element type.
Page element types create various forms of customizable parts for pages. For information about each
page element type, review the procedure that applies to the type.

Page Element Type Chapter Page
Element

Personal Page
Element

Action X X

Comments X

Directory X

Event Calendar X

News X X
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Page Element Type Chapter Page
Element

Personal Page
Element

News Reader X X

Page Links X

Photos X X

Profile X

Rich Text X X

Text X X

Action Page Elements
To include a Report Abuse button on a web page for a Chapter Manager or Personal Page Manager
part, you can create an Action page element type. Site visitors can click this button to report activity
that is inappropriate for your site. When a visitor clicks this button, your website administrator
automatically receives an email notification about the inappropriate activity.

Design Action for Page Elements
For information about page element parts, see Page Element Types on page 139.

1. From the Design tab, select “Action” in the Display As field.

Note: You can include the Action page element in a Chapter or Personal Page element parts.

2. In the Display Name field, enter a name for the action section on the page.

3. In the CSS box, enter Cascading Style Sheets (CSS) text to override the default style of this
element.

Use CSS text to create unique elements, such as to change the text on the Report Abuse
button. CSS is easier to use than other methods, such as HTML. Unless you specify a custom
style sheet, your website uses default style sheets.

For more information about CSS, see the Website Design Guide.

4. Under Details, depending on the personal page type you create, such as Chapter Page
Element, different options appear in the Display As field. For more information about this
field, review the chart and steps.

Chapter Page Element Personal Page Element

Chapter Console Link Report Abuse

Report Abuse

5. In the Display As field, if you create the Action page element for a Chapter Manager part,
select “Chapter Console Link.” This creates a navigation link for content and data managers to
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click to access his Home page on your chapter site. The link appears only for managers
contained in a role with rights to manage the chapter content or data. When you select
“Chapter Console Link,” a Link Text field appears. Enter the text to appear as a hyperlink on
your chapter site, such as “My Console Manager.” Managers of the site click the link to access
the Home page.

If you create the Action page element for a Personal Page Manager part, select “Report Abuse”
to include a Report Abuse button on the personal web page. Additional fields appear.

a. In the Display Text field, enter the text to appear on the button on your website, such as
“Report Website Offense.”

b. In the Email field, enter your website administrator’s email address. This address does not
appear on your site. However, if a user clicks the Report Abuse button on your site, your
administrator automatically receives an email notification about the inappropriate activity.

c. In the Confirmation Message field, enter the text to appear for a site user who clicks the
Report Abuse button. The default text is “This page has been reported to the administrator.”

6. Click Save. You return to Parts.

Comments Page Elements
To allow page owners to add a comments section to their personal page, create a Comments page
element type. When a personal page has this functionality, friends and family of the personal page’s
“owner” can post comments, public or private, to the page.

Note: Website users with supervisor rights can edit and delete posts for the Comments page
element.

Design Comments for Page Elements
For information about page element parts, see Page Element Types on page 139.

1. From the Design tab, select “Comments” in the Display As field.

Note: You can include the Comments page element in a Personal Page Elements part.

2. In the Display Name field, enter a name for the comments section on the page.

3. In the CSS box, enter Cascading Style Sheets (CSS) text to override the default style of this
element.

Use CSS text to create unique elements, such as to change the text on the Post a Message
button. CSS is easier to use than other methods, such as HTML. Unless you specify a custom
style sheet, your website uses default style sheets.

For more information about CSS, see the Website Design Guide.

4. Under Details, in the Default Title field, enter a title for your comments box on your website.

a. In the Button Caption field, enter a label for the button that website users click to post a
comment.

b. To allow visitors to create private comments, select Allow Private Messages.
c. To display dates for comments, select Display under Date Column.
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In the Caption field, enter a column header. The default header is Date.

d. To display comments, select Display under Message Column.

In the Caption field, enter a column header. The default header is Message.

e. To display the names of comment authors, select Display under Author Column.

In the Caption field, enter a column header. The default header is Author.
5. Click Save. You return to Parts.

Directory Page Elements
To allow chapter managers to access directories on chapter pages, use the Directory page element
type. This directory contains a list of the names in the Members role in the Chapter Manager part. For
more information about this role, refer to the Chapter Management Guide.

Design Directory for Page Elements
For information about page element parts, see Page Element Types on page 139.

1. From the Design tab, in the Directory title field, enter a name for the directory, such as “Class
of 2000 Directory.”

2. Under Records to Include, specify the records to include in the directory search results.

a. The Limit to query field displays the selected query of records included in the directory. By
default, “All Constituents” appears.
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Tip: For a query to appear as a selection, you must first create it in Blackbaud CRM. When you create
a query, you may need to refresh the website for it to appear as a selection. To refresh, select View,
Refresh from the menu bar.

To include information from all constituents in your database, leave the default “All
Constituents.” To select another existing constituent query to use as the directory, click
Change. The Query Search screen appears.

For information about how to use the Search screen, see the Program Basics Guide.

b. In the Include field, select the type of constituent records to include in the directory search
results. You can select “Both Organizations & Individuals,” “Individuals Only,” or
“Organizations Only.”

c. To include deceased constituents in the directory search results, select Include Deceased.

3. When you use the Academic Catalog in Blackbaud CRM, an Education Fields section appears.
In the Include field, select whether to include academic information from affiliated
educational institutions only or both affiliated and unaffiliated institutions for the search and
results filters.

Tip: To improve search performance, narrow the volume of institutions to search by selecting
"Affiliated educational institutions" in the Include field. After you save the part, you cannot change
your selection in this field.

In addition to this section, more educational fields are available to integrate Academic Catalog
data with this part on your website. Under Available Fields, in the Additional Information
nodes for Primary Alumni and Education History, the College/School, Division,
Department, Sub Department, and Degree type fields appear to support the integration.
When you use these fields, website users can search and view the information in the directory
display window for affiliated and unaffiliated institutions, depending on the selection you
make in this section. For example if you select "Affiliated educational institutions" and include
the Department field, users can narrow their search by selecting a department and then view
the information in the search results for affiliated institutions only. Also, you can use the
Program and Degree fields under the Primary Alumni and Education History nodes to
search and display this data for affiliated and unaffiliated institutions.

Note: When you enable or disable the Academic Catalog in Blackbaud CRM and then add or remove
Academic Catalog fields on the part for your web page, the changes do not reflect on your website
for approximately 20 minutes.

4. Under Search Form, in the Split search fields into field, select how many columns of search
fields to appear in the criteria table. You can display up to five columns.

To process a search while the user browses your Directory part, select Load unfiltered results
when this part is loaded. When you select this checkbox, the directory search processes
before the user enters criteria and clicks Search on your website.

5. Under Results, set up how search results appear on your Directory part.

a. In the Show navigation controls field, select whether the navigation buttons should appear
above the results, below the results, or both above and below the results.
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b. The directory search can return up to 500 results that match the criteria entered by a site
user. In the Results per page field, select the maximum number of results to appear on a
page when a site user searches the directory. You can display up to 50 results per page.

c. You can include in the search results the total number of records that met the user’s search
criteria. In the Show number of results field, select whether to display the total number of
results above the results, below the results, or both above and below the results.

d. In the No records found message field, enter the message to appear if no records meet the
search criteria the user enters to search the Directory on your website. By default, the
message “No directory entries match your criteria” appears.

e. Directory results can link to a page containing a Profile Display part. In the Linked profile
page field, select the page to link to. The field you list first in the Listing Fields box
becomes the link to the page you select in Linked profile page field.

f. To allow website users to send personal messages to constituents in the results, in the
Include a send message link for field, select the User Networking Manager part to link to
the directory results.

Note: If constituents opt out of email in Blackbaud CRM, website users can send them personal
messages through the user networking site, but they cannot send them email messages.

g. To allow website users to send personal messages through the User Networking Manager
part to constituents who are not registered website users or who are registered but are not
members of the user networking site, select Allow messages to non-users.

Warning: Constituents who do not have user networking accounts receive personal messages
through email. To allow users to send email messages to these constituents, you must enable a
Directory Message Notification in Email and select the User Networking Manager part for it. Without
this notification, your users will not be able to send messages to constituents who are not registered
website users or to constituents who do not have social networking accounts. For more information
about notifications, see the Email Guide.

6. Under Fields to Include, select the fields the user uses to search the directory, such as First
Name or Last name. Right-click and drag the field from the Available Fields box to the
Search Form Fields box, or select the field in the Available Fields box and click the right
arrow to move it to the Search Form Fields box.
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When you integrate with Blackbaud CRM, do not include the Business.County or
PreferredAddress.County field in the Search Form Fields box. Blackbaud CRM does not
support these fields in a directory search.

Note: The system administrator selects the attributes available on the Settings tab on the Settings tab
in Sites & settings. For more information, see the Administration Guide.

To arrange the placement of a field in the Search Form Fields box, select the field and click
the Up or Down button.

Note: The fields in the Search Form Fields list and the Listing Fields list do not have to match.

7. Select the fields to appear when the search finds a match. To select a field, right-click and
drag it from the Available Fields box to the Listing Fields box. To move a field from the
Available Fields box to the Listing Fields box, you can also select it and click the right arrow.

To arrange the placement of a field in the Listing Fields box, select the field and click the Up
or Down button.

Warning: The listing field you put first for results acts as a link to the constituent record. However, if,
on the Profile Form, the field’s data is marked Privacy edit and the user selects to hide the data, no
link exists. For example, if you select to list First name first, and the user selects to hide First name
data, no link appears.
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While you can link every field, the field you place first in the Listing Fields box automatically
links to the page you select in the Linked Page field. For example, you select to display the
alumni’s last name, first name, birth date, address, and whether the user wants to receive email.
In this case, the last name is the link. When results appear, to indicate the last name is a link, it
is underlined and changes color when you drag your mouse over it. When a website user clicks
the alumnus’s last name, the published profile information for that constituent appears.

8. Click Save. You return to Parts.

Event Calendar Page Elements
To include a calendar on your chapter site, create an Event Calendar page element type. Managers use
the calendar to post event dates and information to a web page.

Design Event Calendar for Page Elements
For information about page element parts, see Page Element Types on page 139.

1. From the Design tab, under General options, enter a name for the calendar in Calendar title
field.

2. Under Default display, select the default view of the calendar. You can select Calendar view
or List view. The website user can always select a different view when they open the calendar.

3. To integrate the calendar with events that have been created in Blackbaud CRM, select Include
events from Blackbaud CRM. Click the binoculars to select an existing event query in
Blackbaud CRM. When you include events from Blackbaud CRM on your website event
calendar, the events appear after the next integration. To integrate the calendar with events
from the query, include frequency information under Blackbaud CRM integration in
Administration. The calendar updates according to the frequency unless you click Refresh
events to immediately integrate the calendar with events. For information about frequency
settings, refer to the Administration Guide.

Tip: We recommend that you add an event attribute to the event records in Blackbaud CRM that
you want to display on your website event calendar. You can then create an event query for events
with that attribute.

4. Under Uncategorized events management rights, select the roles with rights to manage any
events not associated with a category.

5. Under Event Categories, select the event categories to associate with the calendar. After you
add a category, click Assign rights to the category. The Event Category Security screen
appears so you can assign rights to users and roles for the event category. For example, a
Soccer calendar may have the Registration, Practice, and Games categories, and only users in
the Coaches role can add, edit, or delete events in these categories. Also, when the coach adds
a new event, they can assign its category from those you select for the calendar. For example,
the coach specifies whether the new event is Registration, Practice, or Games. You can use
these categories to filter the types of events that appear in calendar groups and calendar
highlights. For example, you can set a calendar highlights part to display only events included
in the Game category. For information about how to add event categories, see the
Administration Guide.
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6. To include a weblog for the Event Calendar part, select Enable RSS. Additional fields for the
weblog appear.

a. In the Date format field under Appearance, select a date format for the weblog.

b. Under RSS publishing properties, in the Title field, enter a title for the weblog.

c. In the Link URL field, enter a website address news readers can use to link to the calendar
weblog. Also, if your website has a News Reader part, add this link to your news reader so it
displays new events when they are posted. For more information about the News Reader
part, see News Reader on page 137.

d. In the Description field, enter a description for news readers about the types of events
posted on the calendar. For example, if your organization supports the environment, enter
“Upcoming Local and National Events Supporting the Environment.”

e. In the Copyright field, enter a copyright notice for the weblog, if you have one.

f. In the Editor’s email field, enter the email address for the person responsible for the content
of calendar postings.

g. To approve weblog posts before they appear on your site, select Moderated.

7. To add a picture to the calendar weblog, click Select Image under Image properties. The
Select Image from Image Library screen appears. For information about how to insert an
image, see the Program Basics Guide.

8. In the Link URL field, enter the web address to open when a user clicks the image. The link can
access another page on your site or an outside website.

9. Under Security rights, define the roles with post and manage rights for the published events.

a. In the Post column, select the checkbox to assign post rights for users and roles allowed to
post to the weblog. This does not include rights to edit or delete postings.

Note: If the list is marked Moderated, posts are pending until a user with Manage rights approves
them. A user with Post rights views his or her pending posts, but not those of other Post users. Only
users with Manage rights view all pending posts.

b. In the Manage column, select the checkbox to assign manage rights for users and roles
allowed to add, edit, and delete weblog postings. If the list is marked Moderated, this
grants rights to approve postings.

c. To include additional users and roles, select Add users and roles.
10. Click Save. You return to Parts.

News Page Elements
When you add a News page element type to a personal page, users can include news on their page.
For example, a user who is ill creates a personal page that contains a News page element part. She can
write her own news article about her sickness for the personal page, or she can include links to news
articles from other websites to create awareness about her type of sickness.

Design News for Page Elements
For information about page element parts, see Page Element Types on page 139.

PARTS 147



1. From the Design tab, select “News” in the Display As field.

Note: You can include the News page element in Chapter or Personal Page Elements parts.

2. In the Display Name field, enter a name for the news section on the page.

3. Under Details, in the Title field, enter a title for your news weblog. This name appears on the
personal page.

a. In the Link URL field, enter the website link that news readers such as NewsGator use to link
to your site. This link should direct the website user to your news weblog or a general
information page about your organization.

b. In the Description field, enter any additional information as required. For example, if your
organization supports the environment, enter “Check weekly for updates.” To view the
information you enter in this field, click XML for the weblog. For this example, the XML
information for your description reads “<description>Check often for weekly
updates</description>.”

c. In the Copyright field, enter a copyright notice for the news, if you have one.

d. In the Editor’s Email field, enter your email address or the person who is responsible for the
content of your weblog.

4. Under Image Properties, click Select Image to add a picture. The Select Image From Image
Library screen appears. For information about how to insert an image, see the Program Basics
Guide.

5. In the Link URL field, enter a link to another website so you can share valuable information
from that website with your site users.

6. Under Security Rights, to assign your website members rights to edit the news weblog posts,
select Allow members to add, edit, and delete posts?

7. Click Save. You return to Parts.

News Reader Page Elements
With the News Reader page element type, you can display Really Simple Syndication (RSS) content or
Atom content on personal pages. These are XML-based formats used to distribute web information.
For example, if your organization is health related, users can create a personal page for health tips and
include a News Reader part that displays news headline feeds from other health related sites. With RSS
or Atom and the News Reader part, you can include these headlines on personal pages automatically.

Design News Reader for Page Elements
For information about page element parts, see Page Element Types on page 139.

1. From the Design tab, select “News Reader” in the Display As field.

Note: You can include the News Reader page element in Chapter or Personal Page Elements parts.

2. In the Display Name field, enter a name for the news reader section on the page.
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3. In the Feed URL field, enter the website address that contains the XML content to display on
your website. Typically, sites that share this content display an orange XML icon that is a
hyperlink to their website’s feed.

Note: The website supports RSS versions 0.9, 1.0, and 2.0, and Atom version .3.

4. In the Display only the [ ] most recent articles field, enter the number of recent articles to
display on your news reader. For example, to display five articles, enter “5.” To display all
recent articles, leave the default “0” in the field.

5. To display the XML content on multiple pages, select Use paged output, with [ ] articles per
page. In the field, enter the number of items per page.

If you do not select this checkbox, the articles display on one web page.

6. To display only the article title, select Display only the headlines in this feed.

If you do not select this checkbox, the complete article appears on the news reader.

7. To display the graphic associated with the website feed, select Display any graphic
associated with this feed.

8. To include the date the feed posts to your website, select Display the date for each posting,
if available.

9. For a website that requires authentication to access its XML content, enter the authentication
information under News Reader Authentication.

a. In the Type field, select the authentication type that the news feed provider requires.

Note: Basic authentication does not encrypt the user name and password and sends these credentials
over the network in plaintext. Digest authentication encrypts the user name and password and does
not send them over the network in plaintext.

b. In the Username and Password fields, enter your authentication information. To display XML
content that requires authentication, you must have a user name and password with the news
feed provider.

10. Click Save. You return to Parts.

Page Links Page Elements
For users who have multiple personal pages, you can add Page Links to a personal page element to
create a list of links to the personal pages that are public.

Design Page Links for Page Elements
For information about page element parts, see Page Element Types on page 139.

1. From the Design tab, select “Page Links” in the Display As field.

2. In the Display Name field, enter a name for the personal page element.

3. In the CSS box, enter Cascading Style Sheets (CSS) text to override the default style of this
element.
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Use CSS text to create unique elements, such as a border around an image. CSS is easier to use
than other methods, such as HTML. Unless you specify a custom style sheet, your website uses
default style sheets.

For more information about CSS, see the Website Design Guide.

Note: You can include the Page Links page element in a Personal Page Elements part.

4. In the Default Title field, enter a default title for the list of links.

5. Click Save. You return to Parts.

Photos Page Elements
To upload graphics for a personal page, create a Photos page element. You can upload graphics for
individual use on a personal page, or you can upload a series of graphics to create a slideshow. Your
organization can upload all the graphics for personal pages and allow a user to select the images she
wants, or you can allow a user to upload an image of her choice. When you create a Photos page
element, you must select a default image to appear on the page. If a user does not upload an image to
the Photos part on her personal page, the default image appears.

Design Photos for Page Elements
For information about page element parts, see Page Element Types on page 139.

1. From the Design tab, select “Photos” in the Display As field.

Note: You can include the Photos page element on a Chapter or Personal Page Elements part.

2. In the Display name field, enter a name for the photos section on the page.

3. In the CSS box, enter Cascading Style Sheets (CSS) to override the default style of this
element.

Use CSS to create unique elements such as a border for images. CSS is easier to use than other
methods such as HTML. Unless you specify a custom style sheet, your website uses default
style sheets.

For information about style sheets, see the Website Design Guide.

4. Upload each image.

a. Under Details, click Add Image. The Select From Image Library screen appears. For more
information about how to upload an image, see the Program Basics Guide.

b. To designate the default image that appears when users do not select one, select Default.
5. Under Slideshow Options, select whether to allow website users to add slideshow captions,

enter a default caption, and enter how long to display images during the slideshow.

6. Under Image Options, enter the maximum dimensions for a slideshow image in the
Maximum height/width field. This limit defines the height and width of the boundary that
contains images but does not directly alter the size of images.

Warning: An image’s number of pixels cannot exceed the number you enter in the Maximum
height/width field. For example, if you have an image that is 200 pixels and set this boundary to

150 CHAPTER 1



500 pixels, the image does not increase to 500 pixels. Conversely, if you have an image that is 500
pixels and set the height/width size to 200, the image shrinks to fit that boundary.

7. In the Image tags field, select the tags to associate with images. Tags are keywords or phrases
to identify an image’s content. To create a tag for slideshow images, enter it in the And/or
new tag field. For more information about tags, see Tags Tab on page 23.

8. Click Save. You return to Parts.

Profile Page Elements
To allow personal page owners to create profiles of the individuals who visit their personal pages, add
a Profile page element to a Personal Page Element part.

Design Profile for Page Elements
For information about page element parts, see Page Element Types on page 139.

1. From the Design tab, select “Profile” in the Display As field.

Note: You can include the Profile page element in a Personal Page Elements part.

2. In the Display Name field, enter a name for the profile section on the page.

3. To format the email content’s appearance and layout, use the HTML editor. For more
information about the HTML editor, see the Program Basics Guide.

4. Click Save. You return to Parts.

Rich Text Page Elements
To add a hypertext link, a remote photo hosted on another server, or formatted text to a personal
page, create a Rich Text page element. When you add include the Rich Text page element, remember
that it provides a lot of power to the owner of the page. The program automatically removes IFRAME
and SCRIPT tags from Rich Text page elements, but the potential remains for site abuse. With a Rich
Text page element, page owners can link to or display inappropriate content. However, visitors of the
page cannot edit the page element. When you use the Rich Text page element for remote photos, you
can only link to an existing image URL. You cannot upload images.

Design Rich Text for Page Elements
For information about page element parts, see Page Element Types on page 139.

1. From the Design tab, select “Rich Text” in the Display As field.

Note: You can include the Rich Text page element in a Chapter or Personal Page Elements part.

2. In the Display Name field, enter a name for the rich text section on the page.

Note: Details are not available for the Rich Text page element because it is not editable for visitors of
the personal page.

3. Click Save. You return to Parts.
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Text Page Elements
To allow users to enter general content text on a personal page, create a Text page element.

Design Text for Page Elements
For information about page element parts, see Page Element Types on page 139.

1. From the Design tab, select “Text” in the Display As field.

Note: You can include the Text page element in a Chapter or Personal Page Elements part.

2. In the Display Name field, enter a name for the text section on the page.

3. In the CSS box, enter Cascading Style Sheets (CSS) text to override the default style of this
element.

Use CSS text to create unique elements such as colors, fonts and styles, and spacing for your
part. CSS is easier to use than other methods, such as HTML. Unless you specify a custom style
sheet, your website uses default style sheets.

For more information about CSS, see the Website Design Guide.

4. Under Details, in the Maximum Length field, enter the maximum number of characters for
the customizable text.

5. In the Default box, enter any default text to include in the part, such as a welcome message.
The maximum number of characters count includes the text you enter in this field.

6. Click Save. You return to Parts.

Page Sharing
To allow website users to easily notify others about content on a web page, add a Page Sharing part to
a layout or template. Using this part, website users can use content sharing services such as Digg or
delicious to send a link to a web page to others and help promote your website. On your website, the
website user selects the sharing service from the page sharing caption and enters information about
the sender and recipient and a personal message for the recipient.

Warning: To prevent website users from sharing content that recipients may not be able to view, we
recommend you not add the Page Sharing part to pages that require specific security or contain
dynamic content such as Directory part search results.

Design Page Sharing
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Content sharing services, select each social networking method,
such as Digg, that website users can use to share content on the web page.
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2. Under Page Sharing caption, enter a caption to appear with the links that website users click
to share the web page.

Note: By default, the page sharing caption is hidden. To display the caption, you must edit its classes
in Style sheets. For information about how to style the caption, see Page Sharing Caption Styles on
page 153.

3. Click Save. You return to Parts.

Page Sharing Caption Styles
By default, the page sharing caption is styled to be invisible on your website. To display a caption that
website users can expand to display the selected sharing services, you must edit its classes in Style
sheets. In Style sheets, you can also specify whether the services appear horizontally or vertically.

Adjust the style sheet to display the page sharing caption
1. From Site explorer, click Style sheets. Style sheets appears.

2. Select a style sheet and click Click here to edit this style sheet under Action. The Style sheet
text editor screen appears.

3. To load the Page Sharing CSS selectors that allow you to edit the appearance of the part on
your web pages, click Insert CSS selectors. The Insert CSS Selectors screen appears.

4. In the Insert selectors for field, select Page Sharing. To include the Page Sharing default style
settings along with the names, select Include defaults.
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5. Click Insert. You return to the style sheet editor, and the Page Sharing selectors appear in a
new section within the editor.

6. Enter the styles to display the caption users can expand and collapse.

a. Under .PageSharingLink, enter display:block.

b. Under .PageSharingLinkImage, enter display:block.

c. Under .PageSharingList, enter display:none.

7. By default, when website users expand the list at the caption, sharing services appear
horizontally. To display the sharing services vertically:

a. Under .PageSharingListItem, enter float:none.

b. Under .PageSharingListItemLinkImage, enter float:none;display:inline.

8. To apply your changes, click Apply. The styles apply to all layouts, templates, and web pages
that use the style sheet.

9. To save your changes, click Save. You return to Style sheets.

Payment
With the Payment part, website users can pay for multiple transactions with a single charge. For
example, when a user registers for an event or makes a donation, the program adds the transactions to
a payment page. If the user leaves the website without paying, the transactions remain on the payment
page. To clear unpaid payment pages that have not been modified within a specified time period, you
can set an expiration date.

Note: Anonymous website users can create payment pages. When an anonymous user adds a
transaction to a payment page, the page remains after the user leaves the website. To identify
anonymous users, the program uses cookies. To access a payment page, an anonymous user must use
the same computer used to add the transactions. If multiple anonymous users add transactions from
the same computer, the program adds the transactions to the same payment page.

You can use a payment page with the Donation Form and Event Registration Form parts. Before you
can add a payment page to these parts, you must add a Payment part to a web page. To add a
payment page to these parts, you select a web page with the desired Payment part. For information
about the Donation Form part, see Donation Form on page 60. For information about the event
registration form, see Event Registration Form (Classic) on page 107.

When you add a payment page to a donation form or event registration form, the user does not
proceed directly to payment. Instead, the program adds items to the payment page. When the user
clicks Continue on the form, the payment page appears with the new item. The Payment part
determines the available payment methods and the merchant account. To provide a link on your
website for users to access payment pages without adding items, use the Payment Summary part. For
information about the Payment Summary part, see Payment Summary on page 157.

Note: To design, style, and test a part on your website without creating transactions, generating
emails, or communicating in any way with Blackbaud Services or Blackbaud CRM, select Test Mode
on the Properties tab. For example, you can complete the fields on a Payment form to ensure the
confirmation page is styled and working properly. Although you submit the payment and receive a
confirmation, a transaction does not appear on the Web Transactions page in Blackbaud CRM. Use
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Test mode to verify the user’s experience, not to test data processing. Test mode does not validate
credit card numbers and merchant accounts. Only users with supervisor rights can view parts in Test
mode.

Design Payment
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

Note: If you are using multicurrency and browser/regional settings, prices are displayed on the
form in both the base currency for the database and the regional currency based on the browser
settings.

1. From the Design tab, under General, set an expiration date for payment pages.
• To clear unpaid payment pages that website users have not modified, select Clear unpaid

transactions and enter the number of days to wait before you clear the pages.
• To keep all payment pages regardless of when last modified, select Never clear unpaid

transactions.

2. Select when to display the payment form for users to enter payment information.
• To display the payment form on the payment page, select Display the payment form

immediately.
• To display the payment form on a separate page, select Display the payment form after

clicking ‘Checkout’.
3. You can determine if a donor receives a summary email to acknowledge one or more

payments made with this Payment part or individual acknowledgement emails for each
payment.

• To send a summary acknowledgement email for donations and event registrations a donor
pays for with this Payment part, select Send summary acknowledgement email.

Note: From a Donation or Event Registration part, you can choose to always send the
acknowledgement email defined for the part. If you add a Payment part with Send summary
acknowledgement email selected to one of these parts, the donor receives the acknowledgement
email you designed for the donation or event registration, as well as the summary acknowledgement
email you defined for the Payment part.
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• To send donors an acknowledgement email for each payment, select Send the
acknowledgement email defined for Donations or Event Registrations that use this
payment part.

4. Under Required Fields, select the checkbox for each donor field to make required on the
payment page. To ensure you download complete constituent information, we recommend
that you make all these fields required.

Tip: We recommend you include Middle name so your organization meets the Canadian Revenue
Agency's requirements for donation receipts.

5. Under Payment Methods, select the payment methods to offer to website users.

6. Under Merchant Account, select the merchant account to use to process credit cards. For
example, select your IATS account. The system administrator sets up merchant accounts in
Administration. For information, see the Administration Guide.

7. Click Next. The Acknowledgement Email screen appears.
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8. Create an acknowledgement email for website users who make a payment with this Payment
part. You can use the default text provided or enter different text. For information about how
to design an email acknowledgement, see the Email Guide.

Note: You must select Send summary acknowledgement email under General for donors to receive
the summary email you create for the Payment part. For information about how to send both a
summary and individual acknowledgement emails, see the Email Guide.

The summary acknowledgement email includes loop merge fields for donations and event
registrations. For information about how to use loop merge fields, see Event Registration
Loop Merge Fields on page 115.

Tip: When you edit a Payment part, you can click Acknowledgement Email to access the
Acknowledgement Email screen. For information about how to create this email message, see the
Email Guide.

9. Click Save. You return to Parts.

Payment Summary
With the Payment Summary part, website users can view useful information about their payment
pages. The payment summary can display the number of items on a payment page and the total cost
for the items. It can also provide a link to view the payment page and pay for transactions. When you
add a link and place the summary on a page template, a website user can access the payment page
from any web page that uses that template. You can also use merge fields to create two versions of the
summary: one for an empty payment page and one for a page with transactions.
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When you create a payment summary, you select a Payment part to connect to the summary. For
information about the Payment part, see Payment on page 154.

Design Payment Summary
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

Note: If you are using multicurrency and browser/regional settings, prices are displayed on the
form in both the base currency for the database and the regional currency based on the browser
settings.

1. From the Design tab, in the Payment part field, select the Payment part to connect to the
summary.

2. Under Display text, enter the text to appear in the payment summary. You can use merge
fields to display the number of transactions on a website user’s payment page and the total
cost, as well as to provide a link to the page. You also can use merge fields to create
conditional statements that appear according to whether the payment page contains
transactions. To format the content’s appearance and layout, use the HTML editor.

For more information about the HTML editor, see the Program Basics Guide.

3. Click Save. You return to Parts.

Payment 2.0
With the Payment 2.0 part, website users can pay for multiple transactions with a single charge. For
example, when users register for events or make donations, the program can add the transactions to
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their shopping carts. If users leave the website without paying, the transactions remain in the shopping
carts.

Note: Website users who do not log in to your site can still add items to shopping carts. To identify
these anonymous users, the program uses cookies. To return to their shopping carts, users who did
not log in must use the same computer as when they added transactions. If multiple users add
transactions from a computer without logging in, the program adds all the transactions to a single
shopping cart.

The Payment 2.0 part shopping cart can process transactions for the following parts. It cannot process
transactions from other sources.

l Advanced Donation Form

l Donation Form

l eCards

l Event Registration Form

l Membership

l Transaction Manager (for unpaid event registrations only)

l Sponsorship Form

After you place the Payment 2.0 part on a web page and route transactions to the shopping cart for
other parts that integrate with Payment 2.0, the parts then send users to the shopping cart during
transactions and the Payment 2.0 part determines the merchant account and available payment
methods. After users add items to the shopping cart, they can click links to edit individual transactions.
When users pay with credit cards, the program collects user information on secure payment pages to
help you comply with the Payment Card Industry Data Security Standard (PCI DSS).

Design Payment 2.0
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

Note: If you are using multicurrency and browser/regional settings, prices are displayed on the
form in both the base currency for the database and the regional currency based on the browser
settings.

1. From the Design tab, under General, enter how long to maintain shopping carts for users who
add transactions but do not log in to your website.

Warning: If you enter “0” in the Days to keep anonymous carts field, the program does not
maintain cookies to identify users who are not logged in. If one of these anonymous user adds
items to a shopping cart and does not check out, the user cannot return to the cart later.
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Depending on the browser, the cart is cleared either when the browsing session times out or when
the user closes the browser.

For registered users on your website, the Payment 2.0 part maintains shopping carts until they
process the items in their carts. However, the program can remove individual items such as
event registrations when the parts place time limits on how long the items can remain in
shopping carts.

2. Under Confirmation screen, design the payment summary that appears after user check out in
the shopping cart.

In the HTML editor, enter content for the payment summary and format the appearance and
layout. To include personalized information, use merge fields. To remove the changes you
make to the default confirmation screen, click Load Confirmation Template.

For more information, see the Program Basics Guide.

3. Under Required Fields, select the checkbox for each field to make required on the payment
form. To ensure you download complete constituent information, we recommend that you
make all these fields required.
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4. Under Additional fields, select the additional fields to include on the payment page.

a. In the Include column, select the checkbox for each additional field you want to appear on
the payment page. If you require a field, you must also include it.

b. In the Required column, select the checkbox for each additional field website users must
complete to submit their payments.

Tip: We recommend you include Middle name so your organization meets the Canadian Revenue
Agency's requirements for donation receipts.

5. To enable users to specify their consent preferences for how they want to receive
communication from your organization:

a. Under Consent part, select a saved Communication Consent part to include on the form.

b. Select how you want the communication preference options to display — choose Inline to
embed the options directly in the form itself or choose Overlay to display a pop-up window
with the consent options when the form is submitted.

After users submit the form, their consent information is downloaded along with their
transaction. After the appropriate batch is committed, their constituent record is updated on
the Communications > Preferences tab in Blackbaud CRM with their communication
consent preferences.

6. Under Payment methods, select the payment methods to offer to website users. You can
allow users to pay with credit card and direct debit, or to make pledges to pay later.
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Warning: If you select Direct debit only, the Payment 2.0 part cannot process event registrations
because the Event Registration Form part does not accept direct debit payments. You must either
select an additional payment method or direct event registration transactions to a different
Payment 2.0 part.

Note: To help you comply with the Payment Card Industry Data Security Standard (PCI DSS), the
Payment 2.0 part directs users who pay with credit cards to the secure payment page to process
payments. It does not direct users to this page when they make pledges or pay with direct debit.
For information about the secure payment page, see Secure Payment Page on page 165.

7. In the Merchant account field, select the merchant account to use to process credit card
transactions. For example, you can use your organization’s Blackbaud Merchant Services
account. The system administrator sets up merchant accounts in Administration. For more
information, see the Administration Guide.

Warning: If you create multiple Payment 2.0 parts for your website, you should use the same
merchant account for each part. If you use multiple merchant accounts and users purchase items
through more than one Payment 2.0 part, the program processes all items with the merchant
account for the last item. If you set up merchant accounts for different currencies, this means users
may pay for some items with the wrong currency.

8. Under Additional payment fields, select whether to include reCAPTCHA on the form. When
you select this option, a reCAPTCHA checkbox displays below credit card payment fields on
your Blackbaud Secure Payments form. Users must select the reCAPTCHA checkbox before
they can submit the form.
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9. Under Registration options, select the transaction types that require users to log in before
check out.

In the User login page field, select a page that includes the User Login part so users can log in
to your site. We recommend the part does not enable New user registration. For more
information about the User Login part, see User Login on page 248.

Note: If you select Sponsorships and new users register during sponsorship transactions, the
program automatically creates constituent records in Blackbaud CRM. You do not process the
signup transactions in batches because all sponsorship transactions are written directly to the
database, including signup transactions. To link new website users to their constituent records, you
must have a default batch assignment setting for new user registrations in Blackbaud CRM. If not,
new website user are not linked to constituent records.

When you require this, a message appears during check out to inform users they must log in.
To do this, users click Continue and the user login page appears. Community members log in
to your site with existing credentials and non-community members create a new user account.
After the log in is complete, the program returns the user to the payment page to complete
the check out.

Tip: To change the require message and Continue button text, select the Language tab. For more
information about this tab, see Language Tab on page 17.

10. Click Next. The Acknowledgement email section appears.
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11. Enter a name for the acknowledgement, a subject, and an address and name to include in the
From field of the email message.

12. To receive responses from recipients at a different email address than the one you use to send
the message, enter the return address in the Reply Address field.

13. Under Notifications are to be sent to the following addresses, select Failures to receive
failure messages for email messages that are not delivered. In the field beside the checkbox,
enter an email address to receive failure messages.

Note: Failures are email addresses that do not receive the acknowledgement email. Failures can
also be called non-delivery receipts, bouncebacks, UnDeliverables, or Delivery Status Notifications
(DSN).

14. In the HTML editor, enter content for the acknowledgement email message and format the
appearance and layout. To include personalized information, use merge fields.

For more information, see the Program Basics Guide.
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Note: You design acknowledgement messages for each part that routes transactions to a shopping
cart. To include all these acknowledgements messages in the email message you design for the
Payment 2.0 part, use the Acknowledgement Block merge field. For example, you can add the
merge field to a Payment 2.0 part acknowledgement email message and then route transactions to
the part from Donation Form parts. After website users check out, they receive a single Payment
2.0 acknowledgement email that includes acknowledgment messages from the Donation Form
parts. You can also use this merge field on the Payment 2.0 part’s confirmation screen.

15. Click Save. You return to Parts.

Secure Payment Page
To help you comply with the Payment Card Industry Data Security Standard (PCI DSS), the program
uses a secure payment page to process biographical billing information and payment information for
the Advanced Donation Form, Event Registration Form, Membership Form, and Payment 2.0 parts. The
program also uses it to secure credit card updates for the Transaction Manager part. Users enter the
information on a secure payment web page that is hosted on a separate Blackbaud server from your
website.

Note: Whether you host your site or Blackbaud hosts your site, the secure payment page on the
hosted Blackbaud server processes credit card payments only.

When a user submits a credit card payment on the Payment 2.0 part, the user navigates through a series
of pages. First, a user enters the amount and biographical information on your site. When the page is
complete, the user clicks Check out.
The program uses the style sheet, layout, template, and page for desktop browsers and mobile devices
to display the secure payment page on the Blackbaud server. On this page, the user enters billing and
payment information, such as credit card details.

Note: Your organization can use the Template 1.0 static page or Template 2.0 responsive page for
your secure payment page. However, if you are using the static page, we recommend you upgrade to
the responsive page to provide an optimal experience for website users on various devices. For
information about upgrading an individual static secure payment page to a responsive one, refer to
the Website Design Guide. For information about upgrading all static secure payment pages, across all
of your websites at the same time, refer to the Administration Guide.

To complete the transaction, the user clicks Pay now. The secure payment page uses Blackbaud
Payment Service to transmit the users’s information and process the credit card transaction. For more
information about Blackbaud Payment Service, see the Payment Application Data Security Standards
Implementation Guide.

Warning: Your code tables in Blackbaud CRM for countries and their subdivisions, such as states and
provinces, must follow the International Organization for Standardization’s ISO 3166 standards. The
secure payment page uses ISO 3166-1 for countries and ISO 3166-2 for subdivisions such as states. If
your code tables do not match these standards, Blackbaud Secure Payment changes selections to the
closest abbreviation when it processes transactions, and this can lead to incorrect address
information. For example, if your countries table includes “United Kingdom,” The secure payment
page changes this to the United States abbreviation “US” because it is the closest abbreviation to
“Un.” In ISO 3166-1, the abbreviation for the United Kingdom is “GB,” and your code table must
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match this. For information about how to edit your code tables in Blackbaud CRM for countries and
their subdivisions, see the Administration Guide.

The user returns to your site and your confirmation page appears.

Secure Payment Page: Important Considerations
There are several important items to remember about the secure payment page for the Payment 2.0
part. The secure payment page uses your style sheets, layouts, templates, and pages for desktop
browsers and mobile devices to render the page. Make sure you consider this information to enhance
accessibility for both options.

l When you use the same Payment 2.0 part on two web pages that use two different templates,
the secure payment page renders using the template for the page the website user navigates
from. For example, your payment page for an event registration uses a template with a red
background and your payment page for a donation uses a template with a blue background.
When a user navigates from the event registration payment page to the secure payment page,
the page renders using the red template. When a user navigates from the donation payment
page to the secure payment page, the page renders using the blue template.

l Some parts, such as Formatted Texts & Image and Menu, appear on the secure payment page.
Images also appear. However, you may notice that some parts, including Unformatted Text, do
not appear on the page.

l When you include targeted content on your page, be aware that it does not apply to the secure
payment page. No matter the role the user is in, the secure payment page renders the view for
an anonymous user the same way your page appears for anonymous users. Anonymous users are
users not logged in to your website.

l We recommend you remove parts that contain a Flash file. These files include JavaScript that the
secure payment page removes for PCI DSS compliance. If you do not remove the part, an Adobe
download message likely appears in its place on the secure payment page.

l Likewise, we recommend you remove graphics that include JavaScript. The secure payment page
removes these graphics for PCI DSS compliance. If you do not remove the graphic, the page
likely renders incorrectly.

l We recommend you remove third-party social media sharing widgets from your page. These
links typically include JavaScript that the secure payment page removes for PCI DSS compliance.

l External style sheets including those you import in Stylesheets do not appear. Only styles from
the default style sheet or inline on a part appear.

l To enhance performance between your site and Blackbaud's server, the program holds design
and property updates you make to the style sheet, layout, template, and page for your payment
page in a queue. When this content remains static for five minutes, the updates push to the
Blackbaud server within one hour. You cannot change this process. However, you can click
Update templates in Sites & settings to manually update the changes for your secure payment
page. For more information, refer to the Administration Guide.

l A generic template exists for the secure payment page. It is unlikely you want to use it because it
does not match the rest of your website. However, Flash and JavaScript content does not upload
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to the secure payment page for PCI DSS compliance. If your page, template, or layout includes
this content and the absence of it heavily impacts the appearance of your secure payment page,
you may want to use the generic template. You can also use the generic template if you need to
temporarily revert your template updates to the page. When you are ready to use your template
again, you select Enable secure payment template updates and click Update templates in
Sites & settings. For more information, refer to the Administration Guide.

Note: The program does not send updates to the Blackbaud secure payment server for Advanced
Donation Form, Event Registration Form, Membership Form, and Payment 2.0 pages that do not
accept credit cards, and Transaction Manager pages that do not allow payment type changes for
recurring gifts.

Secure Payment Page: Transaction Processing Safeguards
When users navigate from the Payment 2.0 web page to the secure payment page and an interruption
unexpectedly occurs before the transaction is submitted, your payment processor receives the
payment and the information from the Payment 2.0 web page creates a transaction to process in
Blackbaud CRM.

Tip: An interruption can occur when your website server refreshes while a user attempts to submit a
transaction. An interruption can also occur when a user leaves your secure payment page for a time
that exceeds the session login and then returns to the page and submits the transaction.

To support this functionality, a database process checks the CMS_SessionVariableBackup table for data
every 24 hours. After Blackbaud Internet Solutions submits the data to Blackbaud CRM, it no longer
exists in the table. The remaining data stays in the table for 30 days unless your system administrator
changes the UnprocessedBBSPTransactionLifeSpanInDays web.config setting to increase or decrease
the number of days. For example, to increase the number of days to 60, enter
UnprocessedBBSPTransactionLifeSpanInDays = 60 in the appSettings node of web.config.

Note: The remaining data in the table likely exists because users entered payment information on the
secure payment page, but did not submit the transactions. For PCI DSS compliance, the table does
not include credit card information. Your system administrator can access the table to provide you
with a list of these users so you can follow up with them.

Your system administrator can also use the ArchiveUnprocessedBBSPTransactions web.config setting to
specify whether the process should move the remaining data from the table to the CMS_
UnprocessedBBSPTransaction archive table in the database, or to delete it permanently. For example,
to move the data to the archive table, enter ArchiveUnprocessedBBSPTransactions=True in the
appSetting node of web.config. Otherwise enter False.

Payment Summary 2.0
Payment Summary 2.0 part works with Payment 2.0 parts to provide website users a summary view of
their payments. The payment summary can display the number of items on a payment page and the
total cost for the items. It can also provide a link to view the payment page and pay for transactions.
You can also include a summary grid that lists the items added to the cart and provides a brief
description of each. When you add a link and place the summary on a page template, a website user
can access the payment page from any web page that uses that template. You can also use merge
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fields to create two versions of the summary: one for an empty payment page and one for a page with
transactions.

When you create a payment summary, you select a Payment 2.0 part to connect to the summary. For
information about the Payment 2.0 part, see Payment 2.0 on page 158.

Design Payment Summary 2.0
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

Note: If you are using multicurrency and browser/regional settings, prices are displayed on the
form in both the base currency for the database and the regional currency based on the browser
settings.

1. From the Design tab, in the Payment 2.0 part field, select the Payment 2.0 part to connect to
the summary.

2. To include a summary grid that lists the items in the shopping cart, select Include shopping
cart summary grid. The grid appears below the payment summary content.
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3. Under Payment summary content, enter the text to appear in the payment summary. You can
use merge fields to display the number of transactions on a website user’s payment page and
the total cost, as well as to provide a link to the page. You also can use merge fields to create
conditional statements that appear according to whether the payment page contains
transactions. To format the content’s appearance and layout, use the HTML editor.

For more information about the HTML editor, see the Program Basics Guide.

4. Click Save. You return to Parts.

Personal Notes
With the Personal Notes part, you can allow website users to share their stories with your organization.
This part allows website users to communicate life changes, narratives, or other personal information
through your website.

When you create the part, you designate a redirect page to appear after website users submit notes,
and you select the note types from Blackbaud CRM that they can select when they submit personal
notes.

To submit personal notes, website users must log in to your Blackbaud Internet Solutions site. When
users submit notes, the part saves the notes directly to their constituent records in Blackbaud CRM.
These personal notes from your website appear on the Documentation tab along with any notes that
you entered directly in in Blackbaud CRM.

In Blackbaud CRM, you can create constituent queries to monitor the personal notes that website users
submit. The Online Information node under Notes includes Page ID and Page name fields that are
associated with personal notes from your website. For information about how to create a query, see
the Blackbaud CRM Query and Export Guide.

Design Personal Notes
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, select a redirect page in the Redirect page field. After website users
submit personal notes, the part sends them to this page.
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2. Under Note types, select the types of personal notes that users can submit. Under Available, all
of your active note types from Blackbaud CRM appear. Use the arrow buttons to add or remove
note types from the list that users select from on your website.

Users select note types from a dropdown list on your website. If you only include one note type
on the part, the field does not appear because that note type is selected by default.

Tip: You can use the Language tab to edit the privacy statement that appears at the bottom of
the Personal Notes part by default, as well as other labels on the part. For information about the
Language tab, see Language Tab on page 17.

3. Click Save. You return to Parts.

Poll
Use the Poll part to create a simple poll or survey. A poll may ask a trivia question or who users predict
to win a race. After a website user submits an answer, the program calculates the poll results and
displays them on the site.
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With the Poll part, you can enter your poll or survey question, the text to display on the submit button,
whether to use a pie chart or bar chart to display the results, and, if required, the possible answers for
the poll or question. To prevent skewed polling results, these fields are disabled after a website user
responds to a poll.

Design Polls
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Title field, enter a title for the poll.

2. In the Question Field, enter the question for the poll.

3. In the Submit button text field, enter the text to appear on the button users click to submit
their answer.

4. In the Chart type field, select “Pie Chart or “Bar Chart.”

5. Poll responses are limited to 255 characters. If you expect long poll answers, we recommend
you enter a pixel (px) size in the Chart image width field. If you enter an image width less
than a poll response, the response is truncated in the image. To correct this, adjust the pixel
size in the Chart image width field.

6. Under Poll answers, for each answer for the poll response, enter the answer in the Answer
field and click Add. The box displays the answers entered for the poll response.

7. Arrange the order of the answers as they should appear on your website.
• To adjust the position of an answer in the order, select it and click Move up or Move down.
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• To remove an answer from the box, select it and click Remove.
8. Click Save. You return to Parts.

Profile Display
Use the Profile Display part to display a read-only profile page for website users to view profile details
about an individual or organization. You select the fields to include in the profile display. For example,
for an individual, you can display biographical, address, and contact information about the user. You
can also create separate Profile Display parts for individual constituents, organization constituents, and
user networking groups.

Note: The Profile Display part displays profile information the user enters on a Profile Update Form.
For information about how to create an editable profile form, see the Forms Guide.

You can use the Profile Display part to display information for only the logged-in user or to link to a
directory so it displays information for any person or organization selected in the directory. For more
information about directories, see Directory on page 47.

Warning: You cannot use HTML to embed your own form via HTML in a Profile Display part. We
recommend you put the form on a page that is not stored online but can be referenced in an
<iframe> element tag. For more information about how to include customized forms on the website,
contact Blackbaud’s Professional Services at solutions@blackbaud.com.

Warning: You cannot use HTML to embed your own form via HTML in a Profile Display part. We
recommend you put the form on a page that is not stored online but can be referenced in an
<iframe> element tag. For more information about how to include customized forms on the website,
contact Blackbaud’s Professional Services at solutions@blackbaud.co.uk.

Design Profile Display
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Source field, select the profile type to appear when the website
user clicks the link.

• “Current User” — Select this to display the profile for the logged-in user.
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• “Directory” — Select this if this profile part is added to a page linked to a directory. When a
profile is linked to a directory, users can click a field in the directory to display the profile for
the selected person. For more information about directories, see Directory on page 47.

2. In the Max height/width for full-size image field, enter the maximum display height and
width for full-size profile images that display when users click thumbnails on the web page.

3. In the Max height/width for thumbnails field, enter the maximum height and width for
profile image thumbnails on the web page.

Tip: When you leave the Max height/width for full-size image and the Max height/width for
thumbnails fields blank, the default size to display full-size and thumbnail profile images on a web
page is 200 px. To include profile images on the part, make sure you include the Profile image
merge field in the HTML editor design box.

4. On the HTML editor, select whether to create profile display content for an individual or
organization constituent or for a user networking group.

• To design content to appear for an individual constituent, select the Individuals tab.
• To design content to appear for an organization constituent, select the Organizations tab.
• To design content to appear for a group on your user networking site, select the Blackbaud

Internet Solutions group tab.
5. To enter and format the profile content’s appearance and layout, use the HTML editor. For

PARTS 173



more information about the HTML editor, see the Program Basics Guide.
• When you design content to appear for an individual or organization constituent, you can add

merge fields for personalized information to appear.
• When you design content to appear for a user networking group, you can add merge fields

for personalized information from the User Networking Manager part to appear.

Note: When a website user selects the Make my primary email address private checkbox on your
Profile Update Form web page, it also designates their primary email address as private for this part
on a web page. For more information, refer to Contact Information. When an email address does
appear on the Profile Display page, the email address merge field renders it as a link for users to click
to send a message to the address.

6. Click Save. You return to Parts.

Profile Form (Deprecated)
Note: The Profile Form part is now deprecated. While the deprecated part continues to operate for
backwards compatibility on your website, you can no longer create or copy Profile Form (Deprecated)
parts. Instead, you can use the Profile Update Form in Forms. It includes all the functionality of the
Profile Form (Deprecated) part, and its form designer supports greater flexibility for customization.
For example, you can use the form designer to insert instructional text, add steps, or rename button
labels.

With the Profile Form part, you can create profile forms for constituents and organizations to update
their biographical, address, and contact information. For example, Jane Compton is a member of the
Class of 1988. When she visits your website, she navigates to the user profile page and enters the
information you selected to appear on the individual Profile Form part, such as her full name, current
address, and spouse information. You can download the information she enters on your website to
Blackbaud CRM.

You select the fields of information to appear in each section of the form. The user can select whether
profile information is public (all users can view it) or private (only the user can view it). We recommend
you use the profile form on password-protected pages only.

Note: When users update their profiles, the changes appear in profile displays or directory listings
automatically, even before the changes are downloaded.

If a user is a relationship type with appropriate rights, he or she can edit profile information for an
organization. For example, you can specify that only constituents with a relationship type of
“Administrator” or “Primary Contact” can edit their organization’s profile.

Note: To edit an organization’s profile, in addition to the relationship type set on the Settings tab in
Sites & settings, the website user must be established as a contact for the organization in Blackbaud
CRM.

Design Profile Form
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.
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1. From the Design tab, under Select the type of constituents to use the Profile Form, select
either Individual or Organization.

2. Under Profile form options, in the After update navigate to field, browse to the web page
to appear after website users submit their profile information.

If you do not select a page, the profile form appears after users submit profile information.

3. If you select Organization, the Message to display when there are no organization records
box appears. In the box, enter the message to appear when website users who navigate to a
page with the profile form part do not have an organization record or are not a relationship
type with Edit Org Profile marked on the Settings tab in Sites & settings. For example, enter
“There are no organizations associated with your record.” For more information, see the
Administration Guide.

4. Add each section to the profile form as required.

a. In the Section field, select the type of section to add to the form. Fields appear in the grid
for the section type you selected.

b. In the Heading field, enter the text to appear at the top of the section. For example, for the
Bio section of an individual profile, enter “Personal Information.”
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To specify the order of sections, add a number to the beginning of each section heading. For
example, if you select “Preferred Address” in the Section field and enter “2. Preferred
Address” in the Heading field, the Preferred Address section appears second in the profile.

c. In the Fields grid, select the fields to include in the section and options for the fields.

Note: To protect user passwords, users cannot change their user IDs, passwords, or email addresses
on profile forms unless they confirm their passwords first. When users attempt to change the
Preferred Email field in the Phones and Email section or the User ID and Password fields in the User
Login section, a field requests their current password. Users must enter their passwords so that other
users cannot change their credentials or receive email messages with their unencrypted passwords.

Option Function

Include Select the checkbox next to each field to include in the profile display grid.

Field This column displays the fields from Blackbaud CRM you can include in the section.

Edit To allow the user to edit a field, select this checkbox. If you do not select this
checkbox, the field appears in the profile but the user cannot change its value.

Required To make a field required, select this checkbox. If you select this checkbox, the user
must select or enter a value for the field to complete the form.

Privacy edit To allow users to hide the content of a field, select this checkbox. For example, to
allow users to hide their birth dates on the profile display, select this checkbox for the
Birth date field. On the profile display, “{private}” appears when users hide the field.
For organizations, this column is disabled.

Note: By default, the Profile Form part uses privacy settings from Field Options to
determine whether to display content on the form display. After you process users
and they visit the profile display, the program locks in these default privacy settings,
and future changes in Field Options do not affect privacy settings for the users.
However, users can still change the settings for the fields where you select Privacy
edit.

Use code table If a field has code table values, this checkbox appears. If you select this checkbox, the
field on the form displays the code table values from Blackbaud CRM. If you do not
select this checkbox, the user must enter a value in the field.

Alternate caption To edit a field name, enter a new name in this column. For example, you can call the
Birth date field the Birth date (mm/dd/yyyy) field.

5. Click Save. You return to Parts.

Query Results Display
The Query Results Display part displays output from Blackbaud CRM ad-hoc queries. For example, you
can display a list of volunteer events that occur in the next 2 weeks. For some ad-hoc query types, you
can also display different ad-hoc query information for different contexts. For example, you can
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display a context-sensitive list of events on profile pages to allow users to view the events they
participated in on their own profile pages and the events that other users participated in on their
profile pages.

Design Query Results Display
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under General options, the Query type field, select the type of ad-hoc
query to display.

2. In the Query field, select the ad-hoc query to display. The available ad-hoc queries are those
saved in Blackbaud CRM.

Note: You can select any type of ad-hoc query to use with the Query Results Display part. For
example you can select a Volunteer or an Events ad-hoc query. Smart queries from Blackbaud CRM
are not available for use with this part.

3. In the Maximum number of results field, enter the maximum number of results to include in
the display. If you limit the number of results, they display faster on the web page.

4. In the Results per page field, select the number of results to display on a page. Select Show
pagination to include a Next button to allow users to click through the pages to view more
results. If you do not select Show pagination, only one page of results appears.

5. If your ad-hoc query contains record output fields, a Context filters section appears. This
section allows you to display different ad-hoc query information for different website users.
For example, if an event registration ad-hoc query includes the
Registrants\Constituent\Constituent record field, you can apply context filters to display
registration information based on the user who accesses a page or based on the user
associated with the page. To allow context sensitivity, select “Current registrant context” in the
Registrants\Registrants record field and then select the context in the
Registrants\Constituent\Constituent record field.

• Select “Current user” to display a logged-in user's registration information. Use this option to
display data that is relevant only to the logged-in user, such as events that the user registered
for, the cost of tickets, and seating assignments. You can select this option for any type of
page.

• Select “Current constituent context” to display registration information for the user associated
with a profile display page. Use this option to display public data. For example, you can
display the events that a user participated in when other users visit that user's profile display
page. Only select this option for profile display pages because context sensitivity doesn't work
for other pages.

6. Under Result summaries, design the ad-hoc query results display. Use merge fields to define
the ad-hoc query output to include. For certain types of ad-hoc queries, the text box includes
merge fields by default. To add merge fields, click Merge fields on the Insert tab in the
toolbar to open a screen where you can drag and drop fields into the text box. To select
additional merge field groups, click Advanced merge fields.
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To format the content’s appearance and layout, use the HTML editor. For more information
about the HTML editor, see the Program Basics Guide.

7. Click Save. You return to Parts.

Quick Search
To use the Quick Search part, you must have Microsoft Full-Text Search on your web server. If you do
not, the part does not appear in Parts. This part can search other parts: Formatted Text and Images,
Formatted Text and Images (Secured), Discussion Group, Event Calendar, Job Board, and Weblogs.

Note: You can select to install Full-Text Search when you install SQL Server. For general information
about Full-Text Search, see your SQL Server documentation.

Learn About Quick Search
The Quick Search part is a text box with a search button that appears on the web page for site users to
search for information. Due to its small size, it is useful to include on a web page template to add
search functionality on pages throughout your site. The search text box has a limit of 255 characters.
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Because the part does not have room to display search results, you must select a web page for the
results to appear on. The web page must contain a Search part. This part is large enough to display
search results similar to Google. The first line is a hyperlink to the web page. The next several lines
provide a preview of the text that contains the word or phrase a user searched on. Words or phrases
used in the search appear in bold.

Note: The primary difference between the Quick Search and Search parts is how results appear on
your site. With the Quick Search part, you select a web page for results to appear on. With a Search
part, results appear automatically below the Search part. You can add a Quick Search part to a web
page template; however, we recommend you not add Search parts to a template.

The parts available for a quick search are indexed by part. For example, a Formatted Text and Images
part contains “boy.” On the same page, a Discussion Group part contains “scout.” If a user enters “boy
scout” in the search field, results do not appear because the same part does not contain both words.

Warning: When the Quick Search part performs a search, it includes all pages on your website that
contain a searchable part. Therefore, the potential exists for search results to return unfinished web
pages. To prevent this, establish security to restrict the users who can view unfinished pages.

Note: When a user searches for a word or term on your website, search results include pages only.
Searches do not include templates or the parts on templates.

The Quick Search part uses “stem” search. When a user enter a word in the search field, the search
results include the word plus its plurals and verb tenses. For example, if a user searches for “run,” the
search results return parts that contain the words “run,” “ran,” and “running.” The search also accepts
certain operators and wildcards in the search text box. You can use the asterisk, quotation marks, and
the minus sign in the Quick Search part.

Operator Function

Asterisk (*) Begins with (For example, enter “donat*” to return
results such as donate, donating, donation.)

Quotation marks (“ ”) Whole phrases (For example, “Become a Member Now”
returns results that contain the entire phrase.)

Minus ( - ) All words in search box minus preceding word or words
(For example, “event registration -form” searches for
“event” and “registration,” but excludes results that
contain “form.”)

When a site visitor performs a search with the Quick Search part, security is upheld. For example, a web
page contains the Formatted Text and Images part with the phrase “Board Member Personal
Addresses.” Only users in the Board Member role with the applicable task rights can access this page.
When other users search for “board member + addresses,” the page is not returned.

For information about security, see the Users & Security Guide.

Design Quick Search
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.
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1. From the Design tab, under Results page browse to the web page to display search results.

2. In the Search button caption field, enter the text to appear on your search button, such as
“Go.”

If you do not enter text for the button in the field, the button does not appear on your site. To
process search results, site users press ENTER on the keyboard after they enter search
information in the text field.

3. Click Save. You return to Parts.

Record Display
Use the Record Display part to provide a detailed description of a record. For example, the Record
Search part displays a short description of each record included in the results. To provide a more
detailed description of the record, you can link from the search results to a page that contains a
Record Display part.

Design Record Display
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under General options, select the record type to display.

2. If you select “Constituent” for the record type, the Current User option appears. Select this
option to display data that is relevant only to the logged-in user, such as events that the user
registered for, the cost of tickets, and seating assignments. If you do not mark this option, the
part displays information for the user associated with a profile display page. Leave this option
unmarked when you need to display public data. For example, you can display the events that
a user participated in when other users visit that user’s profile display page. Select this option
only for profile display pages because the context sensitivity does not work for other types of
pages.

3. Under Record summary, design the search results display. Use merge fields to include
information about records included in the results.
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4. To select the merge fields to include, click Advanced merge fields. The Select Field Providers
screen appears.
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5. Select each group of merge fields to make available and click OK. You return to the Design
tab.

6. Click Merge fields on the Insert tab in the toolbar to select the merge fields to include.

To format the content’s appearance and layout, use the HTML editor. For more information
about the HTML editor, see the Program Basics Guide.

7. Click Save. You return to Parts.

Record Search
With the Record Search part, website users can enter key words or select search filters to search for
records. You can choose the type of filters available for the search and you can design the content for
the search results display. For example, you can create a search that allows users to search for events by
event name, date, and location.

The search results include a short description of each record that meet the search terms. To provide a
more detailed description, you can add a link from your Record Search part to a page that contains a
Record Display part. For more information, see Record Display on page 180.
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Design Record Search
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under General options, select a query in the Query field. The output
fields from the selected query are used as search filters on the record search form.

2. In the Results per page field, select the number of results to display on the page. If the search
returns more results than the number entered, the results display on additional pages.

3. Select Search when page loads to automatically search and display all results when the page
loads.

4. Under Search filters, move fields from the Available box to the boxes on the right.

• Shared search field for multiple filters — This option creates a single keyword search field
for multiple filters. For example, you include the public name and description as filter fields.
Users can enter keywords in a search field and the program will return any public names or
descriptions that match the keywords. For fields where users select from finite lists such as
code table entries, it may be better to use the Unique search fields for each filter option.

• Unique search fields for each filter — This option creates multiple search fields to provide
precise search results for each filter. This is most useful for fields where users select from finite
lists such as code table entries. For example, if you include the record’s purpose category and
tags, users can select from the available categories and tags.
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5. Under Result summaries, design the search results display. Use merge fields to include
information about records included in the results.

6. To select the merge fields to include, click Advanced merge fields. The Select Field Providers
screen appears.
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7. Select each group of merge fields to make available and click OK. You return to the Design
tab.

8. Click Merge fields on the Insert tab in the toolbar to select the merge fields to include.

9. To format the content’s appearance and layout, use the HTML editor. For more information
about the HTML editor, see the Program Basics Guide.

10. Click Save. You return to Parts.

Search
To use a Search part, you must have Microsoft Full-Text Search on your web server. If you do not, the
part does not appear in Parts. This part can search other parts: Formatted Text and Images, Formatted
Text and Images (Secured), Discussion Group, Event Calendar Job Board, and Weblogs.

Note: You can select to install Full-Text Search when you install SQL Server. For general information
about Full-Text Search, see your SQL Server documentation.

Learn About Search
When you add a Search part to your web page, a field name, text box, and search button appear on the
page for site users to search for information on your website. Results appear below the Search part
similar to Google. The first line is a hyperlink to the web page. The next several lines provide a preview
of the text that contains the word or phrase a user searched on. Words or phrases used in the search
appear in bold.
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Note: The primary difference between the Quick Search and Search parts is how results appear on
your site. With the Quick Search part, you select a web page for results to appear on. With the Search
part, results appear automatically below your Search part. You can add a Quick Search part to a web
page template; however, we recommend you not add a Search part to a template.

The parts available for a search are indexed by part. For example, a Formatted Text and Images part
contains “boy.” On the same page, a Discussion Group part contains “scout.” If a user enters “boy
scout” in the search field, results do not appear because the same part does not contain both the
words.

Warning: When the Search part performs a search, it includes all pages on your website that contain
a searchable part. Therefore, the potential exists for search results to return unfinished web pages. To
prevent this, establish security to restrict the users who can view unfinished pages.

Note: When a user searches for a word or term on your website, search results include pages only.
Searches do not include templates or the parts on templates.

The Search functionality uses “stem” search. When a user enters a word in the search field, the search
results include the word plus its plurals and verb tenses. For example, if a user searches for “run,” the
search results return parts that contain the words “run,” “ran,” and “running.” The search also accepts
certain operators and wildcards in the search text box, such as asterisks, quotation marks, and minus
signs.

Operator Function

Asterisk (*) Begins with (For example, enter “donat*” to return
results such as “donate,” “donating,” “donation.”)

Quotation marks (“ ”) Whole phrases (For example, “Become a Member Now”
returns results that contain the entire phrase.)

Minus ( - ) All words in search box, minus preceding word or words
(For example, “event registration -form” searches for
“event” and “registration,” but excludes results that
contain “form.”)

Warning: When you search for a phrase and do not use quotation marks, you may not receive any
results. For example, "Become a Member Now" returns results, while Become a Member Now does
not. This issue is due to a SQL Server setting that specifies how SQL handles searches that contain
“noise” words. For more information, see this article: http://msdn.microsoft.com/en-
us/library/ms187914.aspx.
To fix the issue, run this SQL:
sp_configure 'show advanced options', 1
RECONFIGURE
GO
sp_configure 'transform noise words', 1
RECONFIGURE
GO

When a site visitor performs a search through the Search part, security is upheld. For example, a web
page contains the Formatted Text and Images part with the phrase “Board Member Personal
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Addresses.” Only users in the Board Member role with the applicable task rights can access this page.
When other users search for “board member + addresses,” the page is not returned.

For information about security, see the Users & Security Guide.

Design Search
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Search properties, in the Title field, enter a name for your Search
part. This title appears on your site.

2. In the Description field, enter additional text to appear for users to read, such as “Search Job
Postings.”

3. In the Search button caption field, enter the text to appear on your search button, such as
“Go.”

If you do not enter text for the button in the field, the button does not appear on your site. To
process search results, site users press ENTER on the keyboard after they enter search
information in the text field.

4. When you host multiple websites, Select the sites to search appears. Use these options to
choose the sites to search with this part.

Tip: For more information about multiple websites, see the Administration Guide.
• To return results from all of your sites, select All sites.
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• To only return results for the site the user is on, select Current site.

• To select sites to search, select Specify sites. A list of your sites appears for you to include the
sites to search.

5. Click Save. You return to Parts.

Slideshow
To include a slideshow presentation of graphics on your website, you can create a Slideshow part. The
slideshow can present graphics in a specified or random order. You can add navigation buttons so
website users can start and stop the slideshow and move forward and backward between pictures. If
the image has an assigned caption, it appears below the image and above the navigation buttons.

Design Slideshow
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Slideshow options, to display images in the slideshow in random
order, select Random display order.

2. To include buttons below the slideshow, select Show navigation buttons. This table includes
the navigation buttons available for the Slideshow part.
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This table includes the navigation buttons available for the Slideshow part.

Button Function

Play

Pause

Forward

Back

Stop

3. To display captions with the images in the slideshow, select Show image caption.

4. To enter the maximum dimensions for an image in your slideshow, select Fixed width and
height for all images and enter the number of pixels in the Number of pixels field. This
setting defines the height and width of the boundary that contains the image but does not
directly alter the size of the images.

An image’s number of pixels cannot exceed the number you enter in this field. For example, if
you have an image that is 200 pixels and set this boundary to 500 pixels, the image cannot
increase to 500 pixels. Conversely, if you have an image that is 500 pixels and set the
height/width size to 200, the image shrinks to fit that boundary.

Note: There is no limit to the number of photos you can include in a slideshow.

5. In the Slide display interval (seconds) field, enter the number of seconds to display an image
before the next image in the slideshow appears. The default amount is five seconds.

6. Under Add images, click Add image. The Select Image From Image Library screen appears.
For information about how to insert an image, see the Program Basics Guide.

7. To change the order or remove images in the slideshow, click the up and down arrows or the
red “x” buttons.

8. Click Save. You return to Parts.

Sponsorship Form
Warning: To avoid security issues, do not use an iFrame from a third party website to direct users to
this part on a web page. We recommend you design the page to include the same look and feel as
your third party site so that users seamlessly transition to the page.

Use the Sponsorship Form part to design the form that appears on a web page when a sponsor selects
an opportunity from the search results.

Note: The search results within greatest need groupings are random.
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The form includes several features. You can use the HTML editor to design a section that contains
additional information about the opportunity such as a picture or biographical information. You can
also define the payment options available when website users purchase a sponsorship. For example,
you can allow users to purchase sole sponsorships or sponsorships as gifts for others. You can also
define the schedules available for sponsorship payments.
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After sponsors complete the basic payment information, they click a link that takes them to a page that
contains a shopping cart where they make the final payment transaction for the sponsorship. An email
acknowledgement is sent to the sponsor when the payment transaction is complete.

When a user submits a sponsorship on your website, the data defaults directly on the constituent
record. You do not need to process data in Blackbaud CRM for this part.

After users purchase a sponsorship, they can access a page that contains a Sponsorship Status part to
view information about their current sponsorships. For more information about this part, see
Sponsorship Status on page 207.

Sponsorship information integrates from Blackbaud CRM. For more information, see the Blackbaud
CRM Sponsorship Guide.

Design Sponsorship Form
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Opportunity Display, select whether the display is for a child or
project opportunity. In the HTML editor, design the display that appears when a sponsor
selects an opportunity from the search results. You can select the fields to appear and format
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content appearance and layout. For information about the HTML editor, see the Program
Basics Guide.

2. Under General Payment Options, in the Constituency field, select a constituency to assign to
sponsors.

For more information about constituencies, see the Program Basics Guide.

PARTS 193



3. To offer sole sponsorship for opportunities with multiple sponsorships available, select Offer
sole sponsorship. If a sponsor chooses to be the sole sponsor, he purchases all sponsorships
for that opportunity.

4. Under Attributes, select revenue attributes to associate with the sponsorship page.

a. Select Display for the attributes to include in the Additional Information section of the
display.

b. In the Caption column, enter the text to appear for the attribute on the website. If you do
not enter a caption, the attribute name appears on the website.

c. To make the attribute fields required, select Required.

d. In the Validation Message field, enter a message to display a message when the user fails to
enter a value for a required attribute field.

Tip: The revenue attributes that appear in this frame are created in Blackbaud CRM. After you process
a donation transaction, the attributes you select appear on the Attributes tab of a revenue record.

5. Under Sponsorship Gifts, select Allow sponsors to purchase sponsorships as gifts to add an
option that allows sponsorship gifts.

6. If you select Allow sponsors to purchase sponsorships as gifts, the Allow sponsors to send
eCards when they purchase sponsorships as gifts option appears. Select this option to allow
sponsors to send eCards when they purchase sponsorships as gifts. Additional options for
eCards appear.
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a. Under Available eCards, select the eCard templates that sponsors can use.

b. Under Display Options, select how the selected eCard templates appear on the part’s
Choose screen on your website.

To display all the eCard templates together, select Display the templates in a single listing.

To display the eCard templates by category, select Display the templates in separate
listings by category. When you select this option, your website users can browse for a
template by its category.

c. Select whether the personal message field on the part’s Personalize screen on your website
generates plain text or rich text.

Note: All email applications can easily read the plain text format, but they do not allow users to
adjust the text’s color, font, or format. With rich text, users can adjust the text’s format and embed
pictures and links, but not all email applications can easily read the rich text format. Applications that
do not support the rich text format convert the text to the plain text format.

d. In the Maximum height and Maximum width fields, enter the maximum size, in pixels, of
the thumbnail preview image of each template.

e. Under Sender and Recipient options, determine the maximum number of eCard recipients
and whether to provide first and last name fields for senders and recipients.

f. In the Maximum recipients field, enter the maximum number of recipients for an eCard. You
can allow website users to send eCards to a maximum of 100 recipients.
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g. To provide one name field for the sender and one name field for recipients, select Display
all as single fields. To display First name and Last name fields for both the sender and
recipients, select Display all as separate first and last name fields.

7. Under Additional Donations, to include an additional contribution field on the sponsorship
page, select Allow sponsors to make additional donations. Designation options appear.

a. The ability to credit the opportunity’s designation with an additional donation defaults in the
first row. In the Display Name field, enter text to appear for the option a user selects to
apply the donation to the opportunity. For example, enter “Make a special cash gift to your
child”.

Tip: If you do not want a user to be able to make an additional donation for an opportunity, click
Remove beside this row. The Allow additional donation to opportunity button enables for you to
include this at a later time.

b. To include other designations to credit for additional donations, click Add Designation. A
row appears with a binoculars icon for you to select a designation. Click the binoculars to
search for a designation.

c. After you select a designation, in the Display Name field, enter the name of the designation
as you want it to appear on the website.

d. If the sponsor does not select a designation, select the checkbox in the Default column for
the designation additional gifts should apply to by default.

For each additional designation to make available on the page, click Add Designation.
Another row appears in the grid for you to include another designation. When you add
multiple designations, you provide a list of designations for sponsors to select from.

e. In the Minimum donation amount field, enter the minimum donation a sponsor can
contribute. Enter “0” or leave this field blank for no minimum amount.

8. Use the options under Appeals to manage how sponsors learn about sponsorships through
the website.
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a. To include an appeal, click Add Appeal in the Appeal column. The Appeal Search screen
appears so you can select an appeal.

Tip: When you select source information, a How did you hear about our site field appears on the
donation page. In this field, users can select from the appeals you select in this step.

b. In the Display Name field, enter the name of the appeal as it will appear on the website. By
default, the text entered in the Appeal Name field on the appeal record in Blackbaud CRM
defaults in the Display Name field.

c. In the Default column, select the checkbox for the appeal to use when the user does not
select an appeal.

d. To hide an appeal from the How did you hear about our site field, clear the checkbox for
the appeal in the Display column.

When you do this, you can add source information to the end of a URL in an email that
navigates the recipient to your donation page. For example, create a link to your donation
page in an email message. At the end of the URL, add &source=camp. When the recipient
clicks the link, the How did you hear about our site field does not appear on the page. The
appeal stores automatically based on the source information in the URL.

If the Display checkbox is selected for the appeal and a user navigates to the donation page
via a URL without source information, the How did you hear about our site field appears on
the page.

Note: The source information must include the appeal ID from Blackbaud CRM. For example, if the
appeal ID in Blackbaud CRM is Annual2008, add &source=Annual2008 to the end of the URL. If the
appeal ID includes a space, replace the space with a %20. For example, if the appeal ID is CAMP
LETTER add &source=CAMP%20LETTER.

To add additional appeals, click Add Appeal. Another row appears in the grid for you to
select another appeal.

9. Under Payment Schedule select the payment options for recurring gifts.
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• Force start date —If you select this option, you can select a frequency (weekly, monthly,
quarterly, semi-annually, annually) to associate with the recurring gift.

• General — If you select this option, sponsors enter the payment frequency when they
purchase the sponsorship.

• Specific — If you select this option, you can select the payment frequencies available to
sponsors. Click Add Frequency to add the option to the form. Select Allow sponsors to enter
an ending date to allow sponsors to enter an ending date for recurring payments.

10. Under Payment Setup, select the payment options for website users.
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a. If your organization uses multiple general ledger account systems, the Account system field
appears. In the field, select the GL account to post sponsorship payments to.

b. In the Payment page field, select the web page to use to process donations. The Payment
2.0 part on the selected page determines the payment methods and merchant account used
to process donations. For information about the Payment 2.0 part, see Payment 2.0 on page
158.

c. In the Payment method box, select the payment methods available to sponsors. Credit card
is included by default so it does not appear as an option.

d. In the Payment page expiration limit field, enter the number of minutes an opportunity can
remain in the shopping cart before the transaction times out. If the shopping cart times out,
the hold on the opportunity is removed. For no expiration limit, enter a value of 0.

e. In the Sponsorship page expiration limit field, enter the number of minutes an opportunity
selected from the search results page can remain on hold before the transaction times out. If
the sponsorship page times out, the hold on the opportunity is removed. For no expiration
limit, enter a value of 0.

11. Click Next. On the screen that appears, design the email acknowledgement sent when a
sponsor completes the sponsorship payment transaction. You can select the fields to appear
and format content appearance and layout.

For information about how to design an email to acknowledge an sponsorship payment, see
the Email Guide.

12. Click Save. You return to Parts.
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Sponsorship Search
Warning: To avoid security issues, do not use an iFrame from a third party website to direct users to
this part on a web page. We recommend you design the page to include the same look and feel as
your third party site so that users seamlessly transition to the page.

Use the Sponsorship Search part to create a search section on your website for users to find available
opportunities to sponsor. You can provide two levels of search — a simple search and an advanced
search. For example, you can provide the advanced search so users have the option to refine their
search criteria for more precise results. The sponsorship data that appears in search results integrates
from Sponsorship in Blackbaud CRM. Users select a child or project to sponsor from the search results.

When you add the part to a web page, the search criteria appears at the top of the page and search
results appear at the bottom of the page. After users find an opportunity to sponsor, they click a link to
a page that contains a Sponsorship Form part. The sponsorship page includes information about the
opportunity, as well as payment options for the sponsorship. For more information about the
Sponsorship Form part, see Sponsorship Form on page 189

Note: When you design the Sponsorship Search part, several options can heavily impact the
performance of the search web page. To provide the best experience for website users, refer to
Sponsorship Search: Performance Improvement Tips on page 205.
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Design Sponsorship Search
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Search Fields, drag and drop fields into the Simple Fields or
Advanced Fields box. Website users enter criteria in the fields to filter search results. You can
provide two levels of search — a simple search and an advanced search. For example, you can
provide the advanced search so users have the option to refine their search criteria for more
precise results. To change the order of fields, drag the field to its new position.

Tip: To customize the text to appear on the web page for information such as the simple search and
advanced search fields, select the Language tab.

Note: The available search fields and attributes default from the Sponsorship Opportunity - CMS in
Blackbaud CRM.

2. Under Search Configuration, select search criteria information for the part.
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a. In the Opportunity query field, select the query of opportunities to include in the search
results. The available Sponsorship Opportunity - CMS queries integrate from Blackbaud CRM.
If you do not select any search fields in the Available Fields List, the search results include all
records in the selected query.

b. In the Render results as field, select “Table” to display search criteria in a default table.
Select “DIV” to display search criteria in a table you customize with style sheets.

For more information, see the Website Design Guide.

c. In the Display search fields in [] columns field, enter the number of columns to use to
display search criteria fields.

Both table options in the Render results as field contain the search criteria columns. When
you select “Table,” the table automatically resizes when you change the number of columns.
When you select “DIV” and change the number of columns, you must update your style sheet
data according to the number of columns.

d. To return search results for all available sponsorships when a user accesses the web page,
select Search automatically when page loads.

e. In the Show navigation controls field, select whether the navigation buttons should appear
above the results, below the results, or both above and below the results.

3. Under Search Results, specify how search results appear on the web page.
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a. In the Results per page field, enter the maximum number of results to appear on a page.

b. In the Design standard for rendering results field, select “Table” to display results in a
default table. Select “DIV” to display results in a table you customize with style sheets.

For more information, see the Website Design Guide.

c. In the Number of columns field, enter the number of columns to use to display results.

Both table options in the Design standard for rendering results field contain the results
columns. When you select “Table,” the table automatically re-sizes when you change the
number of columns. When you select “DIV” and change the number of columns, you must
update your style sheet data according to the number of columns.

d. In the Results per session field, enter the number of results a user can view during a browser
session.
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Note: The number in the Results per page field should be less than the number in the Results per
session field. If the number is greater, you display more results on a page than a user can view.

4. Under the Load Default HTML button, enter the text to appear on the search results. To
customize fields on the page and format the content’s appearance and layout, use the HTML
editor. For information about the HTML editor, see the Program Basics Guide.

To use the program’s default search results display, select Load default HTML.

Note: You can include the <Sponsorship Link Begin> and <Sponsorship Link End> merge fields in
your search results to link the user to the sponsorship form page. These merge fields do not appear
in the final results, but they create a link for the content in between the merge fields. For example,
you can enter “<Sponsorship Link Begin>Sponsor this child<Sponsorship Link End>.” On the web
page, this displays “Sponsor this child” as hyperlink to the page that contains the sponsorship form
part. Users click the link for more information about the sponsorship.

5. To provide security for unsponsored opportunities, such as children, select Use a masking
image to include a generic photo for the opportunity until checkout is complete. Additional
fields appear.

a. In the query field, select the query of opportunities to apply the image to.

If you cannot find the query but know it is exists, make sure the query type is Sponsorship
Opportunity - CMS.

The image you select appears only for opportunities that exist in this query and in the query
you select in the Opportunity query field. In addition, when an opportunity exists in this
query but not in the previous query, it does not appear in search results. For example, in the
Opportunity query field, you select the “All opportunities” query. In this query field, you
select “All US children.” The masked image appears only for the US children in both queries
in your search results. Other opportunities in the “All opportunities” query display the default
photo for the opportunity. Other opportunities in the “All US children” query do not appear
in search results.

b. In the Choose an image to display field, click the binoculars to select a masking image for
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the opportunities. The Select Image from Image Library screen appears. For information
about how to insert an image, see the Program Basics Guide.

6. Under Sponsorship Form Setup, select a page that contains a sponsorship form part. The
sponsorship page includes the display that appears when a sponsor selects an opportunity
from the search results, as well as payment options for the sponsorship. When users click the
link created with the Sponsorship Link Begin/End merge fields, they are directed to this page
automatically. For more information about the Sponsorship Form part, see Sponsorship Form
on page 189.

7. Click Save. You return to Parts.

Sponsorship Search: Performance Improvement
Tips
When you design the Sponsorship Search part, the query you select from Blackbaud CRM and the
number of search results you display on the web page can heavily impact the performance of the
page. To provide the best experience for website users, review these importance performance tips.

l When you design the part and include the Location Name field under Search Fields, make sure
the Show this location to online users checkbox is selected for each location you want to make
available on your web page. This checkbox appears on the Add or Edit a sponsorship location
screen in Blackbaud CRM. For information about sponsorship offline data entry, refer to the
Blackbaud CRMSponsorship Guide.

l You associate a Sponsorship Opportunity – CMS query from Blackbaud CRM with the
Sponsorship Search part. This query is used when a search occurs on the web page to return
results by:

1. First, identifying opportunities that are valid to sponsor at the time of the search.

2. Second, returning data that matches the search filters the website user selected.

By default, the query only returns opportunities that meet the program’s standard criteria.
However, your organization can include more fields to the query to add additional fields to
search to further limit opportunity results.
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l Whether or not you select the Show this location to online users checkbox for an opportunity's
location in Blackbaud CRM impacts the web page search in two ways.

1. Location filter - When you design the part to include the Location Name field under Search
Fields, only locations with the checkbox selected appear in the search field. However, the
locations that appear depend on whether or not your Sponsorship Opportunity – CMS query has
an associated selection.

l If the query is not associated with a selection, all locations appear from the search field. Be
aware this can include locations that do not have a corresponding opportunity when a
website user executes a search.

l When query has an associated selection, only locations that correspond to opportunities in
the selection appears from the search field. When you use a selection, the search limits the
location options to only those that will return a search result.

2. Search results - When you design the part to include the Location Name field under Search
Results:

l When the opportunity's location has the checkbox selected, that location displays.

l Otherwise, the program moves up the location hierarchy from the opportunity's location
until one with the checkbox selected is found. When this occurs, that location displays.

For example, if the Blackbaud CRM location hierarchy includes the following:

Africa – Show this location to online users checkbox selected

l Ethiopia – checkbox not selected
l Malawi – checkbox not selected

North America – Show this location to online users checkbox selected

l Haiti – checkbox not selected

When opportunities exist in all three countries, but only opportunities in Malawi appear in the
query results, the following appears on the page based on whether or not you use a selection
from the query.

Note: When an opportunity is marked inactive in Blackbaud CRM, it does not appear in search
results on the web page.

l When you use a selection, only Africa appears.
l When you do not use a selection, Africa and North America appear on the page. If a

website user searches for North America, results do not appear on the page.

l To improve performance and decrease search time on the web page, always use a static
selection from your query for this part. When you use a static selection, the query process to
filter locations (and other criteria you select) occurs at the time you create the selection and it
only processes again when you refresh the query in a queue. A static selection is a saved list
referenced by web page requests. When you use a dynamic query, the query filters criteria
process at least once for every website user's web session and this happens directly on the web
page. This can degrade performance and the website user's experience.

Tip: To create a static selection from a query, open the query in Blackbaud CRM and select the
Set save options tab. Next, select Create a selection, Create a static selection. For information
about queries, refer to the Blackbaud CRM Query and Export Guide.

l We recommend you then schedule the query to update using a queue process in Blackbaud
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CRM. When you do this, it is important to refresh the static selection on a regularly interval that
benefits your organization's opportunity needs the most. For example, if you constantly add new
opportunities to the Blackbaud CRM database, you may want to run the queue daily. If you add
new opportunities once a month, you may want to schedule the queue to run monthly.

Schedule the queue to run after hours to avoid refreshing the query during peak usage by
website users. For information about queue, refer to the Blackbaud CRM Queue and Business
Process Guide.

l When you design the part, the Results per page field includes the number of opportunities a
website user can view on each page of the results. For example, if you enter "25" in this field and
a user's search returns 100 results, four pages return with 25 result opportunities on each page.
The Results per session field includes the number of results a user can view during a browser
session. Therefore, the number in the Results per page field should be less than the number in
the Results per session field. If the number is greater, you display more results on a page than a
user can view.

The higher the number you enter in these fields increases the volume of data the program must
handle to return results on the page. To provide an optimal experience for website users, you
can change these numbers to determine if the impact on the page is acceptable. If not, decrease
the numbers to decrease the time it takes to return results.

Sponsorship Status
The Sponsorship Status part provides a dashboard for website users to view information about their
current sponsorships. When you create the part, you select the features to include in the dashboard.

The Sponsorship Status contains two tabs. On the My Sponsorships tab, sponsors view documentation
items about their sponsorships, such as videos or newsletters. If you allow email, sponsors can send an
email to their sponsorship. The email is “blind” so the recipient does not view the sponsor’s email
address.
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On the Payment Information tab, sponsors can view their recurring gift payments made for active and
expired sponsorships.

208 CHAPTER 1



Sponsorship information integrates from Blackbaud CRM. For more information, see the Blackbaud
CRM Sponsorship Guide.

Design Sponsorship Status
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Programs, select the opportunities from sponsorship programs to
include. Select Include all sponsorship programs or Include selected sponsorship programs
to select programs to include.
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2. Under HTML Editor, enter the text to appear for status information. To customize fields on
the page and format the content’s appearance and layout, use the HTML editor. For
information about the HTML editor, see the Program Basics Guide.

3. Under Notes Types, Attachment Types, and Media Links Types, select the documentation
items that users can view to learn more about their sponsorship opportunity.

• To allow users to view all documentation types associated with the sponsorship opportunity,
select Include all types.
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• To filter the list of items that users can view, select Include selected types. In the list that
appears, select the documentation types to include. Website users view the items you select.

• If you do not want the documentation type to display on the web page, select Do not include
types.

Documentation types integrate from Blackbaud CRM. If you do not see the documentation
information you need, create it in Blackbaud CRM. For more information, see the Blackbaud
CRM Sponsorship Guide.

4. Under Email, select Allow sponsors to send email to their sponsorships to allow sponsors to
email their sponsorships. Several options appear:

a. Select the programs that allow email from sponsors — Select the programs from
Blackbaud CRM that allow sponsors to email their sponsorships.

b. Enter the maximum number of characters for the email message and signature — Enter
the maximum number of characters sponsors can use in messages and signatures.

c. Select the contact method for email — Select the contact method to use on the sponsor’s
Interactions page in Blackbaud CRM for emails sent to sponsorships.

d. Select the interaction category for email — Select the interaction category to use on the
sponsor’s Interactions page in Blackbaud CRM for emails sent to sponsorships.

e. Select the subcategory for email — Select the interaction subcategory to use on the
sponsor’s Interactions page in Blackbaud CRM for emails sent to sponsorships.

f. Enter the default email address to use for sponsorships with no field office assigned —
 Enter the default email address to use for sponsorships with no field office assigned in
Blackbaud CRM.
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g. Select the interaction category for emails sent to the default address — Select the
interaction category to use on the sponsor’s Interactions page in Blackbaud CRM for emails
sent to sponsorships that use the default address.

h. Select an interaction subcategory for emails sent to the default address — Select the
interaction subcategory to use on the sponsor’s Interactions page in Blackbaud CRM for
emails sent to sponsorships that use the default address.

i. Create templates for sponsor emails — Click Add Email to create an email template for
sponsors. You can add multiple templates. Use the email editor to design the appearance
and include any text and merge fields for the message. Sponsors can add text to the
template they choose to personalize their message. The email editor includes the Message,
Signature, Opportunity ID, and Sponsor ID merge fields:

Message — Inserts a text area where sponsors enter their message.

Signature — Inserts a text area where sponsors enter their email signatures.

Opportunity ID — Inserts the opportunity’s name.

Sponsor ID — Inserts the sponsor’s name.

For information about how to create an email message, see the Email Guide.

5. In the Transaction Manager frame, you can customize the recurring gift information that
appears on the Active and History tabs. These are the same options that appear in the
Transaction Manager part for recurring gifts. For more information about options in the
Transaction Manager, see Transaction Manager on page 232.

6. Click Save. You return to Parts.

212 CHAPTER 1



Suggested Content
With the Suggested Content part, you can create recommendations for website users to visit other
areas of your website. For example, you can use the part to direct users to articles or donation forms
that are related to the content on the pages they visit. The part displays short summaries about
suggested content and links to the pages with the content.

The Suggested Content part uses tags and user interests to determine the content that it recommends.
When you create parts for your website, you associate tags and users interests with them and select
whether to make the parts eligible for Suggested Content parts. Then when you create a Suggested
Content part, you select the tags and users interests to use to generate recommendations. If you assign
tags to designation records in Blackbaud CRM, you can also use this part to suggest designations to
users.

Note: For the Suggested Content part to be effective, you must associate tags and user interests with
the parts on your website. If you do not maintain these tags and user interests, the Suggested Content
part cannot recommend the most relevant content or keep recommendations up to date. To
associate tags and user interests with parts, use the Tags tab. For more information, see Tags Tab on
page 23.

When a user visits a page that includes a Suggested Content part, it recommends other parts that most
closely match its tags and user interests. As you update the content on your website, the part
automatically updates its recommendations to reflect the changes. For example, when you add new
parts or edit the tags and interests associated with existing parts, the Suggested Content part updates
its suggestions to take these changes into account.

To determine the content to recommend, the Suggested Content part assigns point values to the tags
and user interests that it includes. It then assigns point values to all parts on the website that are
eligible for the Suggested Content part. When the Suggested Content part creates its
recommendations, it selects randomly from all eligible parts but emphasizes the parts with the most
points. This allows the part to avoid recommending the same content repeatedly and still focus on the
most relevant content. After the part selects the parts to recommend, it organizes the items to display
the most recently edited or created first.

To assign point values, the Suggested Content part performs several calculations.

• For tags associated with the Suggested Content part, the part assigns points based on user history.
When website users visit your website, the program tracks the content they view. For each part that
a website user views, the Suggested Content part assigns points to the tags associated with that
part. The number of points depends on how often and how recently the user viewed the part. For
each view, tags receive five points, but this decreases to one point during the course of seven days.

• For user interests associated with the Suggested Content part, the part assigns 20 points for each
match to a user interest in a website user’s profile.

• For parts that are eligible for the Suggested Content part, the part adds the points from all the tags
and user interests associated with the parts and then subtracts points for each time a user viewed
the parts. The number of points it subtracts depends on how recently the user viewed the part. For
a recent view, the part subtracts 25 points, but this decreases to 5 points during the course of
seven days.
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Design Suggested Content
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Content source, in the Types of content to suggest field, select
the source for content. If you select “Parts”, the program creates recommendations for parts
based on their associated tags. If you select “Designations” the program creates
recommendations for designations based on tags associated to designation records in
Blackbaud CRM.

2. If you selected “Designations” as the content type, under Designation summaries, design the
suggested content display. Use merge fields to include information about recommended
designations. The text box includes the Public Name, Purpose Description, and Designation
Tags List merge fields by default. If you need other merge fields, click Advanced merge
fields to select additional field groups. After you select field groups, the Merge fields button
on the Insert tab in the toolbar appears so you can add the additional merge fields to the
display.

To format the content’s appearance and layout, use the HTML editor. For more information
about the HTML editor, see the Program Basics Guide.

Tip: To include an Add to cart link, insert the Desigation.BeginAddtoCart and
Designation.EndAddtoCart merge fields. Users can click this link to add designations in the search
results to their shopping carts.
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3. Under Layout options, in the Number of items to display field, select how many suggestions
to display. You can recommend up to 30 items.

4. In the Orientation field, select whether to display suggestions in a horizontal or vertical list.

5. Under Tags to include, select the tags and interests to include in the suggested content. By
default, the part includes all eligible tags and interests.

Note: If you selected “Designations” in the Types of content to suggest field, you select tags for
designations rather than parts.
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• To remove a tag or interest, click Remove tag for it in the Include box. To remove all tags
and interests, click Remove all. The tags and interests you remove appear under Exclude.

• To add a tag or interest back to the part, click it under Exclude. To return all tags and interests,
click Include all.

Note: Tags are keywords or phrases that describe the content on parts and allow you to link to similar
content. User interests are attributes associated with constituent records. For the Suggested Content
part to be effective, you must associate tags and user interests with parts throughout your website. If
you do not maintain these tags and user interests, the part cannot recommend the most relevant
content or keep its suggestions up to date. For information about how to associate tags and user
interests with parts, see Tags Tab on page 23. For information about how to capture user interests for
website users, see User Interests Form on page 245.

6. Click Save. You return to Parts.

Survey
With the Survey part, you can create surveys to learn more about your website users. After users submit
responses, you can view a summary of responses, view response details, clear responses, and refresh
the survey results on the bottom of the Design tab.

If website users are logged in to your website, you can download their survey responses to constituent
records in Blackbaud CRM. To access survey responses from the constituent records, click Surveys
under More information or select Tasks, More information, Surveys in the menu bar. The Surveys
page appears, and you can view all surveys completed and the survey responses for each one.

For more information about how to download survey transactions, see the Web Transactions Guide.

You can add several types of survey questions in multiple formats.
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Choice - One Answer (Vertical) — Select this to ask a question that allows respondents to select an
answer from a vertical list. To allow respondents to enter an answer that is not provided, you can add
an Other selection.

Choice - One Answer (Horizontal) — Select this to ask a question that allows respondents to select an
answer from a horizontal list.

Choice - One Answer (Dropdown) — Select this to ask a question that allows respondents to select
one answer from a drop-down list. To allow respondents to enter an answer that is not provided, you
can add an Other selection.

Choice - Multiple Answers (Vertical) — Select this to ask a question that allows respondents to select
multiple answers from the vertical list. To allow respondents to enter an answer that is not provided,
you can add an Other selection.

Choice - Multiple Answers (Horizontal) — Select this to ask a question that allows respondents to
select multiple answers from a horizontal list.

Matrix - One Answer Per Row — Select this to ask a question and arrange possible answers in
columns. The respondent can select one answer per row.

Matrix - Multiple Answers Per Row — Select this to ask a question with possible answers arranged in
columns. The respondent can select multiple answers per row.

Matrix - Multiple Answers Per Row (Dropdown) — Select this to ask a question with possible
answers arranged in columns. The respondent can select multiple drop-down answers per row.

Open Ended - One Answer — Select this to ask a question that allows one text answer no longer than
a single field. You can define the maximum number of characters a respondent can use in his answer.

Open Ended - Multiple Answers — Select this to ask a question that allows multiple text answers no
longer than a single field. You can define the maximum number of characters a respondent can use in
his answer.

Open Ended - Essay — Select this to ask a question that allows a text answer longer than a single field.
You can define the maximum number of characters a respondent can use in his answer.

Open Ended - Constant Sum — Select this to ask a question that requires a numerical answer. You can
define an amount all answers must total.

Open Ended - Date — Select this to ask a question that requires a date as an answer. The respondent
can enter the date in the field or click the calendar button to select the date.

Presentation - Text — Select this to add text to the survey, such as a message to thank the
respondent for taking the survey.

Presentation - Image — Select this to add an image with text to the survey. The text can describe the
image, or you can leave the text box blank and add questions that refer back to the image.

Presentation - Page Break — Select this to add a page break between survey questions.

Design Survey
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, under Survey status, select the survey’s current status.
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• In Test Mode — Select this to test the survey. The program does not record survey responses
entered during Test mode.

• Open — Select this to allow respondents to take the survey.
• Closed — Select this to close the survey. If you select Allow users to view survey results, a

Show Survey Results button appears instead of questions.
2. In the Title field, enter a name to appear on your web page for your survey.

3. In the Subtitle field, enter additional text about the survey for website users to read.

4. In the Submit button text, Next button text, and Previous button text fields, enter the text
to appear for these navigation buttons. You can use the default values or enter different text
for each button.

5. In the On submit message box, enter a message that appears when the user clicks Submit.
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6. In the Survey closed message box, enter a message to appear to notify users when the survey
is closed.

7. To add a Display Results button after the user submits his response, select Allow users to
view survey results.

8. Under Survey questions, to add a question, click New Question.

The Add Survey Question screen appears.
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Note: When you select a question type, a sample appears under Sample.

a. Under Question, in the Type field, select the type of question to add. The options that
appear in the Question and Answers frames depend on the selected question type.

After a user submits a response, you cannot edit questions for a survey.

b. In the Question field, enter the question to ask.

c. To not have the program automatically number the survey questions, select Skip auto
numbering.

d. To require respondents to answer the question before they can submit the survey or move
to the next page of a multi-page survey, select Answer required.

e. Under Answers, enter possible answers on separate lines. Enter the first answer choice in the
box and press ENTER on your keyboard. On the second line, enter the second answer choice
and press ENTER. Continue until you have entered all possible answers.

f. To display answers in random order, select Display in random order.
g. If you select a choice question type, Other appears. To add Other as an answer choice with a

text field for respondents to enter their response, select this checkbox and, in the Limit
Answers to [ ] characters field, enter the maximum number of characters a respondent can
enter in his answer.
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h. If you select an open-ended question type, in the Limit answers to [ ] characters field, enter
the maximum number of characters a respondent can enter in his answer.

i. If you select a matrix question type, the Answer columns frame appears. Enter answer
column names on separate lines.

j. If you select a “Matrix — Multiple Answers per Row (Dropdown)” question type, in the
Number of columns field, select the number of columns to appear. In the Heading fields,
enter a heading for each column. In the Choices box, enter answer choices for each column
on separate lines.
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k. If you select a “Presentation — Text” question type, in the Text box, enter the text to appear.
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l. If you select a “Presentation — Image” question type, in the Question box, enter the text to
appear. To insert an image, click Add image. The Select Image from Image Library screen
appears. For information about how to insert an image, see the Program Basics Guide.

m. Click OK. You return to the Edit Part screen and the new question appears at the bottom of
the screen.

9. To generate a print preview of the survey, click Print preview.

Tip: Users with create and edit rights or Supervisor rights can print survey results to a PDF or export
them to a .csv file when accessing the survey part on a page.
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10. To export results into a .csv file, click Export results.

Note: After you receive responses to the survey, the View response details, Clear responses, and
Refresh results buttons appear beside Print preview and Export results. For more information
about these buttons, see Survey Response Data on page 224.

11. Click Save. You return to Parts.

Survey Response Data
After you receive responses to the survey, response data appears under Survey questions on the
Design tab. For example, you can view the number of questions in your survey, the page count for the
survey, and the number of survey responses. Also, the tab displays each question and calculates
information about the responses such as the percentage or respondents for a question.

After the summary response information, the View response details, Clear responses, and Refresh
results buttons appear beside Print preview and Export results.

To view the details for each survey response, click View response details. The Survey Response Details
page appears and includes details about the respondent and the answers to your questions.
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After you close a survey and report on its results, you can click Clear Responses on the survey part to
remove the responses from respondent records. Also, you cannot edit survey questions after a user
submits a response. If you need to edit the questions but have already downloaded a response, you
can click Clear Responses to make the questions editable. When you click Clear Responses, a message
appears to make sure you want to delete them. Also, an additional transaction appears in the responses
count on the Web Transactions page and is included in the total download count after you process the
transactions. Survey responses do not clear from records until you process this transaction, but you can
edit survey questions immediately after you click Clear Responses.
To make sure you have the latest response data from your website, select Refresh results.

Tag Display
With the Tag Display part, you include words or phrases related to a page’s content as hyperlinks on
the page so users can quickly access similar content on your website. You can also display all tags in
use in the program so users can navigate to areas of your site. When a user clicks a tag, a search results
page appears. The search results include all pages with the selected tag. Users can also search for tags.
Enter “tag:” followed by the exact tag name in a Search field to view all pages that contain a matching
tag.

When you include a tag display, you provide website users a more precise way to locate information
because you assign tags to only relevant parts. For example, you add the tag “Tournament” to Event
Registration Form parts you create for different golf tournaments your organization hosts. When a user
views a page with this tag and clicks the Tournament link, the search results include links to all pages
that contain a part with the “Tournament” tag. If a user entered “Tournament” in a Search field, the
search results may include pages that contain the word “Tournament” but are not directly related to
your organization’s events.

You can create and apply tags to parts from the Tags tab on the Edit Part screen. When you build a
page, each part you add may contain its own list of tags. From the Edit Part screen, you can choose to
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display only the tags assigned to the parts on the page or all tags used on your site. For information
about how to add tags to a part, see Tags Tab on page 23.

Design Tag Display
The tag display is linked to a search results page, so you must create this page before you add a
Tag Display part. For information about how to create a search results page, see Learn About
Search on page 185. For information about how to create or edit a part, as well as the tabs on the
Edit Part screen, see Create and Edit Parts on page 10.

1. From the Design tab, in the Results Page field under General, browse to the page to display
search results on.

Note: Only pages you added a Search part to appear on the Select a Page screen. The page grid does
not include pages based on templates that contain a Search part.

2. Select the tags to include in the tag display.
• To display only tags defined for parts on the page, select Display tags for parts on the

current page. When you add this part to a page, only tags assigned to other parts on the page
appear.

• To display all tags in use, select Display all tags in the system. You can use this option to
create a tag display that includes all tags on your website. This provides another layer of
navigation because users can navigate your site based on types of content.

Note: By default, the tag display appears with a “Tags:” header and a comma separates each entry in
the list. You can edit this heading and delimiter from the Language tab. For information about how to
edit the Language tab settings, see Language Tab on page 17.

Note: Each display option has a default format. If you select Display tags for parts on the current
page, when you add the part to a web page, the tag display appears as a horizontal line of text with
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each entry separated by a comma. If you select Display all tags in the system, the tags appear as a
vertical list, with each entry on a separate line. To change the appearance and orientation of the tag
display, you can apply custom styles to tag elements for the appropriate style sheet. For information
about how to manage style elements, see the Website Design Guide.

3. Click Save. You return to Parts.

Targeted Content
With a Targeted Content part, you can target information or features on a web page to different users
based on roles or the individual user. For example, you may want Major Donors to see a donation form
designed specifically for them, but you want all other users see the standard donation form. Use a
Targeted Content part to attach both donation forms on the same web page. When a major donor
accesses the page, the first donation form appears. When other users access the page, the second
donation form appears.

Design Targeted Content
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, create a part or add an existing part.

• To create a part to appear on the web page for a targeted audience, click Add New Part. The
New Part screen appears.

• To select an existing part for a targeted audience, click Add Existing Part. The Select a Part
screen appears.

a. Select the part for the targeted audience, such as “Major Donor Donation Form.”

b. Click Select. You return to the Design tab. The Targeted Roles and Users column displays
the roles and users associated with the selected part. This determines who sees the targeted
content on the web page with the Targeted Content part.

To display a complete list of roles and users associated with a part, hover over the row in the
Targeted Roles and Users column.

Note: The first part in the list appears first on the web page for the roles and users associated with
the part. For example, the Major Donor Donation Form you selected has view rights for the Major
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Givers role. When users in this role log into the website and access the donation page, they see a
form designed specifically for them that other user roles do not see.

2. Create additional parts or include existing parts as necessary for the targeted content. You can
include as many parts as you want. For example, you can include the “Healthcare Donation
Form” for users in the healthcare profession and the “Simple Donation Form” for the rest of
your donors.

Note: When a user accesses a page with a Targeted Content part, the first part in the list that includes
that user or the user’s role appears. For example, Mark Adamson is a member of the Board Members
role. When he accesses the donation page, he does not view the Major Donor Donation Form or
Healthcare Donation Form parts because those parts are not associated with the Board Members role.
Mark views the Simple Donation Form part because he is a user in the Board Members role. If the
users or user’s role is not included in any parts on the Targeted Content part, nothing appears in that
area on the web page.

3. On the Design tab, the first column displays three action buttons.

a. To move a part in the list, click and drag the dotted button on the far left.

Tip: If you move a part, remember that users with multiple roles see the first part in the list that is
associated with one of their roles. For example, Renee Wilson is a major donor, cardiologist, and
board member. When she accesses the donation page, she views the Major Donor Donation Form
because that part is listed before the other parts on the Design tab.

b. To edit a part, click Click here to edit this part. For example, to add a role to view the
targeted content, click this button to access the Targeting & Security tab for the part.

For information about users and roles, see the Users & Security Guide.

c. To remove a part from the Targeted Content part, click Click here to remove this part.

Tip: If a part in the list appears in red with a strikethrough, it never appears on a web page because
all roles and users are included in previous parts in the list. This occurs if you include the Everyone
role, which includes all users, in a part that is not last in the list for the targeted content.

4. Click Save. You return to Parts.

Targeted Content On a Web Page
In Pages & templates, when you include a Targeted Content part on a web page, the part appears with
Page part and Edit part buttons.
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To edit the Targeted Content part, click Page part. This button appears as a blue flag icon. To edit a
part included in the Targeted Content part, click the Edit part button. This button appears as a pencil
icon. For more information about Pages & templates, see the Website Design Guide.

When a user accesses a page with a Targeted Content part, the first part in the list that includes that
user’s role appears. Using the examples in Targeted Content on page 227, the following donation page
appears for users in the Major Givers and Site Administrator roles.
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For users in the Cardiologists and Medical Staff roles, the following donation page appears.
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For users in roles such as Board Members and Everyone, the following donation page appears.
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Transaction Manager
With the Transaction Manager part, you can create and display a giving history for donors. When a
website user logs in to your website, the Transaction Manager part uses the user’s login information to
filter his donor information and display it as a customized giving history. With this part, users can view
their offline and online gifts, as well as any pending online transactions that have not been processed.

On the website, the Transaction Manager part can display one of two tabs, or both. The Active tab
displays current recurring gifts, pledges, event registration fees.
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The History tab displays all gifts the user made to the organization for the selected time period or
designation. Users can also select how transactions are grouped in the grid. For example, they can
group by date or payment method.
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On the Transaction Manager part’s Edit Part screen, you select the tabs to display and the gifts to
include in the giving history. You can include all gifts, filter gifts by gift type or purpose, or use an
offline gift query to filter gifts. The giving history includes a donor’s original gift, but it does not
include any matching gift from the donor’s employer. In addition to your filtering criteria, you can
select whether to include recognition credits, also called soft credits, and pending online transactions
in the giving history. When you include pending gifts, the gifts appear regardless of any filtering
criteria you apply.

You can also choose whether to allow website users to make payments from the giving history toward
outstanding pledges. This option is available for donors who select the Pledge (Bill Me Later) payment
method or donors for whom you enter a pledge offline. If you allow pledge payments and the pledge
will be paid in installments, a Pay link appears in the Amount column with the pledge entry on the
Active and History tabs. The user clicks this link to view a donation form for the pledge and make a
payment online. The Pay link also appears for unpaid event registration fees. For recurring donations,
links appear so users can edit payments, edit payment details, or make additional donations for
sponsorships.
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Tip: Website users cannot submit recurring gift payments on a Transaction Manager part. In
Blackbaud CRM, you create a Generate Payments business process to automatically generate a
revenue batch to create payment records for these transactions. For more information about the
business process, refer to the Blackbaud CRM Revenue Guide.

Tip: The Pay link does not appear if a pledge installment or recurring gift is pending, if the total
pledge balance is zero, or if the donor submitted credit card or direct debit payment information at
the time the pledge was created.

Note: Pledges and pledge payments appear as separate entries on the History tab. From a pledge
entry, you can view the remaining balance and the most recent payment. From a pledge payment
entry, you can view the date, amount, and balance of the pledge. However, pledge payments include
pledge information only when the pledge appears in the giving history. If you filter gifts and exclude
a pledge, payments do not include information about the pledge. For example, you can use a gift
query to exclude gifts before a certain date. If a pledge is made before that date, the giving history
shows subsequent pledge payments but not the pledge details.

If you allow donors to edit recurring gift information, links appear on both the Active and History tabs
of the customized giving history. The settings you select from the Recurring gift details section
determine if donors can change the gift amount and payment schedule, as well as make changes to the
credit card or direct debit account associated with the recurring gift.

Note: When users update credit card information, the program collects user information on secure
payment pages to help you comply with the Payment Card Industry Data Security Standard (PCI DSS).
For information about secure payment pages, see Secure Payment Page on page 165.

To customize the appearance and content of the giving history, you can select the columns to display
for the donor, edit column headings, and add or remove columns. You can also add a gift summary
section.

Design Transaction Manager
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. Under Select the tabs to display on the Design tab, select whether to display the History tab,
Active tab, or both.

l To display the donor's previous transactions, select History tab.

l To display the donor's current recurring gifts, pledges, and event registration fees, select the
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Active tab.

l To display the donor's giving history and current transactions, select Both tabs. In the field that
appears on the right, select the default tab to display when the donor opens the web page.

2. Under Configure results, in the Results per page field select how many gifts to include on
each page of the giving history.

3. Under Choose the gifts to display, select the gifts to include in the giving history.
• To include all gifts, select All gifts.

• To filter the gifts on the Transaction Manager part, select Custom filtering criteria.

To select the gift types, designations, or appeals to include in the giving history, click the
binoculars. On the screen that appears, select your filter criteria.

• To use a gift query from Blackbaud CRM to filter gifts, select Gift query.

236 CHAPTER 1



To select a query, click the binoculars. On the search screen that appears, select a query. For
information about the search screen, see the Program Basics Guide.

• To include recognition credits, select Include revenue recognition.

• To include pending transactions from your website, select Include pending online
transactions.

Note: For pending online transactions, only the gift amount, payment method, and gift date
appear in the giving history. Other details do not appear until you process gifts.

• To include unpaid event registration fees, select Include unpaid event registrations. When
you select this option, the Configure event fee payment field appears.

4. Under Choose the columns to display, select the columns to include in the giving history.
• To display the default Date, Type, Designation, and Amount columns, select Default.
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Note: The Gift Type column includes pending transactions. To avoid redundancy, you can exclude
the Pending column if you include the Gift Type column.

• To include specific columns, select Custom.

Click Add Column and select each column to include in the giving history. To edit a column,
click the column title in the list that appears. You can reposition the column or delete it from
the giving history.

Note: An Export button appears on the web page so a user can export his active gifts and his
giving history. The columns you select to display from this option are the columns that appear in
the export output.

5. Under Choose the summary information to display, select Include gift totals section to
include a summary section that displays gift totals.

Additional options appear so you can select the columns to include in the summary section.
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Tip: The Include recognition credits total and Include donation amount total checkboxes
appear when you select Include revenue recognition under Choose the gifts to display.

6. To allow website users to make payments against outstanding pledges, under Configure
pledge payment, select the web page that contains the donation form to use for pledge
payments.

Warning: You must select a donation form that includes credit card or direct debit payments. You
should not select a donation form that requires only the Pledge (Bill me later) payment method
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because website users cannot pay a pledge with another pledge. For information about how to
create a Donation Form part, see Donation Form on page 60.

7. To allow website users to pay event registration fees from the transaction manager, under
Configure event fee payment, select the page that contains a Payment 2.0 part to use for
event fees. This option appears only if you selected the Include unpaid event registrations
option under Choose the gifts to display.

8. To allow website users to make recurring gift payments from the transaction manager, under
Configure recurring gift payment, select the page that contains the donation form to use for
recurring gifts.

9. Under Recurring gift updates, select the gifts and gift details a donor can update online.

Tip: This section allows you to configure the recurring gift type options you want to make available
to website users on the Transaction Manager part. For example, you can allow users to determine the
frequency of updated recurring gifts. However, users cannot submit recurring gift payments on the
part. In Blackbaud CRM, you create a Generate Payments business process to automatically generate a
revenue batch to create payment records for these transactions. For more information about the
business process, refer to the Blackbaud CRM Revenue Guide.

• To include all recurring gifts, select All gifts.
• To limit the recurring gifts a donor can update, select Custom filtering criteria.
To select the designations or appeals to include in the giving history, click the binoculars. Then,
select your filter criteria on the screen that appears.

• To use an offline gift query to filter gifts, select Revenue query.
To select a query, click the binoculars. On the search screen that appears, select a query. For
information about the search screen, see the Program Basics Guide.

• To allow donors to update the amount of the recurring gift, select Allow amount updates. In
the Minimum Gift Amount field, enter the minimum gift to accept when a donor changes the
original gift amount. Enter “0” or leave this field blank to allow donors to enter any amount.
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When you select Allow amount updates or Allow frequency updates, an Edit Gift Details link
appears under the recurring gift entry on the donor’s giving history.

Note: When users update credit card information, the program collects user information on secure
payment pages to help you comply with the Payment Card Industry Data Security Standard (PCI DSS).
For information about secure payment pages, see Secure Payment Page on page 165.

• To allow the donor to determine the frequency of the updated recurring gift, select Allow
frequency updates.

If you select General, donors can determine the schedule for the recurring gift payment.

Note: If you previously allowed donors to create payment schedules for recurring gifts, you may
want to select the General option so donors may continue to customize their schedules. If you
define multiple payment schedules for donors to select from, they will not have this flexibility.

Select Specific to define recurring gift schedules for donors to select from. You can select
“Weekly,” “Monthly,” or “Annually” as the frequency. In the On field, select a day or date donors
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can choose to schedule the gift. To make this frequency update available to donors, click Add
Frequency.

Note: To add multiple frequency options to the donation form, enter each custom schedule and
click Add Frequency to add the new schedule to the list.

Select Allow donor to enter ending date if donors can specify when the recurring gift ends.
• To allow donors to update credit card or direct debit account information, select Allow

payment updates.

Note: When you select Allow payment updates, an Edit Payment Method link appears under the
recurring gift entry on the donor’s giving history.

10. Click Save. You return to Parts.

Unformatted Text
Use the Unformatted Text part to embed HTML text or scripts on a page. For example, you can paste in
the embed code provided by YouTube to display a video. You can also use this part to enable Google
Analytics E-Commerce tracking features.

For more information about how to configure the program to use Google Analytics, see the
Administration Guide.

Warning: Code and scripts that you include in this part are beyond of the scope of Blackbaud
Support.

Design Unformatted Text
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, enter the HTML code or script in the box.

2. To select additional options for the code, select Show advanced options.
3. In the Placement in HTML field, select where to place the code in the page’s HTML. You can

place it in the <head> tag, at the bottom of the <body> tag, or within the <body> tag
according to where you place this part on the page.

Warning: Code and scripts that you include in this part are beyond of the scope of Blackbaud
Support.
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4. Click Save. You return to Parts.

User Email Preferences Form
Warning: The User Email Preferences Form has been replaced with the more powerful
Communications Preferences Form. This part type appears in Parts only if you have saved User Email
Preferences Form parts. While the deprecated part continues to operate for backwards compatibility
on your website, you can no longer create or copy User Email Preferences Form parts. The
Communications Preferences Form in Forms includes all the functionality of the User Email
Preferences Form part with enhancements. For example, website users view all communication
preferences for your organization on the same page. In addition, you do not have to process data
from the form to Blackbaud CRM. When a website user submits a communication preference, the
data defaults directly on the constituent record. To display the form on a web page, you must include
it on a Form part. For more information, see the Forms Guide.

User Email Preferences Form Part Considerations

If your organization uses Newsletters, users can subscribe or unsubscribe to newsletters from the User
Email Preferences Form. They can also use this form to subscribe or unsubscribe to emails from
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Chapter Manager parts and notifications. Web pages with the User Email Preferences Form allow
nonmembers and members who are not logged in to click a link and update their subscription
preferences.

The User Email Preferences Form appears when users access it from links in email, regardless of
whether they are logged in. However, if users access the form through the website, it only appears
when they are logged in.

Warning: In each email you send, you must include a link to the page of your website that contains
this form.

User Email Preferences Form includes opt-out sections for users to subscribe or unsubscribe to
individual newsletters, notifications, and Chapter Manager email. Users select checkboxes to subscribe
to these email subscriptions, and they clear the checkboxes to opt out of subscriptions. For example, if
the form's newsletters section includes five newsletters, a user can select two checkboxes to subscribe
to those newsletters and clear the other three checkboxes to opt out of those newsletters.

A global opt-out checkbox also appears on the form to allow website users to opt out of all email
communications. For users who select this global opt-out checkbox, Blackbaud CRM adds the “Do not
email” message on constituent records when it processes user profile updates.

To have at least one web page where users can subscribe or unsubscribe from newsletters, you must
allow the Everyone user role view rights for at least one User Email Preferences Form you create. You
can also create other User Email Preferences Form parts that do not have Everyone security set and
require a login, but you must set at least one part for everyone.

Note: Subscriptions derive from newsletters. The website sends subscription email to all constituents
on the assigned lists, plus additional subscribers and minus explicit unsubscribers and users with the
“Do not email” message in their user profile. The program prevents a duplicate email to the same
record in Blackbaud CRM. It does not prevent duplicate emails when the Blackbaud CRM query
contains duplicate records.

Design User Email Preferences Form
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. Select the Design tab.

2. Under Email Preference, in the Title field, enter a title to appear on the web page for email
preferences.

3. In the After update navigate to field, browse to the page to appear after website users
update subscription information. If you do not select a page, the page designated as the
Home Page in Sites & settings appears for users.

4. Under Titles, enter the text to appear on your website in the title bar of your opt-out section
for email.

• In the Chapter email list title field, enter the text to appear for chapter email, such as
“Chapter List Subscriptions.”

• In the Email list title field, enter the text to appear for regular email.
The program automatically configures email lists under the opt-out section. Blackbaud Internet
Solutions groups “Chapter Manager part name — Chapter name List” for the list. For example,
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“Alumni Chapter Manager — San Diego List” is the Chapter Manager part named (Alumni
Chapter Manager) — Chapter name (San Diego) List.

• In the Notifications title field, enter the text to appear for a notification email.
5. Under Opt-out checkbox, customize the instructions that appear for the opt-out section of

the User Email Preferences form. In the Opt-out checkbox label field, enter the text to appear
for the global opt-out checkbox on the website, such as “To no longer receive email from us,
select the checkbox.”

For verification purposes, if a user selects to opt out of a newsletter, the user is asked to enter
his or her email address. If the email address is not registered with the program, the user
cannot opt out of the newsletter.

Note: Even when a user selects the global opt-out checkbox on the website, he or she continues to
receive requested notifications and acknowledgment emails.

6. Under Subscriptions, customize the instructions that appear for the subscriptions section of
the User Email Preferences form. In the Subscribe instructions field, enter the text to appear
for the newsletter subscription checkboxes on the website.

7. Under Directory messages opt-out, select Include opt-out for directory messages on this
form to enable website users to opt out of receiving email messages sent from other
directory users. In the Directory opt-out checkbox label field, you can customize the text
that displays for the opt-out checkbox on the User Email Preferences form.

For verification purposes, if a user selects to opt out of directory messaging, the user is asked
to enter his or her email address. If the email address is not registered with the program, the
user cannot opt out of the messaging.

8. To customize additional messages that appear for the part, select the Language tab. For
information about the Language tab, see Language Tab on page 17.

9. Click Save. You return to Parts.

User Interests Form
With the User Interest Form part, you can create a web page that captures a website user’s interests.
You can download the information that website users select on the User Interests Form. You can use
this information to raise funds and create awareness for your organization. For example, if many
website users select Wine Tasting on your User Interests Form, you can host a wine-tasting event in
your community.

Design User Interests Form
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Title field, enter a name to identify the User Interests Form part.
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2. In the Help message field, enter the message to appear on the website page, such as to
provide instructions for site users.

3. Under Interests to include, select the interests website users can choose from on the User
Interests Form.
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4. Click Save. You return to Parts.

User Login
To control the areas users can access on your website, create a User Login part. When a user logs in, the
user login determines the roles that the user belongs to and the features that the user has security
rights to access.

There are several important items to remember about the User Login part. Make sure you consider this
information when you design the part.

l The part automatically includes sections for the login and logout pages. You can design the part
to also include sections for the new user registration page and the forgotten password page.

l You create emails to acknowledge registrations and provide forgotten usernames.

l When you have multiple websites, create multiple login pages to provide access to each site.

l You can enable social media to allow new users to register with their social network login. When
you use the social media login option, you can indicate where to display the social media icons
on login forms.

l Multiple users can use the same email address when they sign up for your site. This makes it easy
for an entire family to sign up for an event. If a family shares an email address and one user
forgets a password or username, the reminder email contains all usernames associated with that
email address. The password reset link connects to a page where the user can select the
username that needs a new password.

l When you include a link to this part in an email message, you can create a special page link to
send users to the login page and you can also create a special page link to send users to the
forgotten password page. When you include this link in a message and an email recipient clicks
the link, a secure page appears with a Forgotten Password field for the user to enter their email
address. This link remains active in the email for the user to take action to reset the password any
time. After the email address is submitted on the web page, another email sends to the user.
That email contains another link that returns the user to the reset password page on your
website. For more information about how to create a special page link, refer to the Program
Basics Guide.

If a user's email address used for the Blackbaud Internet Solutions password reset process needs
to be updated, you must do so in Blackbaud CRM. Locate the constituent record in Blackbaud
CRM, then select the Online Info tab. The email address used for the password reset process
displays in the Account email address field. Select Update, modify the email address, then
select Save.

Note: If a user is not linked, the Online Info tab doesn't display in their constituent record. You
must first link the user before you can modify their password reset email address.

Design User Login
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.
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1. From the Design tab, when you configure social media for third-party authentication with
social networks such as Facebook and Twitter, Social website login appears with the Enable
social website login checkbox. To enable social media options for the login, select the
checkbox. Additional options appear.

a. In the Sign in text field, enter the text to display for standard and social network login
options.

b. In the Social website sign in text field, enter the text to display above the social site icons.

c. Under Display options, specify where to place the social site icons relative to the standard
login fields.

Note: For more information about social media for third-party authentication, refer to the
Administration Guide.

2. Under Captions and properties, select whether to include forms for new registrations or
forgotten logins. To include a form, select its checkbox in the Enabled column.

Note: To change the caption for a form, select the Language tab. For information about the Language
tab, see Language Tab on page 17.

We recommend you clear New User Registration if you import records from Blackbaud CRM
into the website. Imported users are registered automatically, so they do not need to register
a second time with the User Login part. For information about how to import users, see the
Users & Security Guide.

Note: After you create a login page with the User Login part, select it in the Member Login Page
field in the Registration and Login Options frame on the Settings tab in Sites & settings. For more
information, see the Administration Guide.

3. In the Constituency field, select a constituency to assign to users who use this form on your
website. For more information about constituencies, refer to the Program Basics Guide.

4. Under Navigation, select the web page to appear after users log in, log out, register, or reset
passwords.

• By default, the Login, Logout, and New user registration forms are set to the default home
page you selected on the Settings tab in Sites & settings, and the Password reset form is set to
blank.

• To clear the web page selected for a form, click Remove page for that form. If you do not
select a page for New user registration, users are directed to the page selected for the login
form. If you do not select a page for Password reset, the program does not redirect users to
another page. Instead, a message appears to indicate the password is reset.

5. Under Additional fields, select the biographical fields to include on the new user registration
form.

PARTS 249



a. In the Field grid, select Include for each field to include on the form. To make a field
required, select Required. When you select Include for the Address block field, it is
automatically required.

b. In the Attribute grid, select Include for each constituent attribute to include on the form. To
change the text to appear on the web page, enter it in the Caption field. To make the
attribute required, select its checkbox in the Require column. To move an attribute in the
list, click and drag the dotted button on the far left.

Blackbaud CRM provides these constituent attributes. To add a new attribute for your part,
create it in Blackbaud CRM. For example, you can use a constituent attribute to track t-shirt
sizes for participants. To track this information, create a t-shirt size attribute. If you know an
attribute exists, but do not see it online, check the Settings tab in Sites & settings to verify
the attribute is available.

6. To enable users to specify their consent preferences for how they want to receive
communication from your organization:
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a. Under Consent part, select a saved Communication Consent part to include on the form.

b. Select how you want the communication preference options to display — choose Inline to
embed the options directly in the form itself or choose Overlay to display a pop-up window
with the consent options when the form is submitted.

After users submit the form, their consent information is downloaded along with their
transaction. After the appropriate batch is committed, their constituent record is updated on
the Communications > Preferences tab in Blackbaud CRM with their communication
consent preferences.

7. Under Role assignment, select the checkbox under Member for each role to assign to users
who sign up through this User Login part.

8. To create a reminder email to send to members who click Forgotten Password/Username or
Forgotten Password, click Forgotten Password/Username Email on the action bar. The
HTML editor appears. You can use the default text provided or enter different text.

Note: When you include the Password Reset Link merge field in the reminder email, the field
displays as a secure link that remains active for 24 hours. When a user clicks the link, a secure page
appears to enter and confirm a new password.

9. To create an email to send to new users after they register, click New User Registration Email
on the action bar. The New User Registration Email screen appears. You can use the default
text provided or enter different text. Use the merge fields to include the username, password,
and other personalization.
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For information about how to create an email, refer to the Email Guide.

10. To create instructions to appear on the Login, New User Registration, and Forgot Password
screens of the part, select the Helplets tab. For information about this tab, see Helplets Tab on
page 20.

11. To customize the messages and labels that appear for the part on your website, select the
Language tab. For information about the Language tab, see Language Tab on page 17.

12. Click Save. You return to Parts.

User Photos Form
To allow website users to upload a picture along with a profile image on a profile web page, include a
User Photos Form part on a page that also includes the Profile Display part. When a user uploads an
image on the User Photos Form, the image appears along with the profile information for the user.
When you include the User Photos Form part on a profile page that links to a Directory part, other
website users view the image when they access profiles through the directory.

Images must be *.bmp, *.gif, *.ico, *.jpeg, *.jpg, or *.png files.

Tip: On the Settings tab in Sites & settings, you can require approval for images. Under User Image
Options, select Require approval for all images uploaded by users. When you include the User
Photos Form part on a profile page and users upload images, you must approve the images in Image
library for it to appear on your website. For more information, see the Administration Guide.

Design User Photos Form
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, select the tag in the Image tag field to associate with images that users
upload through the user photos form. Tags are keywords or phrases to identify an image’s
content. For more information about tags, see Tags Tab on page 23.
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2. In the Default caption field, enter the caption to display with images when users do not enter
captions.

3. In the Max height/width for thumbnails field, enter a size limit for images as thumbnails. By
default, images uploaded on this part appear as a thumbnail on the web page.

4. In the Max height/width for full-size image field, enter a size limit for how to display
images when users click thumbnails. If you leave the field blank, images do not appear when
users click thumbnails.

5. In the After update navigate to field, browse to the page to direct users to after they select
images on this part.

6. Click Save. You return to Parts.

Weblog
With the Weblog part, you can collect or share information on your website that pertains to your
organization. This can range from your organization’s news to appeals sent to your alumni to links to
other related websites. Given the appropriate rights, your program users and website users can update
the Weblog part.

The part creates a RSS feed of posts. Include the part on one of your website pages so users can add
and edit posts to appear in the feed. Users can view the feed from the page when they click the RSS
icon next to the title of the Weblog, or from an RSS reader. You can add the News Reader part to your
website to display the feed, or users can subscribe to the feed with a third party reader.

Note: When users add or edit posts, the program includes content from the Story Title and Story
Content fields in the search results for the Search and Quick Search parts. Also, the program uses
content from the Tags for this story field to create category information in the RSS feed. Some RSS
readers use this information to arrange posts in groups that share common categories.
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Design Weblog
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Date format field, select a date format for the blog.

2. Under RSS Publishing Properties, in the Title field, enter the title of your weblog, such as
“Best Solicitation Practices for Fundraising.”

Note: The Title field is optional. However, to save a weblog, you must either enter a title or enter
description information in the Description field.

a. In the Description field, enter any additional information, such as “Check weekly for
updates.”

b. In the Link URL field, enter your website link that news readers such as NewsGator use to link
to your site. This link should direct the website user to your weblog or a general information
page about your organization.

To view the information you enter in this field, click XML for the weblog on your site. For the
example, the XML information for your description reads “<description>Check often for
weekly updates</description>.” In addition, news readers use the weblog description
information to provide general information about the contents of the weblog. For more
information about the News Reader part, see News Reader on page 137.

c. In the Copyright field, enter a copyright notice for your weblog, if you have one.

d. In the Editor’s Email field, enter your email address or the person who is responsible for the
content of your weblog.

e. To approve weblog posts before they appear on your site, select Moderated.

3. Under Image Properties, click Select Image. The Select Image From Image Library screen
appears. For information about how to insert an image, see the Program Basics Guide.

4. To share valuable information from another website with your site users, in the Link URL field,
enter the address of the website to link to the weblog.

5. Under Security Rights, specify the roles with post and manage rights for the weblog.

a. In the Post column, select the checkbox to assign post rights to users and roles. This does
not grant rights to edit or delete postings.

b. In the Manage column, select the checkbox to assign manage rights to users and roles. This
grants rights to add, edit, and delete postings. If Moderated is selected, these users and
roles can approve postings.

c. To include additional users and roles, select Add users and roles.
6. Click Save. You return to Parts.

Web Traffic Reports
Using the Report (Web Traffic) part, you can create reports with statistics about your website’s traffic.
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Warning: To create a Web Traffic report, you must run Microsoft SQL Server Agent. If you are unsure
whether you run this program, consult your system administrator.

You can add several types of Web Traffic reports:

Site Usage Report — The Site Usage Report displays the total number of hits each page on your
website received and the percentage of total hits compared to other pages on your site. Web pages
are hyperlinked so you can open them directly from the report.

Page Rank Report — The Page Rank Report is a small bar graph that displays the number of hits a
page received and its overall rank compared to other pages on your website. You can place this graph
on any page. We recommend you grant view rights to only to those who need to see the statistics.

Page View Summary — The Page View Summary displays the total number of page views, the
average number of page views, and the average number of page views per visit for all pages in the
website. Website users can filter the report results by date range and group the results displayed in the
bar graph by day, week, or month.

Page Overview Report — The Page Overview Report displays the total number of page visits and
views for each page viewed. It also includes a bar graph that displays the total number of page visits
and views for each page ID. You can filter the report so it includes only pages with the top 10 number
of views or visitors, the bottom 10 number of views or visitors, or all pages that had views or visitors.
Web pages are hyperlinked so you can open them directly from the report.

Visit Summary — The Visit Summary displays statistics for website visits during the specified period
of time. The summary includes the total number of visits and average number of visits per day. It also
includes the total length of time visitors spent on the website and the average visit length per visitor.
To calculate the average visit length, the program divides the total length of time of all the visits by
the total number of sessions (individual visits).

Visitor Summary — The Visitor Summary displays statistics including the total number of website
visitors, the number of unique visitors, the number of one-time visitors, the number of repeat visitors,
and the average number of visits per visitor. The summary also includes the total number of program
visitors and the number of unique program visitors. Website users can filter the report results by date
range.

Note: In the Visit Statistics section, Total Visits is the total number of users (everyone who accessed
the website, logged-in or not.) In the Blackbaud Internet Solutions Users section, Total Visits is the
total number of logged-in users that visited the website. For example, here are the Visitor Summary
results for a website:

Visit Statistics

- Total Visits: 13,301

- Unique Visitors: 13,265

- Average Visits per Visitor: 1.00

- One Page Visits: 12,941

Blackbaud Internet Solutions Users

- Total Visits: 72

- Unique Users: 36

- Average Visits per User: 2.00
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What this means — The website was viewed 13,301 times by 13,265 unique visitors. 36 views were
from visitors who had previously viewed the website during this period.

Of those 13,265 unique visitors, 36 of them logged into the website a total of 72 times among them.

Web Traffic Reporting Terms
This table explains the items included in Web Traffic reports.

Hits Number of times a page was accessed

Views Number of times visitors viewed a page

Visits Number of times users logged into the website

Unique visitors Number of logged-in users and anonymous visitors (those not logged into the
website) who visited the website. These are counted only once, even if they visit
multiple times during the report’s date range.

Return Visitors Number of unique users who visited the website more than once while logged in.
(This excludes return visits by those not logged in.)

Only Visited once Number of logged-in users and anonymous visitors (those not logged into the
website) who visited the website only once

Unique Hosts Number of different IP addresses that accessed the website

Unique Users Number of different logged-in users that accessed the website

Design Web Traffic Report
For information about how to create or edit a part, as well as the tabs on the Edit Part screen, see
Create and Edit Parts on page 10.

1. From the Design tab, in the Report Type field, select the type of report to create.

To view a pop-up preview of the report, click on the report type. For information about report
types, see the introduction to Web Traffic Reports on page 254.

2. In the Report Title field, select the report title.
• To use the report name as the title, select Default.
• To use a custom title, select Other and enter the report title in the field.

3. To display the name of the report, select Show Report Title.

4. Click Save. You return to Parts.
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